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Preface

Literally dozens of books on digital photography are currently being
published. Both authors Uwe Steinmueller and Jirgen Gulbins (until
now only available in German) have contributed to this growing list.
These books largely cover photographing aspects or image process-
ing. An amazing list of hundreds of books exist on Photoshop. This
book, however, focuses on an important step connecting shooting
and image processing (and possible manipulation). It deals with the
conversion of images shot using RAW format into images in a stan-
dardized image format, such as TIFF or JPEG. In our experience,
shooting photographs using RAW format is strongly recommended.
Doing so allows getting the highest quality from your camera and its
images. It lets you decide on many image settings apart from the
moment you took your photo and reduces the pressure and haste
possibly existing as you took the picture. For many camera settings,
RAW processing lets you reconsider and even revise settings made
during shooting. This ability need not encourage sloppy photogra-
phy, yet it gives you substantially more control of your pictures.

In this book, we mainly restrict our close scrutiny to the process
of RAW conversion: What you should consider when shooting RAW,
how to prepare files for conversion and how to set up an efficient
conversion workflow as part of your total image workflow.

We will not go deeply into image processing and image manip-
ulation in Photoshop, but we will discuss image enhancement
either done in the camera, in the RAW converter or perhaps later in
Photoshop.

The king of all image editors is Photoshop. It may not be the
best solution for all image operations, but it provides an overall
high level of functionality, an excellent integration of those various
functions and definitely is the trendsetter for these kinds of applica-
tions. We believe these qualities justify its hefty price. Adobe
Camera Raw, an excellent RAW converter, is provided as part of
Photoshop CS. Of all RAW converters Camera Raw supports one of
the broadest range of RAW formats, and is updated regularly in
order to support newly released RAW camera formats. For this rea-
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son, we delve deeper into details of Adobe Camera Raw than we do
other RAW converters. Be aware that there are a number of RAW
converters available, and some of them are quite good concerning
resulting image quality and workflow integration. It may well be
worth evaluating other RAW converters, as well and even using sev-
eral for different situations and workflows. We focus on those we
judge the best and most often used.

This book is not intended as a substitute for the program manual.
Some programs would very likely be worth a book of their own.
Instead, you will receive a thoughtful overview plus hints and recom-
mendations allowing you to set up your own RAW workflow and
adapting it to your personal preferences and kinds of work. We are
focusing on getting the best possible images from the RAW files your
camera produces.

The workflow we present is based on practical work with thou-
sands of real-world RAW photographs.

This book is quite technical and deals with many aspects of various
programs and techniques. Don’t become confused: The goal is tak-
ing good photographs. Don't get lost in technique, spending time
fiddling with programs and settings.

You can be more productive shooting good photographs,
being creative, looking for appropriate light, finding the right angle
of view and optimal settings. What we hope to show you in this
book is making the most of the creative work done previously with
your digital camera.
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Chapter 1

Introduction

Camera: Canon 10D

Introduction to RAW files or digital negatives

What is the digital photography workflow? All you want is to take a
picture and get a great output. Yet, this process should be:

» Fast
» Atreasonable cost
» Getting optimal quality

-
1
-
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Digital workflow includes everything from the moment you take a
picture until you print and archive it. Unfortunately there is no silver
bullet to guarantee success in all of these areas. This book will not
presume to sell you this illusion. What we can do is present a proven
workflow that enables you to:

» Improve your output quality
» Save you time by avoiding costly personal exploration

This book tries to be as simple as possible but not simpler. The goal
is not to become the great master in Photoshop or other tools. We
hope to teach you how to use all necessary imaging tools in a man-
ner allowing you to create the images you want without undue trial
and error.

1.2 How to use this book, how this book is organized

In this book we attempt to cover the Microsoft Windows platform,
as well as, Macintosh (Mac OS X). The two use some different key-
board shortcuts. In most cases, substitute the Windows key
with the Mac |H] key (labeled (&) and also known as command key)
and the Windows (A1t key with the Mac (<] key (called option key).
When you read a key sequence like (ctrl)/(H]-[S ] it means you have
to press and 5] together in Windows and (&) together with
with Mac OS. [¢] is the symbol used for the shift key.

Some of our photographic artwork is included to remind you that it
is all about good pictures and not just technique. We prefer a great
vision not perfectly executed, over a technically perfect ,boring pic-
ture. We trust you understand what we mean by this. In the end,

your eyes are the most important tools to succeed in photography.

Keep your vision fresh!



1.3 Using PCs and Macs

We - Bettina and Uwe Steinmueller - work on PCs most of the time.
Fortunately, Photoshop CS is pretty much the same for PCs and
Macs (apart from some different keystrokes). This makes all
Photoshop content valid on both platforms. Author Jirgen Gulbins
uses a Macintosh as his primary platform. So, both systems are used
in this book — without any serious incompatibilities or problems. A
few tools we use are available only for the PC. In most cases, you can
locate an equivalent tool for the Mac platform. As for the computer
configuration, dealt with in the following section, the requirements
are very much the same for a Windows PC or a Macintosh.

1.4 Computer configuration

Image processing is often quite demanding of your computer hard-
ware. Some guidelines (valid for both Macs and PCs):

» 1GB of memory is a good start (0.5 GB is the bare minimum,
(While 1 GB is good, more is even better)

» Don't settle for a low-quality monitor. 1280 X 1024 is an accept-
able resolution. Again, more is better (we use 1600 X 1200). High
resolution should accompany a sufficiently large screen (19" or
more is suggested)

» Having USB 2.0 and Firewire ports are a plus
» Dual Processors is a plus, utilized by Photoshop

» Disks space:
— 1X 80 GB or more for your operating system
- 11X 80 GB or more for working files
- 2Xx120 GB or more for archiving
(external USB 2.0 or Firewire drives are fine)

» External Compact Flash (CF) card reader with USB 2.0 or Firewire
connection (USB 1.0 is considerably slower)

» DVD reader/writer (external Firewire is fine)

» Device for monitor profiling (see chapter 2.3)

1.3 Using PCs and Macs B §,
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In all cases, “more”is better. The result is faster operation, a more
comfortable workflow and a more pleasant working environment.
Doing color work, the importance of a good large monitor should
not be underestimated. When, in previous years, CRT monitors had
advantages over LCDs - especially concerning color confidence -
this is no longer true. There are many very good LCD monitors on
the market. You have to spend up to 3 times the amount of money
to get an LCD with the same size and quality of a CRT. For color work,
laptop screens are usually not as effective as stand-alone monitors.
In most cases, their contrast is lower and in almost all cases their
color quality is of lower quality.

1.5 What are RAW files?

In many ways, using a film camera and a digital camera is identical.
This section concentrates on the things that are different and must
be known to start the digital workflow with the best possible photo-
graphic material. As always, the optimal framing and exposure lead
to better images. Otherwise, ‘garbage in means garbage out!This
does not mean, however, that you cannot get great pictures from
less than optimal shots. But be prepared. This requires much more
work in the digital darkroom

The most common image format today with digital cameras is
JPEG (Joint Photographic Experts Group). The obvious limitation of
JPEGs are that they are most often used for their excellent, but lossy
compression format (there are also lossless JPEGs rarely used in
cameras). Even at low compression rates, an image degrades
slightly. A more important point is the fact that an image under-
goes heavy color/exposure/noise/sharpening processing within the
camera. These adjustments reduce the ability to make further post-
processing corrections. JPEG compression works best for images
with no need of further substantial post-processing (his is rare if
you are demanding) or under circumstances where such post-pro-
cessing is prohibited.

Many photographers try to get the best possible quality out of
their cameras using the TIFF selection, or if supported by the cam-
era, a vendor-specific RAW file format. As you will see, RAW file for-
mats allow for the greatest post-processing flexibility.



If you decide to continue using only JPEGs, this does not mean
you cannot use our workflow. In this case, you will have used the
RAW converter built into your camera. All steps that are applied
after a RAW conversion are valid for JPEG images. Even if you don’t
use RAW, it probably is helpful to better understand what RAW is all
about.

What are the RAW file advantages?

To better understand what these magic RAW file formats are, you
must understand how the majority of today’s digital cameras work.
All new digital cameras capture color photos, right? Well, you ulti-
mately get color prints, yet most modern digital cameras use sen-
sors that only record grayscale values (the Foveon X3 sensor, digital
scanning backs and multi-shot digital backs are exceptions).

Assume you want to photograph a box of Crayola crayons:

< Figure 1.1:
Full colored
sample target

A gray scale sensor would see the picture as in the figure 1.3. You
would never see any color photos at all.

-
1
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< Figure 1.2:
>Grayscale
picture< seen
by the sensor

How do you use a grayscale sensor to capture color photos?
Engineers at Kodak came up with the following method called Bayer
Pattern. Dr. Bayer is a Kodak scientist who invented this novel Color
Filter Array configuration back in the eighties. Hence the name
Bayer pattern. There are also other pattern variations used):

B-G-B-G-B-G < Figure 1.3:
G-R-G-R-G-R Bayer pattern
B-G-B-G-B-G achieved by a
G-R-G-R-G-R matrix of color filters

First, it is interesting to note that 50% are green and only 25 9% for
each red and blue. The reason for this is that the human eye can dif-
ferentiate far more green shades than red or blue. Not really a sur-
prise if you look at nature. Green also covers the most important
and widest part of the visible spectrum.

Now our sensor captures gray values filtered by these color filters:



4 Figure 1.4:
Color mosaic
seen through
the color filters

However, you want to have a photo with full-color information for
every pixel. Here a software trick comes into play called Bayer
Pattern demosaicing or color interpolation. What actually happens
is that the missing RGB information is estimated from neighboring
pixels.

A good demosaicing algorithm (the method of turning the
RAW data into a full color image) is actually quite complicated, and
there exist many proprietary solutions on the market. The problem
is to resolve detail and maintain correct colors. To illustrate some of
the challenges, think of capturing an image of a small black & white
checker pattern, small enough to just overlay the sensor cells:

—
N
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color filter CCD-array final

subject .
array response image

white ﬂl . red
black .‘ . black
white :‘ I . plue

Figure 1.5: CCD / color mosaic sensor with color interpolation errors
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subiect sensitive  sensitive  sensitive
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Figure 1.6: X3 sensor with no color interpretation errors

As the neighboring green filtered photo site does not add new
information, the algorithm would not know whether it would be
some kind of “red” (if the white hits a red filter) or “blue” (if the white
hits the blue filter). In contrast, for example, a Foveon sensor would
capture white and black correctly as all three color channels are cap-
tured at the same photo site. The resolution captured by the Bayer
sensors would drop if the subject only consists of red and blue
shades, since the green channel could not add any information. For
monochromatic Red/Blue (very narrow wavelengths) the green sites
get absolutely no information. But such colors are rare in real life. In
reality, there is information in both green, and to a much lesser
extent, even blue, if the sensor samples very bright and saturated
red colors. The problem in our example above is the fact that esti-
mating the color correctly requires a certain amount of spatial infor-
mation. If only a single photo site samples the red “information”



there will be no way to reconstruct the correct color for that particu-
lar photo site.

The above next cropped illustrations are from real samples that
were made in a studio to show a practical effect. Of course, these
test photos here show an extreme situation. In reality the failure is
less dramatic but is still visible by our eyes and definitely not to be
ignored.

Canon EOS 10D Sigma SDg using the Foveon sensor

Figure 1.7: Fooling a Bayer sensor

Some of these challenges result in image artefacts like moirés and
color aliasing (shown as unrelated green, red, blue pixels or result-
ing in discoloration). Most cameras fight the aliasing problem by
putting an AA (Anti-Aliasing) filter in front of the sensor. This filter
actually blurs the image and distributes color information to the
neighboring photo sites. As you know, blurring and photography
aren't compatible. To find the right balance between blurring and
aliasing is a camera design challenge. In our experience, the Canon
1Ds does this job well. Finally the image needs stronger sharpening
to re-create much of the original sharpness. To some extent AA
filtering degrades the effective resolution of a sensor.

This appears as a complicated mission. Indeed it is, but works
surprising well in the end. Every technology has to struggle with its

=y
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inherent limitations. In many aspects, digital photography can beat
film today because film has its own limitation to contend with.

We can state what the RAW data are for any given digital cam-
era. The RAW data are, in fact, all the data for gray values captured
on a chip. To produce a final image, these RAW data require
processing (including the demosaicing) by a RAW converter. To pro-
duce JPEG images, the camera must have a full RAW converter
embedded within the camera’s firmware.

What are the limitations of using camera-produced JPEGs:
» JPEG artefacts, due to lossy compression

» Although most sensors capture 10-14 bit color (grayscale) infor-
mation only 8 bits are used in the final file

» Thein-camera RAW converter can only use limited computing
resources but good RAW conversion can be very complex and
computer intensive. As software technology evolves, it is much
more efficient to have the conversion done on the host com-
puter instead of the non-upgradeable ASIC commonly used
today.

» The in-camera set or estimated white balance (WB) is applied to
the photo within the camera. The same is true for color process-
ing, tonal corrections, and in camera sharpening. This limits the
post-processing capabilities, because a previously corrected
image must be corrected again. The more processing done on a
photo (especially 8 bit) the more it can degrade.

Next we explain the different RAW files formats. The formats store
only RAW data (plus additional metadata to describe properties of
the RAW data in EXIF section of the file — the EXIF sections hold infor-
mation, such as camera type, lens used, shutter speed, f-stop and
more). All the processing previously done shooting JPEGs or TIFFs in
the camera are now ready to be performed on a more powerful
computing platform with:

» No JPEG compression
» Full use of the 12-bit color information (10-12 bit)

» Use of very sophisticated RAW file converters (as an example,
Adobe Camera Raw, Phase One’s Capture One DSLR or
Pixmantec’s Raw Shooter Essential)



» White balance, color processing, tonal/exposure correction,
sharpening and noise processing can be processed later on in
the computer

» The RAW files also resemble a digital version of an undeveloped
film negative. Over time, there are improved RAW file converters
that give better and better results from the same data.

This all confirms the fact, that shooting in RAW gives you much
greater control while processing your images.

In-camera JPEGs are similar to shooting a Polaroid (where you
simply shoot and receive your image processed immediately) while
RAW is more like a film that can be developed and enhanced in the
dark room. Raw converters like Phase One’s Capture One DSLR
mimic a magic formula for film developer.

What is the advantage of 12-bit data? The main advantage
exists if you need to make major corrections to the white balance,
exposure and color corrections. During processing of an image, you
lose bits of image data due to data clipping (accumulating over
multiple steps). The more bits you have in the beginning the more
data you have in your final corrected image.

What about using TIFF files in the camera? Actually TIFF files
only solve the lossy compression issue, but are still converted to
8-bit inside the camera. Most TIFF files are larger than RAW files
(remember RAW files only hold one 12-bit gray value per pixel) and
don’t have the other benefits of RAW. | would go so far as to say
that an 8-bit in-camera processed TIFF file is only slightly better
than a high-quality / high-resolution JPEG.

Digital camera artefacts

Current sensors do not record full RGB color but only interpolate the
color but, at a price.

Color aliasing / moirés

What happens when a fine red line crosses a green photo-site but
not any neighboring red photo-sites? There would be no indication
of this red line in RAW data. To combat this effect, most cameras
have fixed-mounted AA filters. These AA filters blur the image so
that neighboring photo-sites also acquire some red line informa-
tion.

=y
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While the AA filter fixes one problem, it introduces a different
one, a loss in sharpness. This means that some strong sharpening is
needed later during the RAW workflow. Keep in mind, lost detail
cannot be recaptured later regardless of whatever fancy sharpen-
ing methods are used. Sharpening does, however, do quite a good
job, and digital cameras work much better than this description of
it sounds.

1.6 The digital negative/slide

What you now have on your computer when shooting RAW are
often called “digital negatives”. We recommend you keep these RAW
(or original JPEG or TIFF) files as they hold all the information cap-
tured in the field. You may want to revisit these original RAW files in
case:

» You improved your own digital workflow over time (very likely)

» Better RAW converter software will be available. We have seen
many improvements over the last four years and expect more to
come.

» You lost your derived files

Actually, a RAW file is even more like a latent image and the RAW
converter software acts like your preferred magic developer. The
only big difference in digital is that you can do multiple kinds of
development over time.



1.7 Some strategic reasoning

Like many pads lead to Rome, there are many ways to shape your
digital workflow. The most appropriate way for you depends on the
kind of photographs you shoot, the purpose you intend for your
images, on your equipment and on personal preferences, as well. To
setup a workflow that suites your work best, you might give differ-
ent workflow variations a trial, then finally settle on a workflow,
which can be adapted in special cases:

Several steps in the processing of an image - e.g. white bal-
ance, sharpening, contrast enhancement, saturation enhance-
ments, ...) may be done at three different stages:

» Inside the camera (some of the operations mentioned above,
even if you shoot RAW files)

» Inside your RAW converter
» Using Photoshop or some Photoshop Plug-in

Doing an operation at an early stage doesn’t necessarily mean you
may not do it again at a later stage. For example, there are reasons
to do some sharpening globally with the RAW converter and add
more sharpening with Photoshop. In Photoshop, sharpening may
be applied to either the whole image or to certain edges or areas.
You may even want to do some final sharpening when preparing for
a dedicated form of output (e.g. an image printed using an inkjet
printer or offset printing requires more sharpening than an image
presented on screen or using a light jet printer). Inside the camera
ora RAW converter, you may apply changes only globally (to the
whole image) while Photoshop allows selective corrections using
selections, masks, layers or filters.

The general rule is that corrections done in the camera or
— with more control - in the RAW converter will result in less loss of
quality. This is especially true concerning good exposure, which
correction should be done within the camera. But correcting expo-
sure values with the RAW converter is much better than done
within Photoshop.

White balance » When you shoot RAW files, it is useful to set a
proper white balance in the camera, because this value will be used

as a default and starting point for your white balance inside the RAW
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converter — however it is only a starting point and may be changed
without loss of color quality. White Balancing is one of the most
important tasks in a RAW converter and should largely be done
there.

With those cameras that support Black&White (B&W) shooting,
you may consider a B&W setting if your are sure, you only want
B&W. Shooting color however gives more control and more options.
You may do a color to B&W conversion either inside the RAW con-
verter or do it in Photoshop (see chapter 12).

Sharpening, saturation, contrast enhancements » Apart from
the exposure and white balance settings, all other settings, such as
sharpening, saturation and contrast enhancements should be deac-
tivated or set to the lowest possible value when you shoot RAW files.

Up- or Down-sampling » As for scaling, we recommend using the
highest resolution available with the camera, and do up- or down-
sampling either in the RAW converter or in Photoshop. Photoshop,
as well as Capture One and Raw Shooter, support a reasonably good
up-sampling, however offer only some fixed sizes. If you wish to pre-
pare an image for large-scale printing, it may be helpful to do a
rough up-sample in Adobe Camera Raw and a final sizing in
Photoshop.

Cropping » Cropping is offered by Adobe Camera Raw 3 (or
newer), by Nikon Capture and by Raw Shooter Essentials if you are
certain your image needs cropping. This results in smaller image
files, thus faster processing.

Which RAW converter to use

There are several RAW converters available, and their number is
increasing over time. Almost all DSLRs come with a native RAW con-
verter. This may be a Photoshop Plug-in or a standalone RAW con-
verter (or both). E.g. Canon cameras supporting RAW format come
with Canon EOS Viewer Utility (EVU for short) and Canon Digital
Photo Professional (DPP for short) — both applications are a free part
of the camera package. If you use Photoshop CS1 (alias Photoshop 8)
or CS2 (alias Photoshop 9) or even Photoshop Elements 3 (or later) a
good RAW converter is included, as well. If you use a picture data-
base or good picture file browser - also referred to as “Digital Asset
Management Systems” (or DAMS for short), it probably will have a



RAW converter of its own. There are some optional RAW converters
as well - e.g. Capture One (by Phase One), Nikon’s Capture, Bibble
(by Bibble Labs) or Raw Shooter by Pixmatec, just to name a few.
Which one should you use?

There is no single answer to that. It very much depends on your
requirements and work — and it may change over time.

Those RAW converters that are part of a DAMS system such as
ThumbsPlus, iView Media Pro or Extensis Portfolio are primarily
intended to produce a reasonable preview. Though they may be
used to convert a RAW file to TIFF or JPEG, that is not their primary
focus. For that reason, you seriously consider doing your actual
RAW conversion using one of the “real” RAW converters. The range
of formats and cameras supported by the various RAW converters
differs. Nikon's tools, for example, only support Nikon cameras. The
same is true for Canon’s tools with Canon’s cameras. Adobe Camera
Raw, Capture One, Raw Shooter and Bibble all support a wide
range of formats — however, be sure you check to see if they sup-
port your camera. Some converters are faster than others, and
some offer a better workflow integration than others. For that rea-
son alone, we recommend you read the description of all the RAW
converters we include in chapter 3 to 6, do some testing (a trial ver-
sion of most converters is downloadable from the internet) and set-
tle on that converter that best fits your needs and budget.
Sometimes it may be useful to use more than one converter,
depending on the type of work and the images you have to pro-
cess.
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Chapter 2
Basic Color Management

Camera: Canon 1D Mk. I

Usually, when working with photos, we work in color. Thus, it is very
important that the color we see on our monitor closely matches the
color seen by the camera when a photo is taken.

Likewise, when white balancing, fiddling with color saturation,
or performing other color corrections or contrast enhancements,
we want to be sure that the color we see on our monitor represents
the color values of our image, and that if we print our image (once
all optimizations and enhancements are finished), the colors in our
print will be very close to those we saw on our monitor. This is what
color management is all about. Of course, in order to do efficient
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color work, you must understand the basics of color and color
management.

Color management is one of the more demanding subjects in
digital photography, and has, itself, been the subject of entire
books. Because of this, we give you only a short introduction to
color management, with a focus on those parts important to our
workflow. It is strongly recommended that you read more about
color management. There are several good books on color manage-
ment, such as Color Confidence by Tim Grey ([1]) or Real World Color
Management by Bruce Fraser ([2]).

2.1 Understanding the different color modes

Photoshop supports several different color models. A color model
defines how colors in an image are described using numerical val-
ues. The main color models for photographers are these:

» RGB

» LAB

» CMYK

» Grayscale

Photoshop offers additional color modes, but photographers rarely
use them, thus a discussion of them is beyond the scope of this
book. These include Bitmap for pure black or white (bitonality)
images, and Index mode, used primarily for web graphics (if you can
live with fewer than 256 different color values). Duotone is used for
B&W images and allows for the addition of a second color to give
the print more depth.

Color depth: Returning to the term color model, you may use either
8-bit (one byte) to specify the amount (or percentage) of a single
value (e.g. red) or 16-bit (2 bytes). Thus you may have your image in
8-bit or 16-bit mode. A different bit length is possible, but not sup-
ported by most applications. Using 16-bit doubles the space needed
to store the values, but gives you more headroom when it comes to
differentiating color values and allows for a more precise calculation
with less rounding errors. Using 8-bit, the value of a single compo-
nent may vary from o to 255 (using integers), using 16-bit, the range
runs from o to 65,536 (actually only 15-bits are used, so the range



becomes o to 32.768). Though we recommend using 16-bit when-
ever possible and reasonable, for most explanations we use 8-bit
values (0-255). This is common practice. For most issues in color
management, it doesn’t matter which mode you use. When produc-
ing final output, e.g. printing, you will be required to reduce your
image to 8-bit mode, since nearly all real devices can't actually pro-
duce more than 256 different shades of a color (taking into account
a combination of the three primary colors of RGB, this adds up to
16.777.216 different colors). Even our eyes can only differentiate
about 120-200 different shades of a color, depending on illumina-
tion. During the phase of color optimization, however, where a large
amount of color shifting and transformation and lots of calculation
of color values is done, 16-bit is the better mode.

RGB color model

All colors in the RGB color model Yellow
are created from three primary Red Green
colors: red, green, and blue.
RGB is the color mode most
commonly used today in digital
photography. We will perform
our workflow mainly in this Magenta
mode. RGB is an additive color
model, meaning that the sum
(addition) of all three basic col-
ors at full strength (100 per-
cent) will add up to pure white.

Triple (o, o, 0) defines black while (255, 255, 255) is bright white
(Either should rarely occur in any photo).

As you will learn a bit later, pure RGB values without an addi-
tional reference to the device or color space these values are used
for, do not define colors in an unambiguous way.

Blue
Figure 2-1: The RGB Color Model

LAB color model

The CIE-LAB color model (often spelled Lab, LAB or L*a*b*) separates
colors (chroma, A+B) from the detail and brightness (luminance, L)
in images. As in RGB, Lab uses three basic components to build (or
describe) a color: L (for Luminance), ranging from Black (o = no light)

2.1 Understanding the different color modes u 3,
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to white (100), and two color axes: a and b. The a-axis is a Green to
Red and the b-axis, Blue to Yellow.

1100

4« Figure 2-2: LAB color model

CMYK color model

The CMYK color model uses Blue
four primary colors to define
a color: Cyan (C), Magenta (M)
and Yellow (Y) and Black.
CMYK was designed for print-
ing, where incoming light is
reflected by the print.

CMYK is a subtractive color
model, as each of these col-
ored inks absorbs (subtracts) Yellow
a certain spectrum of light. As Figure 2-3: CMYK Color Model
you see in figure 3, mixing
cyan and magenta gives you blue, and when you add magenta to
yellow you get red. In theory, the combination of the colors C, M,
and Y alone should be sufficient to produce black, but due to cer-
tain impurities in inks, they produce a dark muddy brown instead.
To solve this problem, a fourth color, black, is added, and is called
the key color (K for short).

Although CMYK is an important color model for the printing
press, it is not used much in digital photography. Though inkjet
printers are technically CMYK printers (most are even CcMmYK with

Cyan Magenta

Green Red



additional light Cyan and Magenta inks), they provide an RGB inter-
face to the user and the transformation from RGB to CMYK is done
by the printer driver in an almost transparent way.

We rarely use the CMYK color model in our workflow. Even if
you intend your images for printing preparation, which requires
CMYK, you should stick with RGB mode images whenever possible
and resort to an RGB to CMYK conversion as the very last step
(some additional sharpening and some slight increasing of satura-
tion may be required afterwards for the final touchup). Working on
photos in CMYK mode has some disadvantages:

» CMYKimages are larger than RGB (with four color values per
pixel instead of three with RGB).

» Some photo filters won’t work in CMYK mode.

» The CMYK color space usually has fewer colors than most RGB
color spaces. Thus, when you convert from RGB to CMYK, you
probably lose some colors, and there is no way to retrieve them
should you want to later use your image for something such as
lightjet printing (used by photo services to output your image
on photographic paper) or a digital presentation using a monitor
using RGB colors.

Grayscale mode

Photoshop also works with images in pure black and white (B&W) or
grayscale. However, when working in grayscale, the color of a pixel
only describes a single (gray) value. Consequently, even when you
intend to produce a B&W photo (grayscale photo), it is recom-
mended using RGB mode, to preserve color information.

When using Photoshop's bitmap mode, a picture has only two
possible color values: black and white, no gray. Bitmap mode is
rarely used for photographs, and most imaging techniques and fil-
ters do not support bitmap mode.

Color spaces

A color space is the total range of colors (or color values) real devices,
such as a monitor or printer or a virtual device (such as a theoretical
average monitor, represented by the sRGB color space) can record or
reproduce. This range defines the gamut of the device.

2.1 Understanding the different color modes u 3
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Every real device has a unique color space, and even identical
devices (of the same make and model) have slightly differing color
spaces, e.g. due to different age, production tolerances and so on.
These differences increase with variations in user selected hard-
ware- or software-settings, such as different monitor resolution, dif-
ferent printer inks or paper, or even a different brightness setting
on a monitor.

To improve our ability to work with colors, the International
Color Consortium (ICC for short, see also [13]) and some other com-
panies (e.g. Adobe, Kodak, Apple) have defined virtual color spaces
that represent the gamut of a virtual, rather than a real device. We
will see later, what the advantage of those virtual, standardized
color spaces really are.

2.2 Understanding color management

Color correction and color management (CM) are two of the most
important and difficult areas to master in digital photography. As
stated earlier, the goal of color management is ensure that the
photo you see on your monitor looks as much as possible like the
print you'll get from your printer and very much the same when you
send it to a photo service that will reproduce it using a lightjet
printer. Color management helps to reproduce colors as truthfully as
possible across a broad range of different devices. As an identical
reproduction is often impossible due to different ways different
devices produce color, you should at least be able to predict the color
you'll get when printing from the color you see on your monitor.
The ability of a color managed application to show (simulate)
on your monitor the colors and the impression that an image will
have when printed on a specific printer or other output device is
called soft proofing. If you actually print using the same inks and the
same paper used for final output, this is called hard proofing.

Why you need to understand color management

If you post a photo on the web and ask different people to discuss

its color quality, responses will be altered by the fact that when the
image is displayed on different monitors (without using color man-
agement), the result will show colors, which are at least slightly dif-



ferent on all monitors. The viewers will actually see different ver-
sions of the same photo. In fact, the monitors may not even be
capable of rendering some RGB values at all. It is the domain of color
management to significantly reduce the problem described here.

The challenge

Your challenge is to have a monitor present the correct impression
of how a certain photo would print on a color printer. The latest
inkjet printers can produce amazing results, but without proper
color management, color printing remains trial and error. You end
up changing the printer’s color settings for every print, with usually
less satisfaction.

The solution

The solution to the color problem is to determine the color charac-
teristics of a device and to take those characteristics into account
when reading colors form an input device or when sending color to
an output device. Additionally you put a tag on color images that
define how the color values of the image are to be interpreted.

ICC-profiles

An important concept of color management is the production of a
standardized description of a device, called an ICC profile; the format
of these profiles is defined by the ICC. The ICC color profile describes
a device’s color characteristics, such as the colors the device can
record or reproduce and the values recorded for a perceived color
(input device) or the values you must send to an output device to
produce a certain color. These profiles are either from the device
manufacturer (usually called generic profiles), or you produce your
own using special profiling hardware and software. A profile pro-
duced for your specific device is called a custom profile. Almost all
color management systems today use ICC profiles. With the help of
such a profile, the color values required to produce a specific color
on device A (e.g. a monitor) can be translated to values that will
reproduce that specific color an device B (e.g. a printer) as close as
technically possible. It also describes the gamut of the device.

Note: While a raw RGB value does not define color in an absolute
way, the color produced is very much dependent on the device
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used or on the device that recorded that value. An RGB value in the
context of a color space (defined by the ICC profile of the color
space) however, does define an absolute color!

Note: Because most people use their monitor as their soft proofing
device, the first step toward complete color management is to pro-
file your monitor.

Let’s return to the problem when receiving a sent image that (with-
out color management) displaying different colors on different
monitors. With the help of the input profile, a color management
system may correctly interpret the RGB values of the (input) image
and, with the aid of an ICC profile for your monitor, may transfer
them to color values producing (nearly) the same color on your out-
put device. How this is done, we see in the next section.

What is a color management system?

A color management system (CMS) is a set of program modules that
handle color translation. These modules are often part of the oper-
ating system but may be provided by applications, as well (Adobe
does this). If an application is used to display or print a color image,
it calls up these functions and hands over the image values and ICC
profile information and tells the CMS what function should be per-
formed. The central part of the CMS is a module called color man-
agement module (CMM). This does the calculations needed to trans-
late (transform) a color from color space A to color space B. Here's
how it works:

1. First the color management module (CMM) translates the device
dependent color values of the image to a device independent
color space, using the description of the source ICC profile. Now
the color values of the image are in Lab color space, which is de-
vice independent. This intermediate space is called transfer color
space or profile connection space (PCS for short).

2. Next, these LAB-values are translated to color values that will
produce a color on the output device that is as close to the origi-
nal color impression as possible. If the output device cannot pro-
duce the very same color, the CMM will try to find a close match.
How the best match is achieved, is determined by the translation
intent (which we will explain at page 2-14).



The ICC profiles used in this scheme are actually simple translation
tables. They support translation from device dependent color values
to the device independent color values (and vice versa).

image in device independent
internal color space
(e.g. Lab)

yxRG scanner
ICC [ICC profile

N
yyRGB

CMM | IcC

(Color Managment =

Module) \p”ntj_pblbﬁle

image file CMYK
(RGB) xyRG monitor ICC Ny
icc |1CC profile prepress

profile

Figure 2-4: How color profiles function with a color management system

Photoshop, and other applications that support color management,
embed the ICC profile data within the image file, and the files with
this embedded information are called tagged files (or tagged images).
When you pass the tagged image along, the profile information is
passed along as well. You should be beware that not all image file
formats can include ICC profiles. While TIFFs and JPEGs can, GIFs can-
not.

Note: Avoid applications not using or creating these embedded
profiles and also do not support use of monitor profiles. The color of
the image they display on the monitor or print may or may not be
correct or even close to the true colors. You will not know. Some
applications may even remove the profiles from your image when
editing without telling you.
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Color working spaces

Itis a bit tedious to work with a large number of different device
dependent color spaces. This is why virtual, standardized color
spaces were defined. These do not describe a gamut of a real device
but for an abstract (virtual) device. There are several different such
spaces for each of the color models (RGB, Lab, CMYK). They range
from narrow to broad gamut. For example, for the RGB color model,
there is (from narrow to wide) sRGB, Apple RGB, Adobe RGB (1998),
ECI-RGB and Pro Photo RGB (and several others).

To eliminate a specific working space (including its ICC profile)
of your input device, you usually convert your image from the origi-
nal input color space to a standardized color space and continue to
work on your image using this working space. With digital photos,
you may accomplish this conversion using the RAW converter.

Why define several working spaces for a color model? These
spaces differ mainly in the color range (their gamut) they cover. In
some workflows, it is advantageous to use a narrow color space,
while in others, a wide space is better. If your input device has a
wide gamut (such as digital cameras), you should use a work space
with a wide gamut if you intend to produce output for several dif-
ferent output methods (e.g. inkjet printer, lightjet printer, monitor,
etc.). If you convert your image to a working space with a narrow
gamut, you may lose some colors that could be reproduced by
some of your output devices. If, however, you use a working space
with a very wide gamut, the numbers (bits) representing color val-
ues may not be sufficient to differentiate the many different colors
your gamut allows (with 8-bit there are only 256 discrete values
available). Many of these discrete values may be lost, because your
image may never have colors that extend to the outer edge of the
theoretical gamut of the space. This may get worse if you have to
do a lot of correcting, rounding and transformations. For this
reason, we recommend using 16-bit mode, when you intend to use
a color space with a wide gamut.

The following list shows some of the most important color spaces
for photographers:

» sRGB: This color space was designed to be used with monitors,
and is probably a good one for photos to be presented on the
Web. It defines a gamut that can be displayed by the average



monitor, which is a relatively small color space. Though many
DSLRs allow you to produce images using this color space, sSRGB
color space is much narrower than the color space than the
cameras can see and record.

» Adobe RGB (1998): A color space very popular among
Photoshop users. It has a larger gamut than sRGB and covers
most printable colors. This is the color space we use for digital
photos.

» Pro Photo RGB: This color space was defined and is supported
by Kodak. It provides a very large gamut and should only be
used when working with a color depth of 16-bit.

» Apple RGB: This color space was defined by Apple Computer
and is commonly used with Macintosh systems. Its gamut is
wider than that of sRGB but smaller than that of Adobe RGB.

» ECI-RGB: This color space was defined by ECI, the European
Color Initiative — a group of companies attempting to define
color production standards in Europe. The ECI-RGB color space
was designed to include all colors that may be reproduced by
printers. Its gamut is somewhat wider than that of Adobe RGB
and includes some green colors that can be reproduced by many
printers (inkjet and offset, as well as gravure), but which are not
part of either sRGB or Adobe RGB (1998). ECI-RGB is the standard
RGB color space within the European prepress industry and
serves as the European alternative to Adobe RGB for prepress
work.

Visualization of color spaces

Color spaces are actually three-dimensional (L-, A-, B-axis). The profile
shown in Figure 2-5 is that of sRGB, using the ColorSync utility of Mac
OS X. The gray outer space shows the gamut of Adobe RGB (1998) and
allows comparing these two color spaces. As can be seen, Adobe RGB
is a superset of SRGB.
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Figure 2-5: 3D diagram of sRGB (color) and Adobe RGB (1998) (gray shape)

The industry also uses some form of 2D charts to display color
spaces. The color space plot shown in Figure 2-6 was generated with
the GretagMacbeth Profile Maker Pro 4.1 Profile Editor.
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Figure 2-6: Gamut Display (using Profile Maker Pro 4.1 Profile Editor)

As seen in the diagram of figure 2-6, Pro Photo RGB is extremely wide,
while Adobe RGB (1998) is much smaller and sRGB is very narrow.
We often use “Hahnemuehle German Etching watercolor paper”
for printing with our inkjet printers. The gamut that may be repro-
duced using this paper using Epson’s UltraChrome inks exceeds
SRGB but fits into Adobe RGB. The color space of the “Epson Luster
paper” has a much wider range than that of “Hahnemuehle water
color paper” (no surprise here) and exceeds both sRGB and Adobe
RGB (in some blues and greens). If you have ICC profiles describing
different printing sets (combinations of printer + ink + paper), a dis-
play like the ones shown above allow you to compare the gamut
and thus the color richness you may achieve using different papers.
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Color space mapping

When images need to be converted from one color space to another,
for example, when displaying an image on a monitor, the image is
transformed from its source color space (device color space or work-
ing color space) to that of the output device (your monitor, in this
case). In most cases, the gamut of the source and the destination are
different, so some color mapping has to take place. This transforma-
tion is performed by the color management module (also called the
color management engine).

The main question is: What to do with those colors of the source
space, that are not present at the destination space? Because there
are several ways to handle this problem, ICC has defined four differ-
ent ways of mapping, called intents:

Perceptual (also called Photographic): If the gamut of the source
space is wider than that of the destination space, all colors are com-
pressed to fit into the destination space. If the gamut of the source
space is smaller than the destination space (all colors of the source
are present at the destination space), a one to one mapping takes
place (all colors keep their original appearance).

When mapping from a wider space to a smaller space, the
Perceptual mapping usually shifts colors to a bit less saturated and
somewhat lighter colors, but the overall impression of the image is
preserved (different colors keep their relative color distance).
Perceptual mapping is one of the two intents we use when con-
verting photographs (the other being Relative colormetric).

Relative colormetric: When you map from a wider color space to a
smaller color space and a color in the source space is not present at
the destination space, it is mapped to the closest color at the desti-
nation space, which usually lies at the border of the destination
space.

With this mapping, two colors different in the source space and
not present in the destination space may be mapped to the same
color of the destination space (usually residing at the border of the
that space). This may result in some color clipping or banding. The
white point of the source space is mapped to the white point of the
destination (if they differ) and all colors are adapted relativ to the
destination white point.



The Relative colormetric intent is useful for photographs, and
should be used when the source and the destination spaces have a
similar gamut with lots of overlap or if most of the colors in your
image (which may not use the full gamut of the source space) have
an identical color in the destination space. In this case, most colors
remain unmodified when transformed. This intent is used implicitly,
when colors in your image are translated to colors on your monitor
when an image is displayed in standard mode.

Absolute colormetric: This intent is like a relative colormetric,
where colors present in both color spaces are mapped 1:1, and colors
that are out of the gamut (a color of the source space, that is not
present in the destination space) are mapped to the border of the
destination space. This mapping is particularly useful if you wish to
use your output device (say your monitor) to simulate the behavior
of another device.

You should use this intent only for soft proofing: When you
want your monitor to display what your image will look like when
printed on an inkjet or with offset printing. In this case, the monitor
simulates the white color of the paper.

Saturation: This intent tries to map an out-of-gamut color to a
color of the destination space with the same saturation, even if the
color has to be shifted significantly. Use this intent when converting
logos and colored diagrams from a larger color space to smaller one.
For photographs, it is absolutely of no use! This intent tries to keep
the visual difference of two colors but not their color impression.

Creating device profiles

The introduction above emphasizes the importance of using accu-
rate device profiles. As most of our digital work is done using the
monitor, when setting up a color managed workflow we need to
consider monitor profiles as our most important task. In this section,
we turn our attention to how to build a device profile.

When profiling a device, there are normally two steps:

» Calibration. The aim of calibration is to define a standardized
state for the device, setting its controls so that it is in a state, as
close to this defined state as possible. For example, when cali-
brating a monitor, you manually set the controls of your monitor
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to achieve a certain luminance (brightness of your monitor’s
white) that has proven to be good for color work. Also, you set a
white point conforming to an industry standard, such as D50 or
D65 (color temperatures of 5,000 or 6,500 Kelvin respectively).
The white point of your monitor is a mix of R, G and B that will
represent white.

» Characterization. When characterizing a device, a target is
recorded by the input device, or sent to an output device. A tar-
get is a pattern of color patches with known color values. By
comparing the color values recorded by the device (such as a
scanner) to the known color values of the target, the profiling
program can calculate a device’s color profile, using essentially a
translation table of device-dependant color values to device-
independent color values or vice versa. As an example, if the pro-
file is for an input device, it translates device-dependant colors
seen by the device into the device-independent profile connec-
tion space (PCS, which is CIE-LAB space). If, on the other hand, it is
for a profile of an output device, the table provides translation
from the profile connection space to the device-dependant col-
ors of the output device.

To perform both steps it is advisable to use a hardware device to
measure color. When calibrating monitors, the device could be
either a colorimeter or a spectrophotometer.

As the focus of this book is on the processing of RAW files, we pro-
vide a very brief overview of profiling, with only a bit deeper discus-
sion of profiling a monitor.

Camera profiles

There are two types of camera profiles: generic camera and custom
camera profiles which profile specific cameras. All RAW converters
we discuss come with quite good generic profiles. Some of them
(e.g. Raw Shooter and Capture One) also support customer profiles.

Creating your own camera profiles can be very tricky, since tar-
gets must be shot under highly controlled light conditions.
Additionally, individual cameras of the same model can vary signifi-
cantly (certain cameras vary more than others within type and
brand). For more details on camera profiling see chapter 1.



Printer profiles

There is no single profile for a printer. A printer profile is always spe-
cific to that printer using a specific paper and ink set, and a specific
driver and its settings (such as the same DPI). To make life interest-
ing, profiles for different types of printing paper also vary signifi-
cantly.

Note: While some newer inkjet printers may vary little between
individual printers of the same make and model, profiles should still
be generated for each printer and its specific settings.

When profiling a printer, a target is printed, using precisely the
printer settings, ink, and paper that the profile is intended for. Once
the print has dried (anywhere from 1 to 24 hours) the color values of
the print are measured using either a spectrophotometer or a pro-
filed scanner (less accurate). By comparing known values of the
color patches of the target to those of the measured patches of the
print, the profiling software produces the printer profile.

Fortunately, you don’t need to invest in a costly
spectrophotometer and profiling software; you can use several pro-
filing services, which do this job for you. Look up “printer profiling
service” at Yahoo or Google.

2.3 Profiling your monitor

As stated before, an accurate monitor profile is the basis for serious
color managed workflow. When calibrating your monitor, you have
a choice of doing so by eye or with specialized hardware.

When profiling your monitor, begin by turning it on and leav-
ing it on for at least 30 minutes before beginning any calibration. To
perform the calibration follow the instructions provided by your
choice of tool, whether calibrating by eye or using hardware-based
tools as discussed below.

Be aware that room lightning, the color of your walls and desk-
top and even your clothing can influence precise calibration.

N
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Calibration by eye

Photoshop for Windows comes with a utility called Adobe Gamma
that lets you calibrate your monitor. With Mac OS X there is a similar
little utility called ColorSync Calibrator. Both utilities use your eyes as
their measuring instrument.

Hardware based calibration

Although calibrating your monitor by eye is better than doing no
calibration at all, if precision is important to you, you should use a
hardware based color measuring device (a color spectrophotometer
or colorimeter) to achieve much more precise results. While the soft-
ware and hardware for monitor profiling used to be quite expensive
there are several packages currently available for between USD $100
- $300 for a complete kit. Your choices include: GretagMacbeth Eye
One Display 2 (see [15]), ColorVision Spyder and Spyder Pro products
(see [16]), and MonacoOPTIX from Monaco Systems (see [17]).

We use and recommend GretagMacbeth Eye-One Display 2
and the Sony Artisan monitor (which provides an integrated solu-
tion with a monitor and a special measuring device).

The entire calibration and profiling process will take you about
10 minutes. Once a good calibration is achieved, the next calibra-
tion will be much faster.

Calibration settings

As there are several options when calibrating and profiling a moni-
tor you have to decide which settings to use when starting your cali-
bration. Without going into too great detail, we recommend using
the following values:

White point 6500 K (D65)
Gamma 2.2
Luminance 130-150 cd/m?

We recommend these values even if you do prepress work (where a
white point of 5000 K is the standard) and even if you work on a
Mac where a gamma of 1.8 is tradition.



Calibrating and profiling using Eye-One Display 2

The Eye-One Display package from Gretag Macbeth ([15]) includes
software (Eye-One Match) for calibrating and profiling monitors as
well as a sensor (colorimeter). It supports Windows as well as Mac OS
and allows the calibration of CRTs as well as LCDs and laptop dis-
plays. To use it to calibrate your monitor:

1. Launch Eye-One Match (EOM) and select the monitor from the
list of devices you can profile. We recommend using Advanced
mode.

Eye-One Match

Select the device you wish to profile

Monitors

This is the online help! i will
guide you through every step
of the profiling process

Choose the device you wish
to profile from the options on
the |eft. Browse through the
help to learn more about the
different options.

Select your profiling mode and click the right arrow.

Q Easy

@ Advanced

[ L)

Figure 2-7: Startup screen of Eye-One Match: Select the monitor to profile

2. Select the type of monitor you intend to calibrate (LCD, CRT, or
Laptop), then Click 22 to continue.

3. The first task is to calibrate the sensor (not your monitor). Follow
the instructions given on the screen. (Help will provide you with
additional information.)

4. Select your target calibration settings. We recommend these
values:

-
)
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White paint: | Medium White (6500) i) < Figure2-8:

Gamma: [ 2.2 - Recommended b+] Recommended settings
Luminance: [ 140 - LCD recommenda... F4 for your monitor
calibration

=) will take you to the next step.

5. Attach the sensor to your monitor using either the suction-cup
(if you are calibrating a CRT) or by attaching the lead weights to
your sensor cable and letting them dangle on the backside of
the monitor. If you're calibrating an LCD you may have to tilt the
monitor backward a bit, so that the sensor lies flat on the screen.

T
(&

o

< Figure 2-9:
Eye-One Display
colorimeter

6. Begin the calibration phase using the controls on your monitor, if
your monitor has them. (Skip this step if you are calibrating a
laptop or LCD without controls and continue with step 8). You
will set the contrast control to maximum and then slowly reduce
it until the green arrow resembles the black one. Don’t worry;
Eye-One Match will guide you through this calibration.

O Contrast '

\ ' < Figure 2-10:
Contrast Indicator Contrast Indicator .
5 . - - . . Use your monitor
TIRTR IR RRARMA THHRNTTTEE  dial to bring the
contrast marker
near the zero
value.

Stop )] Stop )]




7. Press Start to have EOM begin measuring the contrast values,
then Stop and £ to begin calibration of the RGB controls. This
step will set the control dials so that the monitor’s white point is
set close to the intended color temperature (6500 or 5000
Kelvin). This may be achieved either by adjusting an OSD (Online
Screen Display) setting on the monitor, or by setting the moni-
tor’s R-, G- and B-controls, if any. In this step, all three colored
bars should be in the green area for optimal calibration. (The
Eye-One Match screen will give you useful feedback.)

RGE Controls ') RGE Controls ')
T T N NI T .
= 5 . = n—— . < Figure 2-11:

C LI |II!II| I mll |II!I| T Ifyour monitor

mr {11 | mi [ 1A has RGB controls

RGE Presets 6500 RGE Presets 6500

Current: 6400 Current: 6500 yOU ShOUId try to
Stop Stop setyour target

white point.

Next, set luminance using your monitor’s brightness controls.

< Figure2-12:

E E Set the
Luminance Indicator Luminance Indicator Iuminance using

] [ TR ” brigh
J {1111 | I T T your brightness
Target (cd/m2); 140.0 Target (cd/m2); 140.0 control of the
Current {cd/m2): 148.8 Current {cd/m2): 140.8 mOﬂitOI’ toa
stop S target value of

120-150 cd/m>.

8. This finishes the calibration phase, and Eye-One Match will start
the actual characterization. It will display a number of color
patches and measure their values (which should take about five
minutes). You won't need to do anything while this process runs.

9. Once the characterization is finished, Eye-One Match will display
the values used and display a diagram of the resulting color
space (see figure 2-13 at page 2-22).

n
N
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Save ICC profile and summary screen

Color Temperature: Luminance:

Target: 3} Target: 140.0 cd/m2

Current: Current: 140.1 cdjm2
Minimum: 1.1 cd/m2

Gamma:
Target:
Current:

| EOM-NEC2180-D65-2.2.icc

Click the right arrow to save your Monitor profile.

= Activate reminder for the monitor calibration

|: 4 Weeks I-H

Figure 2-13: When finished, EOM shows the profiling values
and the monitor color space. Enter a descriptive profile name.

EOM will also prompt you for a profile name. Choose a descriptive
name that reflects the tool used, the make of the monitor, as well as
the values used. For example, if your are using EOM to calibrate an
NEC 2180 monitor with X values, a suggested name might be “EOM-
NEC2180-D65-G2.2".

Eye-One Match will save the ICC profile to the appropriate
folder (depending on your operating system), and will immediately
make it the active and default monitor profile. Running Windows
and having Adobe Gamma installed, you should move Adobe
Gamma out of your start folder to prevent it interfering with the
correct loading of the new monitor profile when Windows starts up.

Once you have completed these profiling steps, do not change any
monitor settings without re-calibrating. You should plan to re-cali-
brate your monitor about once a month.



2.4 Photoshop color and monitor profile settings

Before beginning to work with Photoshop, set up the program up
with your personal color management preferences. The way color
settings are made is similar with all Adobe applications since Adobe
Creative Suite 1 (CS1). When using CS2, you may use centralized color
settings. These settings will be used (by default) by all other CS2
applications, as well. With CS2, the settings may be done in Bridge.

Photoshop probably offers the most advanced color manage-
ment support in any application. For that reason, its color settings
show many different options and parameters.

To begin setting your color management preferences, select
Edit»Color Settings to open the color setting dialog.

Figure 2-10 shows how we set up the “Color Settings” in
Photoshop (the most relevant settings are marked).

Color Settings E x|
" For more information on color settings, search for “setting up
iJ

color management” in Help. This term iz searchabla from any
Creative Suite application,

Cancel |
[ Settin s:ICustUm j
LHng Load... |
— wiorking Spaces
Save...
RiGE: IAdobe RGE [1938) j _—I
=l |u.s. ieb Caated (SWOR) v2 j Fewer Options
Sray: IDot Gain 20% j ¥ Previgw
Se2t |pot Gain 20% j

— Color Managernent Policies
RGB!

Preserve Embedded Profiles

CHYK:

&
Preserve Embedded Profiles j
B

g IPreser\re Embedded Profiles

Profil Misrnatches: W Ask Wwhen Opening [V Ask Wirhen Pasting
Iizzsing Profiles: W ask Wwhen Opening

[ Conwversion Cplions

Engine: | - 4 pe (acE) %
Intent: IReIati\re Colarimetric 'l

¥ Use Elack Point Compensation
W Use Dither (&-bit/channel images)

— Advanced Controls

I_ Desaburate Monitor Calors By I ﬂ %%

[~ Blend RGE Colars Using Gamma: [ 1.00

— Description

< Figure 2-14:
Photoshop color
settings

Note: We ignore settings for CMYK and Gray here as we only cover
RGB color setup in our workflow. If you live in Europe, your CMYK

2
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Setting should either be Euroscale Coated or ISO Coated. If you are
mainly preparing your images for prepress, use ECI-RGB as your
default RGB color space, in which case your settings might look like
this:

Settings: I Custom j T
— ‘Warking Spaces
fete IECI-RGB j
SIS 50 costed =« Figure2-15:
Gray: IDot Gain 20% j Recommended working
Spot: IDDt p— - spaces for prepress work
3 in Europe

Photoshop is not particularly intuitive when it comes to finding the
monitor profile in use. To determine which profile is in use, select
Edit»Color Settings and use the RGB drop-down list to select work-
ing spaces and scroll (usually up) until you find the entry Monitor
RGB (Figure 2-x shows Sony_LCD_Std_Dé65). The entry you see indi-
cates the monitor profile in use.

Note: Close the Color Settings dialog box by clicking Cancel in
order to avoid changing your working space settings. Your monitor
profile should never be your work space!

Color Settings b

3 For more information on color settings, search for “setting up
\l) color managernent” in Help., This term is searchable Fromn amy
Creative Suite application.

Settings: I Custam j —

Wiorking Spaces

RSB I."-\dobe R.GE (1935

it T
Apple RGE
B3 | ColorMatch REE

Spat: =RGE IECE1966-2.1

CIE RGE

CiamondTron Monitor G22 D92

=-zR.GE

Generic EBL 1.5 Gamma Monitor

Generic EBLI 1,8 Gamma Monitor

Generic EBLI 2.2 Gamma Monitor

(Generic Monitor Adobel3398R.GE DES WP 2.2 Gamma
(Generic Monitor AppleRGE DES WP 1.8 Gamma
(Generic Monitor 092 WP 1.8 Gamma

(Generic Monitor 093 WP 2.2 Gamma

Generic Monitor MTSC Ilurminant C WP 2.2 Samma
Generic Maritor Radius ColorMatchRGE DSO WP 1.8 Gamma

(Generic P22 1.5 Gamma Monitor .
Generic P22 1.2 Gamma Monitor ‘ Flgure 2' 76:
(Generic P22 2.2 Garnrna Monitor Flndlng the Monltor

Hitachi Maonitar G22 D92
MEC MultiSync Garmma 1.5 Maonitor

4
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Chapter 3

Basic RAW workflow

Camera: Canon 350D (Rebel XT)

Here, we want to outline the basic workflow steps and tasks of a
digital RAW negative workflow. The RAW converters featured in the
next chapter will perform most of these tasks outlined here.

As an overview, here is a list of the main steps:

Handling the camera in the field using RAW file photographs
Transferring images to the computer

Setting up digital workflow tools

Browsing and evaluating RAW images

v v v Vv

w
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» Essential image corrections
- White balance (WB)
- Improving tonality
- Getting better colors
» Advanced image corrections
» Advanced workflow helpers

In following chapters we will show how these steps can be handled
by the various RAW converters we cover, starting with Adobe Camera
Raw.

3.1 Setup the camera for RAW file photographs

Set your camera to RAW mode

This is a basic step as you merely follow your camera manual and set
the camera to RAW. Some cameras allow use of both RAW and JPEG
simultaneously. We don't always recommend this as it uses more
memory space on the card. Of course, there are instances when it
may make good sense to do so, e.g., when you need to have the
image available as JPEG quickly, without spending time with image
optimization using the RAW converter. For dedicated images, you
may then still go back to your RAW file, getting the most from it.

Exposure, Exposure, Exposure

There are really not a lot of differences from traditional photogra-
phy. A better exposure is the ticket to a good final result. Raw file
processing may allow you to get good results from not-so-perfect
exposure, but this should not be taken as an excuse for sloppy expo-
sures.

A good exposure sounds so easy, but it is not. What you want is:

» No blown highlights
» No underexposed images
» No noisy and dark shadows

The good news is that there is an instrument in digital cameras that
allows you to evaluate exposure instantly after you take the photo:
Itis the histogram.



Optimize exposure using your camera’s histogram

In the field, the main difference between using a film and a digital
camera is the LCD on the back of the digital camera giving you the
ability to evaluate an image right after exposure. You might think
that viewing your pictures on that tiny LCD is a major benefit in
going digital. Yes, if you try hard, you can check sharpness by zoom-
ing in on the image. The main advantage of this LCD for me, how-
ever, is to check exposure in my last photo.

Correct exposure is the key to taking quality images. This did
not change from film to digital. In some ways, over-exposure
becomes more problematic in digital as the sensors tends to clip
data beyond a certain threshold. This equates to: Never over-
expose your photos. In this case, the highlights may be lost and
recovery is not possible (though there are some techniques to esti-
mate lost highlight).

There is help which only the digital cameras can provide: The
cameras provide a way to view the result of the last photograph
taken and show a histogram of the grayscale values from o (black)
to 255 (white).

Here are four histograms examples (created in Photoshop) that
show different characteristics and show histogram basics.

< Figure 3-1:
Histogram 1- indicating
strong overexposure

Highlights (right side of the histogram) have been lost. This shot
would be a candidate for deletion in all but a few rare cases. Some
might recommend to “burn” the photo in Photoshop. Still that is fak-
ing details in the highlights that are not actually there. Histogram 2:
Histogram indicating potential over-exposure

< Figure 3-2: Histogram 2

. . ' . w
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There is only a small spike in the highlights and it very much
depends on the photo whether this might be a problem or not. If the
spike represents a real pure white or an unimportant specular high-
light then this photo may be OK. Otherwise, you are in trouble.

In such cases, if the camera has the ability to indicate overex-
posed areas, we recommend having a glance at the camera’s LCD
preview with the highlight/overexposure indicator enabled.

« Figure 3-3: Histogram 3
- indicates good exposure

Here the highlights are OK. You lost a bit of the dynamic range in the
highlight area but Photoshop can correct for this. You should
endeavor to get histograms similar to this. In principle, it is best to
get as close as possible to the right without actually touching it.

<« Figure 3-4: Histogram
4 - indicates strong under
exposure

Here the data in the shadows are lost. This is not the only problem
since digital cameras show much more noise in the shadows. Once
this image is corrected, extended noise would show up even in the
midrange.

“Expose to the right” rule

From the above we learned that the ideal histogram should:
» Not indicate any over-exposure or missing highlights

» Not under-expose because you may lose shadow details, and
more importantly, get more noise

In conclusion, the perfect digital exposure is as far to the right as
possible without over-exposure. Unfortunately the reality is not that
simple.



The overall shape of the histogram does not matter at all, as it
merely reflects the tonal distribution of the scene you photo-
graphed.

Read the next section and you will understand why it is safer to
slightly under-expose than risk highlight clipping. This is especially
true as some histograms are hard to read outdoors in bright day-
light.

Color channel clipping

We mentioned that most histograms in cameras show the histo-
gram as grayscale levels. But as we are dealing with color images,
we have, in reality, histograms of all three RGB channels.

Some clipping can
happen just in one or
two color channels,
which might not display
in the luminance histo-
gram.

Here is an example
from the Canon 10D
demonstrating typical
problems with saturated
colors. Blue, orange and
yellow flowers are good
candidates, and it is safer
not to use up the full

exposure headroom to Figure 3.5:Image with clipping in the
the right. blue channel

The histogram in Camera Raw 2.2 clearly shows the challenge in the
blue channel.

2.0 histogram of image 3-5.

3.1 Handling the camera in the field for RAW file photographs B 3
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This overexposure in the blue channel was not shown by the cam-
era histogram as it averages all three channels (most often, they use
a so-called luminance histogram, where green gets valued higher
than red/blue).

In this difficult situation, it would be very helpful if you also had
histograms for the three-color channels. The only cameras we
know providing this are the Fuji S2 and the new Canon 1D Mark Il
The latter provides a histogram like this one:

« Figure 3-7: The “after” histogram.

Most cameras allow you to inspect the histogram as part of the
instant preview. Here is an example from the Nikon D7o:

< Figure 3-8:
Histogram from a
Nikon D7o.

Of course, the “after” histogram only helps if you can repeat the
shot. Fortunately, when doing nature photography, this is frequently
the case except for photographing birds and other wildlife. We
check the histogram constantly. Once the exposure is right and the
light does not change, it is necessary to only check the histogram
occasionally.



The "before/live" histogram

The ideal would be to display a live histogram and use it instead of
the camera meter. For digicams, this dream has come to be actual-
ity. The new 8MP Konica Minolta DiMAGE, Sony F828 and Olympus
8080 all sport live histograms.

<« Figure 3-9:
Shot form
the LCD of
the A2.

Implementing live histograms in digital SLRs is problematic as the
viewing mirror hides the sensor. One thing for sure: Refined versions
of live histograms are the way to go.

Do we really need the histogram?

What we actually need from the histogram is the information about
under/over exposure. If this information can be presented by other
means, then the histogram may become obsolete. But, for now, the
histogram is your ticket to a better exposure.

Correct white balance (WB) for optimal color quality

The key to correct color is getting the white balance correct, and
that depends on the light source or sources illuminating the photo-
graphed scene.

When using film, the choice of film type or the filters used to
compensate for different lighting conditions (indoor, sun, cloudy,
shade, flash, etc.) all influence the white balance.

If you use only RAW file formats, WB can be corrected later. For
fine art photography, true color isn't what really matters (would

3.1 Handling the camera in the field for RAW file photographs B g,
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someone use Velvia™ for that?) Most people are more interested in
the subjective ‘correct’ (i.e. pleasing) WB.

Digital SLRs allows you to measure the right WB (custom WB) at
the time you photograph. This might be optimal, but is not always
easy in the field (nature). Therefore, set the WB to “auto” for all
cameras and adjust the WB later in the RAW converter. A preferred
practice is to photograph a gray card (or even better, a Macbeth
ColorChecker) in the same light as the following photos and use
this shot later for the correct WB correction.

Correcting WB (and color in general) can be very tricky, highly
subjective and requires a lot of experience. With practice, you will
improve.

Additionally, an observation: Judging colors is very much a
function of mood. Sometimes colder colors (more blue) are viewed,
and, in that case, you may want more warmth (more yellow). Such
experiments can amount to a lot of time optimizing images.

If occasionally you feel lost, don’t worry. You are not alone!

Understand objective and subjective white balance

There is a significant difference between ‘pleasing’and ‘correct’ color.
Only in a relatively few photographic disciplines are you concerned
about the correct color. This may be the case when photographing
fabrics or, perhaps, catalog shots. Otherwise, usually aim for pleas-
ing colors. The most heated discussions occur over what constitutes
a good skin tone. Even here exist many cultural differences.

Begin with a white balance you prefer, optimize the contrast
and change colors selectively only if there are major issues. Some
shots might need skin tone correction, while in others, the shade of
a boring blue sky.

Adjust your camera’s sensitivity: selecting the right ISO

Today’s digital cameras allow changing the ISO value on the fly by
simply dialing in a new value. This is a huge plus for digital as you
can change ISO speed on a picture-by-picture basis.

A low ISO normally results in lower noise (better image quality)
and a high I1SO means higher noise (lower image quality). Noise can
show up in many different ways. If a camera shows noise-like grains



of “salt and pepper” then this is very positive, as we all are accus-
tomed to this grain from our film-based experience.

Note: Stay at low ISO whenever possible and use a tripod!

If you need to use a higher ISO, try to improve such photos by using
top-class noise removal tools (see Noise reduction at chapter 7).

3.2 Camera to computer: enter the digital darkroom

Manage your image storage

Once back from the field with memory cards and/or digital wallets
filled, it is time to transfer these files to your computer.

Be aware that this requires a lot of disk space. Converting images
to 16-bit TIFFs makes even more demands on disk space.

You might be thinking in Gigabytes and soon in Terabytes. We
currently have about 1,000 GB of storage in our network (to accom-
modate organization and duplicates). A reasonable starting point is
80 GB at minimum then adding external Firewire drives as backup
(perhaps start with 160 GB).

Computer transfer and organizing your photos

Most cameras today come with either a USB or Firewire interface.
Many also use these interfaces to transfer files to a computer. We
personally choose not use this feature, as it offers little help if you
have multiple memory cards and/or digital wallets. Nor do we
believe cameras themselves are the most robust CF card readers.

We chose a USB 2.0 card reader installed on our main PC (same
is available for Macs) then proceeded by copying our images from a
day’s shoot to a new directory in our “inbox” folder.

3.2: Camera to computer: Enter the digital darkroom ® g
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Figure 3-10: Inbox folders

Since several different cameras are frequently used, the goal is to
give every image a different name (even when using two cameras of
the same type).

The following explains the file hierarchy:
» all_2005: all RAW files from all cameras for 2005 go here

» all_dvd_2005_o01: this is the first DVD set (or use CDs) for 2005.
It is suggested you create a new folder when one’s content
exceeds about 4 GB (data to fit on one DVD or 600 MB for a single
CD)

» 20050913_300d_LosGatos: a folder from a single photo session
in Los Gatos (actually better to name it “Los_Gatos” as some
archival tools filter out names.

» The name also contains the date yyyymmdd for easier sorting
» 300d: for information on the camera used

» Subject: (sometime followed by “_o01"or“_ox” if more than one
card was used that day.

All image files are renamed to: 300d_nnnn_mmm where:
» 300d describes the camera type

» nnnnis asequence number (starting at oooo) and incremented.
Why do this? You may use two 300D cameras but still all images
deserve a unique filename. Also, when 9999 is reached, the cam-
era restarts at 0001. Sequence numbers allow unique file names.



If we later work on a file in Photoshop, the result is saved as a master
TIFF file. The file name will keep its original “300d_nnnn_mmm” file
name, and can be appended with more descriptive text:

An example: » Original: 300d_0001_1256
» Derived: 300d_0001_1256_Los_Gatos_Bear_Cafe

In doing this, every file is linked by its original file name to the RAW
file in the archives.

Renaming

As described above, after copying files to a hard disk, files are
renamed to ensure their names will be unique. A free PC utility
called "Rname-it” is used (you can download it from our web site at
[38]). Several others programs are available, e.g. RenamergMac ([39])
for Mac OS X.

The Photoshop CS File Browser and Capture One also allow
renaming your files. We find Rname-it suitable for our use. A file
name can contain a prefix describing the digital cameras used with,
for instance, a name like “1Ds_oooo_". We use software called
Downloader Pro (PC only, see [41]).

¥ Rname.it Version 3.1.1.C |_ O x|
; {1 Photoshop_Settings d I[-d-] 'lIShow ALL files '"Sort flenarnes [& ta Z] [Default) 'l
{:I F'rc-filels  Basic File R enaming O ptions:
a raw_files [~ Make changes ta Prefix | v Prefis: |

L] cl_raw_temp -
{1 RECYCLER J PFlace the new prefis where? (8 Replace €0 Before 0 Stter old|Prefid

{1 steinmueller_phato
E Spstem Volume Information ﬂ Blace the newest where? % Beplace € Befare. € Afterald Ext
[+]-.. Ternn
Frefin- UPPER || Prefis- lower | | Ext-UFFER || Ext - laver |
Search Mask: | 1 - -
|’E0unter for padding to Brefiv or Extension:

[~ Make changes ta Extension | Hew Ext: |

Single/Multiple Extended | ID Apply b Frefin_ || Estension | ™1 Alphabetical court
10 0000_0035.f Starting walue: IDD'I |mnerement by I'I

10 0000_0095-1
Presview: |[ND Real Time Preview for Adwvance mode) Full Preview |

—&dvance Renaming Options:
i Applyto Prefis only " Apply to Extension " &pply to entire name
[~ Search Sting Backward [~ Case Sensitive Search

[~ INSERT | stritigy I at s I (- 255]
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[+ Feplace | shring: |83?S
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4| | ﬂ - Clearl Rename it Options About E it

Figure 3-11: Freeware PC renaming tool "Rname-it"
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http://www.outbackphoto.com/handbook/cameratocomputer.htm
mac.softpedia.com/get/Utilities/Renamer4Mac.shtml
http://www.outbackphoto.com/computers_and_more/veit_downloader_pro/essay.html
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Securing your valuable photos: Backup

After transferring the images, it is strongly advised to backup these
files to a physically different hard disk or to CD/DVD. After that, it is
safe to erase the images from your memory card or possibly refor-
mat the CF cards or Microdrives.

Tip: Backup, Backup, Backup

»

>

Make backup CDs or DVDs

Use two different CD/DVD brands if you make two copies. If a CD
from manufacturer A fails there is a chance that additional cop-
ies may be faulty, as well.

Store each copy in a different location

Once you have stored your files on a disk drive, you can confi-
dently enter the digital darkroom and begin to work on your
images.

Note: Infrequently, your Microdrive or Compact Flash card becomes
corrupt. Do not panic! Get Photorescue (for more information con-
sult our web site [3]) There are several other programs to help
recover images from corrupted file systems or memory cards.

3.3 Setting up your digital darkroom

This step is required only when a new RAW converter is installed or
possibly if you change options.

»

Setting up the cache folder: Most modern RAW converters use a
cache to make unnecessary the need to create previews repeat-
edly while working on a set of images.

Choosing the working space you will use (mainly ProPhoto RGB
for 16-bit only, Adobe RGB or sRGB).

Select either 8- or 16-bit TIFFs or 8-bit JPEGs (we do not recom-
mend the latter).

Some RAW converters allow selecting the per-image-settings are
storage area.

Which application (if any) to launch after converting an image.


http://www.outbackphoto.com

3.4 Browse and evaluate your RAW files

It is quite important for every photographer to inspect both new
and older images. Particularly as you upload your work to a com-
puter, you want to analyze new images as quickly as possible,
decide which to retain and which to delete, and begin working on
the 'keepers!

A small thumbnail, as provided on older file browsers, is not

usually good enough to determine whether the following image
criteria are met. Advisable also is to preview RAW files on a digital
light table which is best integrated with a complete RAW converter.
The critical points to look for when inspecting your RAW files are:

»

»

»

v

v

>

Is the composition satisfactory?
Is critical sharpness achieved?
Is the exposure OK? Here we need to see a histogram.

Quality of colors. This step usually requires a correction of white
balance.

Flagging files and/or setting priorities.
Basic rotation (in 9o-degrees increments).

The deletion workflow: ‘Delete’ sounds simple, right? In fact, it is
one of the most dangerous operations. When you have deleted a
valuable image you know you have a problem. If you keep all
guestionable images, you'll need lots of disk space, having to
view those images again and again. An effective delete workflow
is a two-step process: First, mark for deletion, revisit the marked
images and then finally delete them. The RawShooter solution is
simple, yet elegant. ACR 3.0 and Capture One may provide helpful
solutions, as well.

Ad hoc corrections, where the settings stick with the image: This
implies that in previewing an image you can correct white balance
and exposure on the fly. These settings remain when you revisit

RAW files later on. All RAW converters covered fulfill this criterion.

Ad hoc slide show: (in Bridge and RawShooter)

All the major RAW converters featured in this book are very capable
browsers and inspectors.

w
-
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3.5 Essential image corrections

White balance (WB)

A key part in getting the correct colors in your images is setting the
WB correctly.

White balance (WB) - Essential

Good white balance support is crucial for any useful RAW converter.
There are a couple of white balance correction techniques:

» Gray balance by clicking on a neutral spot in the photo

» White balance correction controls
- Color temperature and tint

— "hite B alance: IEu&tn:lm j —
T emperature I B350
Py
Tint I 41 < Figure 3-12:
= White balance in

Adobe Camera Raw

Calar termperature;

] 7aR0 k.
Tone balance:
Colar cazt corection; Hue Sat
@ K oA
e
o ]

< Figure 3-13:
White balance in Capture One
- Warmer/colder control



< Figure 3-14:

- Presets (daylight, shade, tungsten, ..)
» White balance as shot in camera

» Auto white balance

White balance Colder/Warmer
interface in RawShooter.

Correct white balance support is also not a trivial task for any RAW
converter. We expect that today’s capable RAW converter can pre-

view WB correction in real-time.

Note: Some RAW converters have a single color temperature slider
(measured in Kelvin). These RAW converters oversimplify the situa-
tion of color cast. In many lighting conditions, especially outdoors,

color cast cannot be corrected with a single slider.

White balance samples

This example shows how to use the white balance settings of your

RAW converter.

El@ ’V n A A ¥ Previem [ Shadows [~ Highlights R:-—-

Settings: ICustDm

Temperature
A

1 ®

[T adiust ~Getal Lens \Curve Ncalbrate S|

wihite Balance! [FERlyed

o

Tint

ExposUre [~ Auto IW
e
Shadows ¥ futo |27—
A
0
Brightniess [~ Auto |49—
Contrast [~ autn 45
4
Saturation ID—

Figure 3-15: Image with WB “as shot”
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The camera records WB settings, and these are called “as shot” Such
settings can be achieved with the following camera settings:

» “auto”: means that the camera attempts to make a good guess.
This can be a decent start, sometimes.

» Camera presets (like daylight, flash, tungsten ...): Use this option
only if you know the light source for sure.

» Custom white balance: where the white balance is measured in
the camera. Useful with mixed light or if the light stays constant
for a period of time (e.g. sports photography).

These next samples demonstrate how small changes in color tem-
perature can have a strong impact on color balance.

w
EN
o))

@ ’ % ﬁ o ] ¥ Preview I~ Shadows [ Highlights Ri--- Gi--- Bi-—-

Settings: ICustDm j '@'

White Balance: [Custom =

Temperature 4400

-
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Tink 6

|

Exposure I Auto

: =

Shadaws ¥ Auto 3
L

Brightness ™ Auto 9

Contrast ™ Auto 45

-

R TCHE

Saturation

Figure 3-16: Color temperature set to a lower value

Note: Some may be confused by the notion of “higher color temper-
ature” believing it tends to be bluer or “colder.” Colder in this sense
makes an image look subjectively colder and more bluish.

The above sample displays slightly “colder” because we assumed it
was shot at a lower color temperature.



@ ’V ﬁ. P | Preview [~ Shadows [ Highlights Pl e [hes

Settings: ICustnm j EO)

Temperature I4Bi[l
: .

Tint |+6

-

Exposure [~ autn |+U.?D

o

Shadows v auto |28

-

Brightness [~ Aot |49

~
=

Contrast [~ Auto |+45

-

Saturation ID

Figure 3-17: Color temperature set to a higher value

The above sample displays slightly “warmer” because we assumed it
was shot at a higher color temperature.

Tonality

Exposure (white point), shadow point, contrast and
brightness

A key factor in getting a correct image is creating a good tonality.
Looking at B&W photos you realize that tonality is the only thing
you care about:

How smooth are the tonal transitions
Contrast

Highlights

Shadows

White point (brightest point)

Black point (darkest point)

v v Vv Vv v Vv

With color images it is more difficult to judge optimal tonality. Yet,
the same criteria hold for color photos. Image tonality is influenced
by the following factors:

w
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Exposure, Contrast & Brightness

i) Pt S
EE:...-_']....EI

RGE x| ¥ X A wr BB
Levels | Euwel

|

Bl

o 1.00 25
V. Preserve calor balance v ¢ Figure 3-18:
S e Tonality correction in Capture One

Exposure [ &uko W
=
Shadows [~ Auto IS—
=
Erightness [~ Auto IE-III—
.
L o i
- Camera Raw

Proper exposure compensation is essential. Tools should include a
histogram or equivalent with under- and over-exposure indicators
(Watch also for over-exposure in any single RGB channel). While
under-exposed shots can often be corrected to one or two stops
without too much loss of quality, over-exposure is very difficult (or
impossible) to correct. Once values are clipped in the highlights
(this may occur per RGB channel) there is rarely any way to correct it.
Control exposure to avoid over-exposure at all times.



Adaptive tonality controls

In brightening up shadows, normal curve or levels controls are not
really effective. You need tools that work adaptively. This means that
contrast is corrected locally in proportion to the area in which the
pixels reside.

Exposure compensation
n

E 027 .
Fill Light
k] 18
Shadow conkrask
Tk 17 .
Highlight conkrast
A -1z ., < Figure 3-20:

RawShooter controls

As Photoshop does with its Shadow/Highlight function, RawShooter
uses an adaptive way to improve shadows called “Fill Light”.

Tonality sample #1

Let’s begin with a photo shot at very low contrast.

Canon EOS-1Ds Mark IT: 1ds?_0000_1026.CRZ (IS0 200, 1/160, f/10, 50 mm)

@l 2% #5 4 52 [ Preview [ shadows [ Highlights o G i

Temperature 4600

Tink +6

Exposure [ Auto 00

[i}
Shadows [~ Auto 5
S

-

Brightness [~ Auta 0

Contrast [~ Auto +25

Sakuration a

Figure 3-21: Rock colors photographed at low light
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If you are able to recall the original scene when shooting took
placer, the representation in figure 3-21 may be quite accurate and
it's color correct. But, some flat images look too truthful or even dull.
All this image needs is more contrast to bring it to life.

The histogram shows what this image is lacking:

» There are almost no dark or black tones
» Nor are there real bright tones either

Canon EDS-1Ds Mark II: 1ds2_0000_1026.CR2 (IS0 200, 1/160, £/10, 50 mm})

@ A0 a DO [ Efelign [ shadows | Highlights (shiee e (2
3-20
|
S
Settings: |-
o= ettings: | Custom J @
4
—
o
; Tone Curve: |Medium Contrast j
<
oc
g
wv g
© A
3 y
(28] -~
—
& 7
g A
© e
e 154
Y A
Input: I_ Dukput: l_

Figure 3-22: Improved shadows with ACR curves

Although the curve control improves shadows some, the image is
still unacceptable.



Canon EOS-1Ds Mark II: 1ds2_0000_1026.CRZ {150 200, 10, 50 mm)

RIG A¥ 2 0

¢ [ Shadows [~ Highlights

Figure 3-23: Using the ACR “auto” setting

Settings: | Custom ~-®
“white Balance: |As Shot il
Temperature 4600

ik

Tint +6

Expasure W Auto +0.85

< o
Shadaws v Auto |27—
- .
Brightness v Auta lqa_
4
Contrast [V Auto +50
g

Saturation 0

Using ACR “auto” settings lets the image “pop” - but possibly too

much so.

Canon EDS-1Ds Mark II: 1dsZ_0000_]

El@ ’ %’ ﬁ., @ ."‘ &',a,- [¥ Preview [~ Shadows [~ Highlights

Ri--- G- Bi-—--

Settings: ICustom j ’@'
[ Adiuet *Getal Siens Qurve Nalbrata |

White Balance: |As Shot 5

Temperature 4600

-

Tink +6

k

Exposure ™ Auto IW
e
shadows v Auto Ig;r_
.,
Erightness [~ Auto
.
Contrast Moo [res
23
Saturation IU—

Figure 3-24: The final version with some tweaking based on “auto”
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It is unwise to correct tones only referring to the histogram. Best you
judge it visually, as well.

Conclusion: Low contrast images may be a suitable starting point,
since RAW converters do allow you to improve the overall contrast.

Tonality sample #2

Images covering a wide contrast range are much more difficult to
correct. Here the classic Levels and Curves tools show limitations.

gl 2 | 3 | MG 3 w@L- OMm

Color Temperature:
E] 5850
Tink 7
k] -2

3

appearance | Flatlook v

Exposure compensation
£

Fill Light

¥

Shadow contrast

Highlight: contrast
2
E] 0
Saturation
E 0
Hue
2 [
Sharpness

L

Detail extraction
.
E 0

Noise suppression

E] 0

Color noise suppression
]
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%¢2950,3333 + 43 47 42

l
Currert image: 1ds2_S000_7030,CRZ 3 20,00 % = a - '
Canon EOS-1Ds Mark IT 105 mm, F 8.0, 1/160 sec., 150 100 i = o 8

Figure 3-25: Scene with strong shadows

Normally, these kinds of images are candidates for a Shadows/
Highlight tool treatment in Photoshop CS. The RawShooter con-
verter, however, permits adaptive correction as a part of tonality
control at this early stage of RAW conversion.

Finally, manual fine tuning brings out the best results, shown in
figure 3-27.



1 | 2 3 FrRS

Current image: 1ds2_S000_7030,CRZ E: 20,00 % a - A
Canon EOS-10s Mark IT 105 mm, f 8.0, 1/160 sec., 150 100 ] +

Figure 3-26: RawShooter with “auto” exposure setting

Current image: 1ds2_5000_7030,CR2 3 20,00 % o - '
Canon EQS-10s Mark 1T 105 mm, 8.0, 1{160 sec., 150 100 5

Figure 3-27: Result after careful fine tuning

D a®L- @M

Color Temperature:

E] 5850
Tirk o
k] 2 .
appearance  Flatlook v
Exposure compensation
£ 029 .
Fil Light
% LR,
Shadaw contrast
k] 19
Highiight contrast
| 13 .
Saturation
B 0
Hue
3 0
Sharpness
i
Dietail extraction,
A 0
Noise suppression
i
Color naise suppression
i

3

o 0,300 21 215 224

3 w®BLi- O

Color Temperature:

3 5850
Tink
E] 2E '
Appearance | Flat look -
Exposure compensation
i) 0.26 .
il Light
k] B
Shadow contrast
# .
Highioht contrast
£ zZ .
Saturation
K] 0
Huz
3 i
Sharpness
0

Detail extraction
E] 0

Maige suppression

LColor noise suppression

o 4380660 - 217 219 273

We are convinced that more RAW converters will provide adaptive

tonality control in the future.

3.5 Essential image corrections ® &
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Color corrections

The major step towards correct color is getting the white balance
right. Then, after you have corrected tonality (with the focus on con-
trast), your image should be near what you want it to be. But the
colors in RAW converters are also influenced by these other factors:

» Camera profiles
» Saturation settings
» Color controls in the RAW converter

All RAW converters we are discussing come with reasonably good
camera profiles. Profiles are available on the market, and they may
help improve your results.

It is essential to make a distinction between correct and pleas-
ing colors. As mentioned earlier, in only limited areas of photogra-
phy do you want true and correct colors (i.e., art reproductions, fab-
rics for catalogs). Most photographers, on the other hand, look for
pleasing or even expressive colors. One of the problematic areas is
skin tone. In this arena, pleasing colors are highly subjective.

3.6 Advanced image corrections

It is truly amazing how many defects you can find in an image when
you start carefully looking. While some RAW converters help correct
certain lens deficiencies, in the end you may choose Photoshop to
fix those remaining defects. We dedicate a whole chapter on how to
deal with all these different defects (see chapter 7).

Here is a list of main defects that must be covered at some
point in a workflow:

Noise (luminance and color noise)

Sharpening

Removal of chromatic aberrations (CA)

Vignetting

Cropping

Correcting tilt (so easy to have a shot uneven horizontally)
Perspective corrections

Dust removal

Up-sampling

v Vv VvV VvV VvV Vv VvV v Vv



3.7 Extra workflow support

Here are more features offered by some RAW converters, that may
speed up work and make it easier:

Batch conversion

Background processing

Applying settings from one file to other files
Snapshots of different conversion settings
Save/restore settings

Camera default settings

Undo/redo

Support for scroll wheels

Keyboard shortcuts

RGB value samplers

v VvV VvV VvV VvV VvV VvV v v Vv

We go into these when describing how to work with the various
RAW converters.

N
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Chapter 4
Adobe Camera Raw

Camera: Canon 1DS Mk. I

Adobe Camera Raw (ACR for short) is Adobe’s RAW converter.
Camera Raw version 1 was an optional plug-in to Adobe Photoshop
7, but ACR version 2 is supplied free of charge with Photoshop CS (1)
(also called Photoshop 8). There was a substantial jump in function-
ality with ACR2. Adobe Camera Raw version 3 (ACR 3) is now in its
third generation and is probably the most used 3™ party RAW con-
verter. It comes for free with every version of Photoshop CS1/CS2.

New with ACR3 are Auto-corrections and improved batch pro-
cessing. Additionally, cropping and straightening tools were intro-
duced with this version.

S
-

Basic RAW workflow ®
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While the file browser was a module in Photoshop 7 then
enhanced in Photoshop CS1, with CS2 it becomes a separate utility
called Bridge, now the universal file browser in all Adobe applica-
tions of Creative Suite 2. It provides previews of all kinds of (Adobe)
data files. Though Bridge offers several enhancements over the pre-
vious file browser of Photoshop CS1, for many uses you may well
use the PS CS1 file browser instead of Bridge. Bridge is highly
customizable, and in our estimate, the most flexible and most pow-
erful file browser of all those we will deal with in this book. If you
do desktop publishing, its full strength will become obvious as you
use its close integration with all the Adobe applications, such as
Photoshop, Camera Raw, InDesign, lllustrator, Acrobat, GoLive and
Version Cue. However, in this book, we focus only on those func-
tions, relevant to Camera Raw, Photoshop and our workflow.

As many readers still use Photoshop CS1and ACR2.x, we will
flag those features (if appropriate) since A“® only became available
with Photoshop CSa2.

Canon E0S-1D Mark II: 1D2_9000_0022.CR2 {ISO 200, 1/320, /10, 24-70@35 mm)

@]@ s - ¥ Preview [ Shadows [~ Highlights Ri-- Gi-— Bi-—

Settings: | Image Settings = |-
[ Adjust “Detall WLens \Curve Lalbrate
White Balance: [As Shot -
Temperature 5200
3
Tint +4
3
Exposure I Auto -0.30
Shadows [~ Auto 7
Brightness I Auto 45
3
Contrast [~ Auto +37
3
Saturation 0
-,
S mew ]
[ Show Workflow Cptions
Spare: |Adobs RGE (1998) - Size: [3504 by 2336 (8.2MP) - o | Gneel |
Depth: |3 Bits/Channel - Resolution: |240 pixelsfinch ol Fen | ’WI

4

Figure 4-1: Basic ACR window



Camera Raw 2.x and 3.x can open nearly all RAW files created by
today’s digital cameras. When a new camera is introduced to the
market you may need to wait for the next update of ACR. However,
Adobe has even shipped early beta versions to satisfy its customers.
Perhaps needless to mention, everything in Adobe Camera
Raw (ACR) is fully color managed: Monitor profiles are the same as
used by Photoshop, and for all supported cameras Camera Raw
uses built in generic camera specific profiles.

Quick ACR real life workflow

To use ACR you do not need to understand all its features. A good
point to start is to describe how we use ACR for our own workflow
before discussing the gory details and numerous features of ACR.
We use images from a real-life photo session in Monterey, Califonia
(using the Canon 1Ds Mk. Il camera) demonstrating how to
approach working with ACR on this particular set of images.

Transfer your images to your computer

As described in a previous chapter, we renamed all images using
Downloader Pro. Here is an example: “1ds2_5001_0039.CR2":

» 1ds2 is our specific camera type code

» 5001 is a code we use to identify multiple cameras of the same
type or for overrun of 9999 number limitation. 5001 is also used
for aloaner camera

» 0039 is a camera internal number (camera was new at the time)

B
w
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Chapter 4

Browse the image folder of RAW files using Adobe Bridge

3 20041124_1ds2_Monterey - Adobe Bridge
Fild Edit Tools Label View Window Help

s [=] 5

< |3 20041124_1ds2_Martterey

uftered ~ CF D | @ | &

| Folders

Siprg
123 Profiles
) tax
15 Temp
) tmp
1) travel
125 Tutorials_UweSteinmueller
1) x__digi_negatives_inbox
152 x__digi_negatives_master
B ) x_inbox
2
|5 20050207 _1ds2_Pebble_Beach
1) x_premisre
129 x_thumbs_plus
L DVD/CD-RW Drive (E:)
“# Removable Disk (G1)
= Removable Disk (H:)
“ Removable Disk (11}
e Wishe_RAID (M)
5 Moritz_c on Moritz' (01
e WieheTECHI (v:)

4]

o

150 Country Code

Title

Job Identifier
Instructions

Provider

Source

Copyright Natice

Rights Usage Terms

% Camera Data (Exif)

-JFe

| Matadata “Keywords \Preview \Favorites

b

% % % % % % % %

M
1]

Exposure i 141255 sk Fl8

Exposure Pragram i Manual

150 Speed Ratings i 400

Focal Length {50 mm

Lens +50.0mm

Date Time 11j25/2004, 53334 Al

Date Time Original T 11/25/2004, 5:33:34 Al

Flash i Did not fire, compulsary
mode

Metering Mode ! Pattern

Orienkation + Mormal

Make ¢ Canan

Model i Canon EQS-10s Mark IT

Serial Mumber 303949

Qv

1ds2_5001_0034.CR2
11/25(2004, 5:21:02 AM

< |

1ds2_5001_0038.CR2
11/25(2004, 5:33:02 AM

1ds2_5001_0038.CR2
11/25/2004, 5:33:34 AM

1ds2_5001_0040.CR2
11/25/2004, 5:34:05 AM

1ds2_5001_0041.CR2
11/25(2004, 5:34:29 AM

1ds2_S001_0042.
11/25/2004, 5:35

4F 20items, 1 selected

=

Figure 4-2: Folder selected in Bridge

We use Bridge in the filmstrip-mode giving the layout shown above.
At this point, we could open each picture individually to work on, but
this is not terribly efficient. Instead, we select all images ((ctrl)/[(=)-(A])

and open ACR in filmstrip-mode ((ctr)/[x]-[R]).



Canon E0S-1Ds Mark II: 1ds2_5001_D034.CR2 (ISD 200, 1/640, /8.0, 50 mm)

Select All

Synchrorize,

QD A Hae 208 [ Preview [ Shadows [ Highliohts

Settings: | Camera Raw Defaults =

[ adhust “Detal \Lens Ncurve NCalbrats
White Balance: |As shat ==
Temperature 5450
3
Tint +10
-
Exposure I Auto 0,00

Shadows I~ Auto

-

Brightness ™ Auto 0
: <

B
=
Contrast I~ Auto [rzs
o

Saturation

4+ Imagelfzn
¥ Show Workflow Options
Space: [Adobe RGB (1998) | Size: [4352 by 3325 (16.6 MP) | Save 1 Image... | cancel |
Depth: |8 BitsiChannel ~|  Resolution: [240  |pixelsfinch e R e | ,WI

A

Figure 4-3: ACR in filmstrip-mode

ACR in filmstrip-mode is an important workflow improvement over
older versions of Camera Raw. We now have all RAW files from our
photo session in direct access, and switching from one file to the next
is close to real-time on current computers.

Browse through your images

The filmstrip-mode (for other modes, see page 4-36) allows you to
inspect all shots (almost) as fast as you like.

P
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Make initial corrections to white balance

Sample #1

Figure 4-4: White balance set to "Off"

When we view the crab photo we see that all images are off in white
balance. This was expected as the photo was taken in the shade,
and few cameras with automatic camera-white-balance will correct
this properly. ACR shows the “As Shot”WB settings.

ti Adjust

— White Balance:

Temperature

My
-

Tirik < Figure 4-5: "As Shot"

white balance settings in
ACR

Whenever possible, in such situations, we photograph a Mini-
ColorChecker to be used as a color reference for the white balance.
In this instance, however, we need to use other means to correct the
WB. This is really not a serious problem as white balance for these
kinds of photos is highly subjective.




We have chosen to click on the ice with the WB tool (the eye-
dropper [£)):

P
N
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— White Balance: |Cuskom j =

Temperakture IEDDD
Tink I-'?J

L

L

< Figure 4-27:
Click WB settings

The result looks significantly better, but perhaps a bit too yellow for
our taste. To reduce yellow in the image we enter a color tempera-
ture of about 5,800. Again, this is highly subjective and fully up to
your own personal style and taste.
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Sample #2

:‘-H\I-HAWBH' s

"

~ Adijust
— White Balance: |As Shat
Temperature |4EDD
.
Tink +10
Y
-l

< Figure 4-9:
White balance
settings for “As Shot”

Once more, we have no ColorChecker included in the shot thus no
real defined gray as a reference point in the image. This time, we
begin with a WB preset of “Daylight”.



Figure 4-10: With white balance preset “Daylight”

 Adjust

— White Balance; |[ER]

Temperature
Timk
4 4 Figure 4-11:
White balance at
preset “Daylight”

Again, this result is a trifle too warm for our taste (highly subjective,
too). Ultimately we settled with a WB temperature of 5,000, between
both settings.

1
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Apply settings from one image to other images (especially WB)

Because the other photos of the crabs were shot seectal |
using the identical light, we want to apply the synchrorize.._|

same WB setting to the other crab photos. Keep
the current (master picture, see blue border)
selected and add all the other crab photos to
the selection.

Click on Synchronize:

synchronize
— Synchronize: IWhite Balance j — oK I
v White Balance o] |
[~ Exposure
[~ Shadows
[~ Brightress
[~ Contrast

[~ Saturation

1dsz_S001_0041.CR2

[~ Sharpress
[~ Luminance Smaaothing
[~ Calor Moise Reduction

Figure 4-11:

[~ cChromatic Aberration Image with blue

[~ ‘ignetting border is the
I~ Tore Curve "master picture”
[~ Calibration

[~ Crop

b3

Figure 4-13: Synchronize \White Balance only

Now all crab photos have the same WB settings while the other ori-
ginal image settings are untouched.

Tune tonality

Sample #1

Normally avoiding tools with an attribute “auto’, for tonality we
select the ACR “Auto Adjustments” (not yet available with ACR 2.x) to
provide a solid headstart. You can easily toggle Auto Adjustments
on/off using (ctrl)/[(=)-(u]. Auto adjustments are signaled by the
check marks in Exposure, Shadows, Brightness and Contrast.

Let’s start with Auto Adjustments ON.



Figure 4-14: Auto Adjustments on

We fine-tune Exposure, Shadows, Brightness and Contrast manually.

Settings: ICustnm j _®'

adiust " Detal “Lens “Curve “Calbrate

White Balance: ICustnm = I =
Temperature 5200

& -
Tink -2

o

Exposure v F\LItD +0.30
< o
Shadows v Auto 3

e

Brightness v Auto o5

Cantrast v Auto +46
A
.

Saturation a

A
o

[¥3

In this situation, we were actually pretty close to the Auto-Adjust-

ments. The goal is to always retain shadow details and also keep the

image slightly on the soft side for further fine-tuning in Photoshop.

Figure 4-15: Tonality tuned.

Settings: ICustom j -

Ternperature 5800

white Balance: |Custom = l =
2
I el
A
4

Tint

Exposure [ Auto
A

0
shadows [~ aute

a
-

[
o
Brightness [~ ado I
o

Cantrast [~ auto 4

Saturation

(*3

I
4
—
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Tonality may also be adjusted using ACR Curves, see below (Usually
leave this at a moderate setting Medium Contrast).

Sample #2

Settings: | Custom

Bl

Figure 4-16: Default tonality settings

This image requires further minor tweaks:

» Avoid small aggressive highlights
» Open up the shadows

Figure 4-17: Tweaked tonality settings

Adjust " Detail “Lens “Curve \Calibrate
White Balance: |Custom ] =
Temperature Eooo}
5 :
Tink +10
A
Exposure [~ Auto 0,00
o — . E
Shadows [ Adto B
5 5
Erightness I~ Auta S0
A .
Contrast [ futo +25
5 g
Saturation 0
e
Settings: | Custom =|-®
Adjust *Detail “Lens NCurve \Calibrate N
White Balance: ICustnm El S
Temperature [5000
= 5
Tink [+10
A
Exposurs [~ Aute -0.20
- A -
Shadows I~ Auto |u
5 5
Brightness I~ At |5|J
A
Contrast [~ Auto |
4.
Saturation [
5 E




In addition to these changed | Adiust ] Detal | Lers | Curve Callbrate
parameters, the Tone Curve was
set to ”“near": Tone Curve: ILinear j
Figure 4'18.' > Input: I Cubpuk: I
Linear curve

Organize your images for processing - rank ‘keepers’

If you browse your images, you may want to
rank them. ACR 3.x allows ranking from o to
5 stars. Later, Bridge will allow displaying
only the higher-ranked images so you may
concentrate on the 'keeper’ photos.
Additionally, images may be flagged with
different colors.

ACR 2.x/Photoshop CS1 offers a simple
method for flagging files by your selecting
the appropriate files in the file browser and
clicking the flag icon. The file browser then
displays only flagged images (or if you so
choose, all those not flagged).

Figure 4-19: You may
rank images

Convert images in the background using “Save”

ACR 3.0 adds a new “Save” functionality allowing processing RAW
files in the background (more details later).

N
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w
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Mark bad pictures for deletion Selectal |

It is disappointing viewing your poor B |
images, and there are often quite a few,
even with the best photographers. This is
especially true when shooting sports or
wildlife, often at high rates of frames per
second.

Confirm or abandon all changes

You can end your browsing session with
Done, Open or Cancel.

Save. .. | Canicel |
Cpen | Done I

1dsz_5001_0038.CR2

» Done: Confirms all changes including
the deletion of files marked for deletion Figure 4-20:
(Images deleted are actually put into the XlImage marked
system’s wastebasket where you have a for deletion
second chance to recover them).

» Open: As with Done but opens all selected files in Photoshop

» Cancel: Not a single change will be performed. This tells you that
all new setting changes are lost and no file will be deleted.

If you terminate your session with Open or Done ACR stores (saves) all
settings. We choose to store settings in local XMP files (only if your
files have non-default settings, see page ?7?). In this case, your folder
will also display small XMP files stored with the RAW images.

% 1dsz_5001_0034,CR2 16,206 KB CRZ File 11/25/2004 5:21 AM
% 1ds?_S001_0038.CR2 15,792 KB CRZ File 11/25/2004 5:33 AM
A 1ds2_5001_0038,xmp 4KE ¥MP File 3{11/2005 3:53 PM
& 1ds2_5001_0039.CR2 16,543 KB CRZ File 11/25/2004 5:33 AM
A 1dsz_5001_0039,xmp 4KE ¥MP File 3112005 3:53 PM
T8 1ds2_5001_0040,CR2 14,773KE  CRZ File 11/25(2004 5:34 AM
A 1ds2_5001_0040,xmp 4KB %MP File 3112005 3:53 PM
% 1dsz_5001_0041,CR2 15,477 KB CRZ File 11{25/2004 5:34 AM
A 1ds2_5001_0041 xmp 4KB ¥MP File 51112005 3:53 PM

Figure 4-21: XMP files store ACR settings



Perfect your ‘winning’ images one at a time or batch
process all of them

Which of these depends on your style of post processing and also
on the number of changes made, as well as, how much work
remains to be done per image later in Photoshop.

4.2 Browse and evaluate your RAW images with “Bridge”

Bridge is the new file browser by Adobe for the entire CS2 suite. With
CS2, Bridge is no longer a module of Photoshop, but is a stand-alone
application. In the context of Bridge, ACR plays a special role: ACR
can be hosted by either Bridge or by Photoshop.

@ multiple_raw - Adobe Bridge il _igl x|
FiE  Edit Tools Label View Window Help

@ > |CI rdltiple_raw j = unfitered > CF Y | @ | &

. Folders 40|
B mj N
1) mulkiple_raw_dng

125 New Falder
15 nikon_d70_1
15 noise_tests
Sypl_pes
) plugin_tests
1) pma_z00s J
1) portfalia
Dypso
I pt_lens
15 Rawshooter
1) reviews
15 shadowTluminator
) sharpening
150 sinar_back
15 stern
122 surmit_2004
125 summit_2005

1) think_tank
15 tmp
< | »
] Metadeta] Keywords | Preview] Favorites

\_ Adobe Photoshop C52
,;ﬂ' _portfolio_1973_2005

Drag Favarites Here...

D_7DEA0360, TIF 1D2_8000_0022.CR2 1D5_0000_0112,TIF 10d_0000__0061,CRW 10d_0001_0384, CRW 10d_0001_0385, CRW 10
Bj24j2001, 1:340.,. == 3j24/2004, 453:27 .. B 12/6/2002, 2:48:41 ... B 4/15(2003, 9:0%:26 ... 5 | 6/12/2003, 12:37:44PM  £(12/2003, 12:46:38PM 61

| |
4F 29 items, 1 selected o—————— 3| @ 8= 8% //_‘I

Figure 4-21: "Bridge” File Browser using Camera Raw

N
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Bridge uses Adobe Camera Raw to create thumbnails and preview
images for all supported RAW file formats. Preview images are of
high quality and 1,024 pixels wide.

In the context of this book, we only cover Bridge as it is relevant
to working with RAW files. There are basically two modes in which
to work with RAW files in Bridge:

» Single files can be opened into ARC hosted by Bridge or
Photoshop. (ctri)/[x]+[0] opens ACR in Photoshop and
(ctr)/[<]+(R] in Bridge. Except for minor speed differences, it is
unimportant where you open ACR.

» Working on a set of RAW files in ACR.

Working on a set of RAW files by opening the files singly is not very
efficient. Capture One introduced a substantially more productive
workflow. ACR has adopted a similar style of workflow. You can
select a set of files in Bridge and open them all [ctr)/[x]+(R] in ACR.

Canon EDS-1D: 1D_TDBA0360.TIF (IS0 400, 1,640, /8.0, 800 mm)

Select Al

Synchranize..,

QY #¥ 8B 4s D2 8 [ Preview [ Shadows I Highlghts Py G s

Settings: | Image Settings ~|-®

Tirk +9

Exposure [~ Autg +0.30
- 3
Shadaws ™ Auto 9

f
Brightness I~ Auto S0
- 3
Contrast ™ Audto +32
- 3
Saturation B
- 3
¥ show Workflaw Options
Space: [Adobe RGE (1998) ¥ | Size! [2464 by 1648 (4.1 MP) =l Save 1 Image... | Gareel |
Depth: |8 Bits)Channel hd Resolution; |240 pixels/inch he Cpan 1 Image | ,WI

Figure 4-22: ACR in filmstrip-mode

v



Once you open ACR in filmstrip-mode, previews are created on the
fly. For this task, ACR uses a cache. In ACR preferences you can select
the location and set the size of this cache.

Camera Raw Preferences i

Save image settings in: ISidecar " xmip” Files j
Apply sharpening to: IF‘review images only j Cancel |

Zarnera Raw Cache

Maxirnum Size: |2.D =B Purge Cache |
Select Location, .. | CiDocunents and Settingsiuwel. . on Dataladabe)CameraRaw) Cache),

Figure 4-23: Cache settings

Best to choose a size permitting storing all previews of the largest
folder you intend to process (a single preview file needs about 4.5 to
6.5 MB of disk space). This cache has nothing to do with image infor-
mation (it is stored in a database or in XMP sidecar files).

Still in filmstrip-mode, you may navigate through the images in
real time. Only for a brief period of time, a newly-displayed image
will warn with this icon.

N

This indicator tells you that there may be some minor adjustments
to the histogram and preview while ACR creates the full size image.
At this time, you can navigate through the image set, make
changes, rate or mark images for deletion. None of these changes
are permanent until you confirm them in the dialog pressing Done.

Note: If you work on a set of images, and you the press Cancel, all
changes to all images in that set will be undone. Keep this clearly in
mind so you won't be wasting valuable time. In fact, the deleted
images are put into the system’s wastebasket.

S
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4.3 Adobe Camera Raw 3.x user interface overview

The user interface of Adobe Camera Raw is clean and easy to use. Its
window can be resized up to full screen. The only downside of full
screen is that some operations might slow to less than real-time
which they display in a smaller window (This depends, of course, on
the performance of the computer used). We use a window size that
is quite large, and Camera Raw still performs well in virtually real-
time.

Canon EOS 10D: 10d_0001_0384.CRW (15D 100, 1,20, £/9.0, 50 mm)

@,@ FR Hae oo ¥ Preview [ Shadows [~ Highlights Phe= (e b

Settings: | Camera Raw Defauls - |-

| Adjust " Detail NLens \gurve NCalibrate N
wihite Balance: |As Shot uc P
Temperature 5950
3
Tink -9
3
Exposure [ Auto -0,25
.
Shadows ¥ Auta 3
3
Brightness v auta 75
.
Contrast ¥ Auto 143
>
Saturation o
3
=+ w2 ]
[ Shouw Workflow Options
Space: |Adobe RGE (1998) = Size: 3072 by 2048 (5.3 MP) 2 Save... | cancel |
M€ Bt Channel on: ixls/i -
[N OHE 6 BitsiChannel Resolution: |240 pixelsfinch Open | ’m

Figure 4-24: Basic Adobe Camera Raw Window

The preview image is large enough to judge color and other details.
If you need to view finer details, the preview can be zoomed to
100 % pixels and beyond.




The User Interface Elements

The Histogram

< Figure 4-25:
Use the
histogram as
an aid when
making slider
changes.

This illustration shows an RGB histogram plus histograms of the
three individual color channels, R, G and B. The white areas are those
where all three primary colors are present. Cyan combines green
and blue pixels while yellow combines red and green channels.
Magenta signifies that there are red as well as blue pixel values. It
would be helpful if you could disable the display of the combined
channels, however, that is not currently possible.

Top leftToolbar: [Q|<) #%# B 4 O &

Zoom / Hand tool

ACR supports all the usual zooming and image moving controls that
you are accustomed to in Photoshop. Normally, we set the preview
to “Fit in View” as we do most detailed inspections later in
Photoshop itself (This is, please note, our personal workflow style).

Eyedropper ( # ## ) The eyedropper will be explained later when
we cover WB (White Balance). The eyedropper ## may also be used
for some RGB readouts which are displayed on the right side below
the preview window.

N
4
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Color Samplers

ACR 3 allows up to 9 color
samplers to be placed on an
image.

These can be extremely
useful when desiring to
monitor certain areas in
images and how they are
altered while changing
image parameters.

Clear Samplers |

Al ML EHS
L e an : 4 - é
-
Figure 4-26: ACR color sampler

Crop Tool

You can crop images in ACR too. The crop tool ., also permits arbi-
trary rotation.

Straighten Tool A<

It is easy to tilt an image. The Straighten Tool is an easy way to cor-
rect for tilt. Follow a straight horizontal /vertical line with the
straighten cursor. ACR will then correct the tilt automatically.

QA AP H[] DO

Figure 4-27: Straighten Tool

Rotating "

There are two controls i} £% to rotate the image either clock- or
counter-clockwise.



Workflow options

[ Show Waorkflow Options

Space: |adobe RGE(1998) v Size: |3072 by 2048 (6.3 M) =]

Depth: A Resolution: |24EI Ipixels,l'inu:h j

Figure 4-27: ACR Workflow Options

ICC Working Space

ACR offers four different working spaces.
We use Adobe RGB (1998) or ProPhoto
RGB (only for 16-bit). Currently there is
no way to add additional working spaces,
such as ECI-RGB.

‘.‘
N

Adobe RGE {1998)

[CalorMatch RiGE
ProPhoto RiGE
SRGE TECA1966-1

Bit Depth

From RAW files, you may either produce 8-bit or 16-bit Tiff files when
converting (JPEG allows only for 8-bit files). Most of the time we use
ACR in 16-bit mode.

Output Size

For most RAW file formats,

ACR allows you to up/downsize
an image. The algorithm used is g
much improved over the stan- :

Size: |3072 by 2048 (6.3 MP) =]
1536 by 1024 (1.6 MF‘]I

4096 by 2731 (11,2 MP) +
dard Photoshop 5120 by 3413 (17.5 MP) +

“bicubic”. 6144 by 4096 (25,2 MP) +

“(-)” indicates a down sampling from the native camera format
and “(+)” an up sampling.

If you intend to do large format printing of your image but the
native resolution of the image is not high enough for your intended
size and printing method, we recommend doing your first upsizing
in ACR and, if required, a second in Photoshop.

Resolution

This defines the PPI that the opened file is tagged with. We work
with the standards of 240 or 300 DPI.

4.3 Camera Raw 3.x User Interface overview B
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You likely will not change most of these options often once you
use Camera Raw regularly.

Camera Raw’s main image correction controls

ACR offers five tabs with controls:

r Settings: ICamera Raw Defaulks ;I ~(¥)-

adjust " Detail “Lens YCurve NCalibrate S

Figure 4-29: Main correction tools (tabs) of ACR when
"Extended Mode" is active

Adjust

Detail

Lens

Curve (new in ACR 3)
Calibrate

v v Vv v Vv

We will discuss these tabs in more detail. In most cases, you only
need to bother with three of them: Adjust, Detail and Curve.

Adjust tab

The Adjust tab contains the essential controls used for any RAW con-
version.



- Settings: ICamera Raw Defaulks j ()

Adjust " Detail “Lens “Curve YCalibrate ™
— \White Balance: I.ﬁ.s Shot ;I =
Temperature IS'BSEI
.
Tink I-E‘
Ly
Exposure v Auto I-EI.25
.
Shadows [ Auto iE.
o
Erightriess [ Auko I?S
i
Cantrast v Auto +43
&
Sakuration IIII
.
4 Figure 4-30:

Adjust Tab of ACR

The main tasks done in any RAW converter are correcting White
Balance (WB) and Exposure (EV).

White Balance (WB)

Two sliders control white balance in ACR: Temperature and Tint.
This is how Thomas Knoll (the original creator of Photoshop
and also of Camera Raw) explains their function:

H
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"To get a color to appear white, you need to get three param-
eters correct. This is a basic feature of human vision, stemming
from the three types of color sensors in the eye.

There are several common ways of factoring these three
parameters. Probably the most familiar is red-green-blue
values, where white is when they are all equal to some maxi-
mum value.

Another common factoring is luminance-temperature-
tint, which is what the Camera Raw plug-in is using.

Luminance is basically how bright the light is. This is what
photographers fiddle with all the time by adjusting shutter
speed and f-stop. The Camera Raw plug-in allows you to fine-
tune this using the “Exposure” slider.

The remaining two parameters describe the “color” of the
light.

If you take a black object and start heating it up, first it
starts to glow red, then orange, then yellow, then “white,”
and then a blue-white. The exact color of this light is depen-
dent only on the temperature of the object, and is called
“black body radiation”. It is usually measured in degrees
Kelvin. Unfortunately, humans usually describe lower Kelvin
numbers as being “warmer,” and higher numbers is being
“colder,” which is opposite what science would suggest.

But real world light is rarely pure black body radiation.
Tungsten light comes very close to being a pure black body,
but other light sources usually have a color that is offset from
the black body curve. On one side of black body curve, the
light is greener; on the other side, the light is more magenta.
Fluorescent lights are often very green. The standardized
average daylight values (D55, D65, D75) are all slightly greener
than black body. Flashes are sometimes more magenta than
black body.

The Camera Raw plug-in has two sliders to adjust for the
color of the light. The first is “Temperature,” which is a closest
point on the black body curve to the light's actual color. The
second is “Tint,” which is the offset distance perpendicular to
the black body curve. Positive values means the light is
greener than black body; negative means the light is more
magenta than black body.”



Having used nearly all other RAW converters out there in actual
practice, we conclude that using only a single color temperature
slider does not cut it. We consider the WB control in Camera Raw is
one of the best we have seen, to date.
Of course, Camera Raw also allows a one-click WB. Click with
the eyedropper on a gray or white (no overexposed white, please!)
area and ACR sets the correct temperature and tint values. It is pre-
ferable to photograph a gray card or ColorChecker under the same
light as other images during a photo session, correct from the gray
card image and apply WB settings to all the other photos with the
same lighting conditions (see saving and loading settings below).

Then there are also some standard WB presets:

= White Balance:

Temperature

Tink

Zuskom

[

As Shat
Auko
Dravlight
Cloudy
Shade
Tungsten
Fluarescent
Flash

< Figure 4-31: ACR offers
several predefined WB settings

These presets can be used as a good starting point for manual WB
correction (when you don't find a neutral/gray object in the image).
Please read the section on "Subjective WB” on page 3-8 to
understand that frequently the "right” WB requires further subjec-
tive correction.

D
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Exposure, Shadows, Brightness & Contrast

The slider Exposure allows you to control the proper settings for
tonality (you can also use the Curves tool). ACR has a very powerful,
unique feature to view possible blown highlights. While you drag
the exposure slider, hold down the key and display a threshold
view (works like Photoshop Levels).

[ Preview [ Shadows [ Highlights Ri--- 1G§--- B ---

s
1

1 ___,._—#-P-""'"'- o
Settings: | Custom ﬂ @
Adjust “Detail Ylens “Curve “Calibrate

White Balance: |Custom ﬂ

Temperature F000

Tink i]

Exposure [~ Auko

\

Figure 4-32: Threshold view shows clipped Highlights

If you check the Shadows and Highlights buttons at the top right
top of ACR 3 window, ® Preview [ shadows @ Haichts areas with blown out
portions of an image are marked by ACR*® with a marking color (by
default red = highlights and blue = shadows).

The Shadows slider lets you control the shadows, and, once more,
the (alt) key allows you to see a threshold view.

The preview and histogram are both updated in real-time.



.. - Settings: ICustu:um j —@
| adjust ¥ Detail Yens NCurve \iCalibrate

— White Balance: ICustu:-m j )

Temperature I?EIEIEI

Tink

L

;
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Exposure [T Auto I-EI.EEI
.
Shadows [T Auto IE
- : 2

Figure 4-33: Threshold view shows clipped Shadows

Exposure

With the exposure slider you control the brightest point in your
image. This means that the brightest area in your image should con-
tain the value you choose. The brightest area should not be a white
without any detail unless you have some specular highlights.

Shadows

With the Shadows slider you control the darkest point in your
image. The darkest area in your image should have a value you
choose. The darkest area in an image does not need to hold any
detail and will be mapped to the deepest black your printer can pro-
duce.

Once you have controlled both Exposure and Shadows, then
tune Brightness and Contrast.

P
N
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We recommend using all four sliders to produce either the final

tonality or one that is slightly soft:

» No blown highlights
» No blocked up shadows
» No harsh contrast

Certain tonality corrections needing selection or adaptive controls
(like PS Shadow/Highlight) cannot be performed in ACR. You must

do this final tuning in Photoshop.

Saturation

The control for saturation works quite nicely. We prefer to tune color
saturation later in Photoshop and do it only for selected regions

and/or selected colors usually.

Detail tab

The Detail tab includes controls that handle sharpness and noise.

- Settings: ICustDm j -{D.

| Adjust ¥ Detail *Lens “Curve NCalibrate

Sharpness (Preview Onlyl IES

i
Luminance Smoothing IEI
i
Color Moise Reduckion
i
Sharpness

< Figure 4-34:
Detail tab of ACR

You can get quite good sharpening results with ACR’s sharpness

tool. There are three possible strategies:

» Do all sharpening in ACR (recommended for batch conversion)

» Do approximately 10% sharpening in ACR and later final sharp-

ening in Photoshop

» Leave all sharpening to Photoshop.



We currently tend to use method 3 as we have very good sharpen-
ing tools to use in Photoshop (e.g. CS Smart Sharpen or our own
EasyS Sharpening Toolkit) and choose to leave sharpening as the
final step.

Here is a Canon 1Ds file as an example

Figure 4-36: ACR sharpening 0% on the left and 50 % on the right (shown at 100 % pixels)

You may also set the option Preview images only to prevent the con-
verted files from being sharpened at all by ACR but still simulate
sharpening in the ACR preview. This makes it easier to judge the

4
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image now while using more sophisticated sharpening techniques
later in Photoshop.

Camera Raw Preferences

Save image sektings in; ISin:Ien:ar *xmp* files j

apply sharpening to: | Preview images only j

r Zamera Raw Cache

Figure 4-37: Camera Raw Preferences

We actually have the sharpening setting at zero because sharpening
is done later in Photoshop (or select sharpen for preview only).

Smoothness

Smoothness controls the image noise removal. It can be controlled
at two levels:

» Luminance Noise (detail noise)
» Color Noise (good values seem to be 20-30)

The smoothness control can be used to remove some noise (espe-
cially for higher ISO images). ACR tries to keep the sharpness on all
edges but as with any noise filter, the images gets a bit degraded.
Our strategy is to use as low as possible ISO with all our cameras to
avoid later noise removal as much as possible.

Again, the general strategies are similar as with sharpening:

» Do all noise removal in ACR (only for really high ISO images)

» Do some 10 % smoothening in ACR and later more work in
Photoshop using the filter Reduce Noise, Noise Ninja ([18]) or
equally good tools.

» Leave all noise removal to Photoshop (again “Reduce Noise”,
Noise Ninja ([18]) or equally good tools, also see [17]).

Again, we tend to use the third method or, in general, do scarcely
any noise removal at all.


http://www.outbackphoto.com/workflow/wf_25/essay.html
http://www.outbackphoto.com/workflow/wf_25/essay.html
http://www.outbackphoto.com/dp_essentials/dp_essentials_04/essay.html

Lens tab

| Adjust ] Detail ¥ Lens *Curve \Calibrate

— Chrormatic Sberration

Fix Red/Cwvan Fringe IEI
-
Fix Blue/fellow Fringe IEI
-
— Yignetking
Armount IIZI
-
< Figure 4-38:
Midpoink I
il ACR Lens tab. Midpoint
is grayed out, until an

Amount is set.

This tab provides two very unique tools:

» Chromatic Aberration Removal (CA)
» Vignetting compensation

Lower quality lenses — but also some prime lenses used with full
frame sensors — show so-called chromatic aberration (CA), mainly in

corners.

< Figure 4-39:

Sample Chromatic
Aberration and the fixed
result in Camera Raw 2

CA shows up on high contrast edges. One side will be green and the
other purple. ACR helps remove (or at least minimize) the effect with
ease as the tool works in real time. The Panorama Tools (a free

Photoshop plug-in for image stitching) also contain a CA filter but is

B
w
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pretty slow, and you have to manually try to find the right values.
Adobe Camera Raw chromatic aberration removal is simply first
class beginning with ACR2 and worth the price of the upgrade to CS
alone if you are still using Photoshop 7 and see a lot of CA in your
images.

We have not felt the need to use the Vignetting filter yet. If your
lens, however, shows a strong vignetting, you should do a correc-
tion in your RAW converter. As vignetting may occur a little bit off
the lens center, you may use the slider Midpoint to position the
center of the vignetting.

Curves tab

| Adjust § Detail | Lens ¥ Curve * Calibrate ™

Tone Curve: lMedium _onkrast j

Input: I Cukpuk: !

< Figure 4-40:
Curve Tab of ACR

In theory, you could control the entire tonality using this curves con-
trol, however, correcting using curves often is not terribly intuitive.
We use it only for final fine-tuning. Some presets are provided that
improve the contrast (some weak S-curves mostly).



Medium Contrast

Linear

Medium Contrast
Skrong Conkrask
Custan

medcontrast_low

Officially, there is no support to create your own permanent presets.

< Figure 4-41: Curve presets

Fortunately, the developers allowed a workaround. You can save an
ACR setting-subset to a file. If, at that time, you only select “Tone
Curve,” the settings will be saved in a different folder. These settings
will then show up as Curves presets.

Calibrate tab

This is a tool that
some will love while
others may hate.
Some RAW converters
control colors for
different cameras by
using standard ICC
camera profiles and
even allow the users
to replace the profiles
(example Capture One
DSLR).

Figure 4-42: »

ACR Calibrate tab__

| Adjust ] Detail § Lens | Curve | Calibrate
Zamera Profile: I.ﬁ.CF{ 2.4 j
Shadow Tink IIZI_
4,
Red Hue IIZI_
4,
Red Saturation IIZI_
4,
areen Hue IIZI
i,
Green Saturation IIZI
4,
Blue Hue IIZI
4,
Elue Saturation II:I
4,

This is a very powerful solution if you are able to get “good” (subjec-
tive) profiles. Creating your own profiles is not that easy, and, in our

D
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opinion, better left to experts. There are currently third-party pro-
files for tools like Capture One DSLR on the market.

ACR has hard-coded Matrix profiles for all cameras. The
“Calibrate sliders allow you to tweak profiles defined by ACR. This is
very powerful, but you had better know what you are doing. We
leave the settings mainly at the default (all = 0) but also expect that
some photographers will come up with useful settings for different
cameras. For more details on camera profiling see chapter 11.

How to process the images finally

All ACR versions prior to ACR 3.0 had only had the options Open and
Cancel. This does not envision working with multiple images simul-
taneously. ACR 3 adds two additional buttons: Save and Done.

Save... | Carncel

i

Open | Done < Figure 4-43:
Processing options of ACR 3

It is important to understand these options and all their implica-
tions.

Save: Use Save, To convert an image and return to ACR:
Activate the Save dialog:

Save Options

r— Destination: ISave in Mew Location j
Select Folder. .. | D:l_tmp_workfilesix_acr_tmp} Lcell
r— File Maming
Example: 10d_0001_0385.
|D0cument Marme ;I ar | ;I +
| =] | =l

Begin Mumbering: I
File: Extension: I.tiF 'l

— Farmat: [TIFF

Compression: INone o l

Ll

Figure 4-44: Save Dialog



In the dialog you specify:

» Destination folder for the converted image. We always use a
unique folder “x_acr_temp” used exclusively for ACR output files.

» Renaming options (optional)
» Output file type (either TIFF or JPEG)

Once you press Save, you will return to the main dialog of ACR. But
in the background images will get converted. The ACR dialog indi-
cates this fact by showing a message:

Save Status: 1 remaining

Save,.. | Cancel |

< Figure 4-45: Status of background

BfE = | Dore_| processing

What if you have many images in the queue and want to stop the
rest? Just click on the message and you get this dialog:

Camera Raw Save Status )

Remaining images to process: 5
Original File: Saved File: Status: Stop |
10z_9000_0022.CR2 1D2_9000_0022 b Processing ;[
1Ds_0000_0112 . TIF 1Ds_0000_D112 ki wiraiting
10d_0000_006 1 R 10d_onnn__oe 1 kF i aiting
10d_0001_0384.CR 10d_0001_0354.4F Wiaiting
10d_0001_0385 CR 10d_0001_0385_2 4 Wiziting

E

Figure 4-46: Background Save status dialog

Pressing Stop will terminate all unfinished processing.

Save may be executed without opening up the dialog by using the

(a1)-[ctr)-( S ] (Mac: [=)-(H])-[ s ]) keyboard combination.

Open converts all selected files and opens them in Photoshop. The
ACR dialog is closed and all settings are save (same as Done). This
also denotes that image settings for images not opened will be
saved.

Done Saves all changed image settings and closes the ACR dialog.
No images are opened or converted.

S
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Cancel closes the ACR dialog without saving any changes. No files
will be opened and image processing is done.

Note: If you work on a set of images and you press Cancel, all (!)
changes to all images in that set will be undone. Keep this in mind
to avoid wasting time. Actually, the deleted images are put into the
system’s wastebasket. This note is repeated here to help you avoid
problems.

Saving and reusing settings

Often you want to use the same settings for an entire set of photos.
There are two ways in Camera Raw to save the settings and apply
them later to other images.

Save and Load settings (all [T, | —

settings or subsets are saved
and can be restored).

Once saved into the folder
"Presets/Camera Raw” these
settings are also shown in the

Load Setkings. ..
Save Setkings...
Save Settings Subset. ..
Deleke Current Setkings

Export Settings

settings drop-down list. Use v Use Auto Adjustments Chrl+L
descriptive names for your
saved settings, so you know
their function when recalling
them later on.

Sawve Mew Camera Raw Defaults
Reset Camera Raw Defaults

Preferences. .. Chrl+E

Figure 4-47: Save or load settings
Image Settings: Apply the last

saved setting to this image. Settings: |Image Settings j
e RIS

Camera Raw Defaults: Apply AAUSE | amera Raw Defaults

camera type default (see next

paragra ph)_ — Whike |Previous Conversion
Custon

Previous: Recall values from Ty

. 1Ds_0000_1577

the last conversion done by Pt

ACR for a picture with the Tk | edcantrast

same camera type. rnedcontrast_low
avercask

Custom: User has changed test_calibration

values. Figure 4-48: Drop-down list of settings

Other entries: List of user
saved settings.




Recording Adobe Camera Raw settings

Looking at a converted image, you may wonder which settings were
used for the RAW conversion. By using ACR for the conversion, this is
no problem: ACR records all settings used in the meta information of
the created file. You may recall (view) it in Photoshop by using
Photoshop’s File Information function (File »File Info or via

[e)+Arg+Cer+[1]).

10d_0000_ 0061.CRW

Diescription
Camera Data 1
Zamera Data 2
Carnera Data 3
Categories
History

IPTC Cantact
IPTC Content
IPTC Image
IPTC Status
Adobe Stock Photos
rigin

Advanced

Advanced

= httpeffns, adobe, comnf carner a-raw-settings, 1.0/
- Crsversion: 3,1x1

- crs:RawFileMarne: 10d_0000__0061.CRwW
- craihiteBalance: As Shot

- Crs: Temperature: 5700

- Crs TNt +3

- CreALtoExposure: True

- Cre:Exposure: +0.25

- CrsrdutoShadows: True

- Crs Shadowes: 7

- CcrsautoBrightness: True

- crs:Brightness: 61

- Creddutocontrast: True

Figure 4-49: Recorded Settings

Batch conversion

There are actually three ways to do batch processing with Adobe

Camera Raw:

» Provide your RAW files with the appropriate settings (e.g. call up
ACR with the first image, do all corrections and save that setting.
Then, you may apply this setting to all other RAW images. Select
allimages you want to convert using either Photoshop file
browser or Bridge). Shift-double-click on the last of the selected
files. This will bypass the Camera Raw dialog box and start the
conversion of all images selected.

» Create a Photoshop action (see page 8-5). The action may open a
file, do a RAW conversion using ACR using the assigned setting of

H
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each individual file, open the converted image in Photoshop, do
some Photoshop steps and save the image in a predefined format.
Then use Photoshop’s function File » Automate » Batch to apply
the action to all files of a folder (and optionally all its subfolders).

» Use a script to do the job. A script can do operations a Photo-
shop action cannot do (e. g. use different processing steps depen-
ding on some predefined condition) and can use several applica-
tions like Bridge (e.g. to selection), ACR (e.g. selecting dedicated
settings) and Photoshop. Adobe supports scripts either in Virtual
Basic (with Windows), Apple Script (with Mac OS) or JavaScript,
which may run on both platforms.

Scripting is very powerful, but requires some learning. We rec-
ommend JavaScript, mainly for its independency of platform.

There are a few (Java) scripts shipped with Bridge. Looking at

them can provide you a painless start into scripting.

We go further into batch processing in chapter 8, please refer to that
chapter for more information.

Advanced image corrections

When white balance, exposure and other primary corrections are
done, there may still be some advanced image corrections required.
Here is a list of them and how we deal with them in Adobe Camera
Raw:

Noise (luminance and color noise) » We rarely use Luminance
noise removal as it degrades details too much. Additionally, we
often leave the color noise slider at a low level (10-15). Be aware,
however, that even color noise removal can result in colors bleeding
into other areas.

Sharpening » For optimal sharpening we use other tools in
Photoshop (Smart Sharpen or EasyS Sharpening Toolkit)

Removal of chromatic aberrations (CA) » This is a powerful option
in ACR. Aside from this, you can also use the Lens Correction tool in
Photoshop CSa2. If you still use Photoshop CS1, we recommend you
do removal of CA here.

Vignetting » As mentioned before, we have few vignetting issues
(vignetting mainly occurs with extremely wide angle lenses).



Cropping”“® » Though the cropping support in ACR is very useful,
we often leave the final crop to Photoshop.

Correcting tilt"® (So easy to shoot an image unlevel) » The
straighten tool is very helpful in correcting tilt in images. If your
image is only slightly off, we recommend doing any straightening
here, especially if you convert to 8-bit output.

Perspective corrections » ACR does not have a dedicated tool for
perspective correction. You can use the Lens Correction tool in
Photoshop CS2 though.

Dust removal » Dust removal is best performed with the
Photoshop Healing Brush.

Upsampling » If you know you need your image up sampled, ACR
provides good options. Most often we perform any upsizing later
with Photoshop CS tools (see also our Upsizing articles at [49]).

4.4 Extra workflow support

Batch conversion

You can also perform batch conversions. This is done by creating
Photoshop actions and using these actions in batch mode. Follow
the instructions in the C52 manual and see chapter 8 for more
details. You may also create added actions for different purposes.

One reason to use batch conversions would be to create some
preview JPEG images from newly captured photos, or if a set of
photos has the exact same exposure and white balance (e.g. studio
shots).

Background processing » Like Capture One and RawShooter ACR
(as from ACR 3 on) provides background processing with the new
Save functionality.

Apply settings from one file to other files » You can apply set-
tings from one image to other images in ACR or Bridge.

S
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In ACR:

» Select the original image whose setting you intend to use
» Next, select all the other images that should be adjusted.
» Press the Synchronize button.
» ACR pops up the following Synchronize dialog, where you may
select (or deselect) all settings you want to transfer:
synchronize
— Synchronize: ISettings j—
[V white Balance C I
[V Exposure ﬂl
[ shadows

\\S |v Brightness
|V Caontrast
v Saturation

|v Sharpness
v Luminance Smoothing
¥ Color Moise Reduction

v Chromatic Aberration
¥ wianetting

v Tone Curve

v Calibration

(g < Figure 4-50:
Synchronize dialog
In Bridge:
» Select the original image.
» Use Edit»Apply Camera Raw Settings » Copy Camera Raw
Settings.
» Then select all those images that should be adjusted.
» Use Edit»Apply Camera Raw Settings » Paste Camera Raw

Settings.
The same synchronize dialog pops up:

Snapshots for different conversion settings » ACR does not sup-
port snapshots directly. But you may save as many settings for any
file as you wish.

Save/restore settings » You may save your settings to a file at any
time to recall later on.



Camera default settings » A very important feature for any RAW
converter is to have default settings applying to images created by a
certain camera type. ACR allows setting defaults at any time or to set
them back to factory generic settings.

Undo/redo » With ACR, Undo/Redo can be used for two purposes:
» Actually going back in history

» Toggle between the last and the current state during image cor-

rection ([Ctr-[2)), Mac: [=)-(2]).

In some cases ACR also supports multiple undo/redo by using

(ctr)-(z] and [¢)-[ctr)-(Z].(Mac: (H)-(2] and [o]-(H]-[Z] respectively).

Keyboard shortcuts » For crucial and often-performed operations,
keyboard shortcuts can save a lot of time. All the shortcuts we intro-
duce here are important. Check the manual for others.

Support for scroll wheel » There is no support for scroll wheels in
ACR.

RGB value samplers » Up to nine color samplers can be set using
the eyedropper icon [#I. ACR will show their RGB values in the top
area of the main window.

! ﬂ-'“ *;* .ﬁ ..-"I-_
QI A HE A DD
#1 Ri &3 #2 R 97 #3 R 194 #4 Rizzd
4 G E5 @ G120 @ G152 @ G230 Clear Samnplers

B: EE B: 152 B: E1 B: 231

Figure 4-51: With ACR3, you may set up to 9 color samplers.
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4.5 RAW files embedded in Photoshop "Smart Objects"

One of the very powerful new features in Photoshop CS2 are the
Smart Objects. We will not cover Smart Objects in detail other than
what is needed for our example. Best you read Ben Willmore's book
“CS2 Up to Speed” (see Ben’s book [3]).

Overall, we find Smart Objects more helpful for Designers than
photographers. But there is one feature that is very powerful for
photographers, indeed. You can embed a RAW file into a Smart
Object layer. The process is not complicated, but is not particularly
obvious. The method we describe was introduced to us by Ben
Willmore.

Creating a Smart Object layer that contains a RAW file

First, we may need to change a setting in Photoshop General
Preferences:

— I General j
Color Picker: I Adobe j
Image Interpolation: I BicLbic j
) *  Changes wil take effect the next
UL Font Size: I Small v| \l) time you start Photoshop.
History States: |4EI
— Options
¥ Export Clipboard [~ Beep When Done
W Show Toal Tips W Drynamic Calar Sliders
% [ Zoom Resizes Windows v Save Palette Locations
[T Auto-Update Open Documents W Use Shift Key for Tool Switch
v Showy Menu Colors Automatically Launch Bridge .
@i , . e & < Figure 4-52:
[~ Resize Image During PastefPlace [ Zoom with Scroll ¥heel
Preferences

Make sure that the “Resize Image During Paste/Place” property is
not checked.

Create a new 16-bit RGB document in Photoshop of about 300 x 300
pixels:



bew x|
Name: | Untitled-1 oK |

Preset: I Clstam j C—— Cancel |
Width: IE I Pl Save Presat. ., |
Height: | 200 I nivets Delete Preset.., |

Resolution: | 300 I pixelsfinch

Color Mades | RGE Color | [ & kit
Image Size:

ek Figure 4-53:
¥) Advanced New 16-bit
document

Background Contents: I Transparent

szl LefLefLef]e

Next select a RAW file in Bridge and place it into the new document  4-
by using the Place->Photoshop command in Bridge:

Wl 20050425_350d_SanJuanBautista - Adobe Bridge

File Edit Tools Label Wview ‘window Help

e Window Chrl+M ﬁ =

Mews Folder Chrl+-Shft+

Open Cerl+0

Cpen With [3
Open in Camera Raw. .. Cerl+R.

Close \Window Chrl+W

Send ko Recycle Bin Cerl+Del

Return to Adobe Photoshop 52 Chr+AlE+O

Reveal in Explarer
Rewesl in Bridge

Add to Favorites

File Info... Ctrl4+-Shft+Alt+T 4 Figure 4-54:
WErSions, .. CErl-ShEE AR,
Altermates. . Place Image from

Exit Chrl+Q Brldge

This will open the Camera Raw dialog in Photoshop:

s 3.CRZ (IS0 100, 1/400, /10, 70200084 mm)

o AP Ha DO ¥ Freview [ Shedowe [ Hohiihes

4.5: RAW files embedded in Photoshop "Smart Objects" ®

- Sertngs: | Comer o Defauks =@
& T At Cetal ors Nurvs N S
" |
Temperdrs =
Tk : i |+14
Expaare Ceade oo
- Shodows o —
0E N
1\ ) Pt =
cohrsr -
e T | : 4 Figure 4-54:
o [ave i) w] s [ty o 5] sve el ACR for Placing
Depity: 16 Bes/Charret T T e | e

. aRAW file

1N
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Change your RAW settings and confirm with Open . Now you see
the image of figure 4-55 in Photoshop CS2:

"W Untitled-1 @ 100% (350d_0000_1563, RE
0 L 1 I | I 1 I El

l

[ Ll - 2% «Figure 4-55: After Place

At this point the image is not yet really placed. To continue you need
to confirm the placement with the Return key.

"\ Untitled-1 @ 100% (350d_0000_1563)RE
Hi
""" I ' I B B A R A | MR AR B 1 I

— -

[ioose 8 - 22 «Figure 4-56: After Return

Because the RAW file is larger than our newly-created document, we
view only part of it. Fortunately there is the File »Reveal All tool in
Photoshop available to get back to full size:



Image Layer Select Filter Wiew

Mode 4
Adjustments »
I
Rotate Canvas L4
Crop
Trim. ..
s ¥ dFigure 4-57: Reveal Allcommand

At this point, we see the full-sized converted RAW image as if it would
be normally as Background image. A closer inspection reveals that
we have created a so called Smart Object layer containing the original
RAW file. The first indicator is the different image title bar:

L]Unl:ll:led lml 16. ?“‘n (350d_| l]l]l]l] 1553 RGE/8)

< Figure 4-58:

M- e T bar

» The file name is still “Untitled-1" while a normal opened RAW file
would show the RAW file name.

» The RAW file name shows up as a layer name which indicates that
we have a layer and not simply a Background image

The Layers palette shows more:

| Layars (k)

INu:urmaI ;I Opacity:

Lock: [ &+ & Fill: “

|§ 350d_0000_1563

L

= @ d & 4 4 o 4 dFigure 4-59: Smart Object Layer

The symbol E flags Smart Objects.

Now that we finally have a RAW file as a Smart Object layer, you
may ask: why is it worth the hassle? What is the big difference from
using a converted RAW file as a normal Background image?

In working with converted RAW files you have the following
limitations:

A
o

4.5: RAW files embedded in Photoshop "Smart Objects" ®
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» If you want to change any parameters for the RAW conversion you
have to begin all over again

» Also, you must locate the matching RAW file first

The RAW file in the Smart Object layer makes it much simpler. Double-
click on the image icon and Camera Raw 3.x will open up again and
you can fine tune your RAW conversions settings. There is no need
to search for your RAW files as it is contained in the Smart Object
layer. Finally all information needed for your work on a certain RAW
file is part of your image.

Exporting RAW files from a Smart Object

Because the Smart Object layer contains the full original RAW file,
we can even take the original file back. Select the Smart Object layer
that contains your RAW file and use Layer » SmartObjects » Export
Contents:

Layer Select Filker  Wiew ‘Window Help

My L4
Duplicate Layer. ..
Delete

Flow: [ 1003 [ v | 38

o | 100w [+ ]

Laver Properties...

Weackor Mask r
Create Clipping Mask. Al Chrl+G

Smark Objects Group inko Mew Smart Object
Type b Mew Smart Object via Copy
Raskerize L4

Edit Contents

4 Figure 4-54:
Export Contents

Mew Layer Based Slice

Export Contents. ..

We think that Smart Objects allow a seamless integration of RAW
files and the needed final tuning in Photoshop.

Note: Dr. Brown'’s Services 1.0 make this whole process much easier
to understand (Check out the movie at [48]).


http://russellbrown.com/tips_tech.html

Chapter 5
Pixmantec RawShooter (RS)

Camera: Canon 1DS Mk. Il

Pixmantec RawShooter (RS for short) is a new RAW converter,
created by the software designer Capture One. Capture One has
proven to be very influential in the RAW converter evolution.
RawShooter was designed to be very simple and quick to use. Yet its
focus is excellent RAW conversion results.

As of mid-2005, there is no Mac version. That is a business deci-
sion on which we have no comment. We do hope for all Mac users
that a Mac version of this technology is released in the future.

wn
-

Pixmantec RawShooter (RS) m
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5.1 Quick RawShooter real life workflow

To use RS it is not required to know all its features. It may be helpful
to describe how we use RS in our own workflow before discussing in
detail the many features of RS. Again, we work with images from a
real-life photo session in Monterey, California (using the Canon 1Ds
MKk. Il camera) and explain how we approach working with
RawShooter on this set of images.

Transfer your images to your computer

All images are renamed using Downloader Pro (see chapter 3).

Browse your RAW files using the RS RAW file browser

=10 x|
- M-0 «@ &

] 20041117_1ds2 Sedona 2|
([ 20041022_1d2_SakonSea
(g 20040326_300d_ LosGatos

(L muliple_raw

1] multiple_raw_dng
1) s_raw_keepers_2005
(i #_raw_kespers_2004
1] mi_test_raws

Zivaw_digl_inbioseshcig_inbow_2004%
B sl ovD_z004 01 &
£ | all_DVD_2004 01

B¢l
B

£

-] sl_ovD_z004 01
- sl DYD_2004 02
= sl ovp_z004 02

Correct I Batch conveltl e

e b i Tl A e T Dl A e e e ¢ @ wBL- @M

Color Temperature

4850
UlLss o & 7P s
E] z
Appearance | Flatlook |
Exposure compensation
Ll 0,00
o Fill Light
e -1
Shadow contrast !
o
Highlight contrast B
4 o
¥ Saturation )
20044020_di - =
20041021_d Hue —y e
20041103 _te 2
20041103_1 Sharpness 4
20041110 _te [
20041110 _{l Detail extraction ial
20041111 _tc [i]
20041111 10 MNoise suppression
EVEEE - il .
2004111411

Color noise suppression

----- ) 2041114 1c
| 2m4t1td e
() 20041114 20
2 20041115 30 | B -
e b s pute i i L
B fler%, #-d
5"&-2_011 A |#en] 1 |2 | 3 | o] = | image:s) 20319530 Selection: 20 (319.8 MB)
< | =
Current image: 1ds2_5001_0039.CR2 ~t- COES o
Canon EOS-10s Mark Il 50 mm, F 8.0, 1/125 sec., 150 400 S

Figure 5-1: Folder selected in RS

RS has a RAW-only file browser which helps concentrate on only
RAW files. The RS browser acts as a digital light box. We use the
layout shown with a bottom filmstrip. When you enter a new folder,



RS creates preview files. It is advisable to wait for all previews to be
created, as work goes significantly faster when previews are avail-
able.

Browse through your images

Filmstrip-mode allows you to inspect all shots as quickly as you like.

Make initial corrections to WB

Sample #1

Figure 5-2: WB Off

The crab photos seen have incorrect white balance. This was
expected because the photo was shot in the shade. Few automatic
camera’s WB will correct for this situation. RS displays the “As Shot”
WB settings:

o
w
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Color Temperakure
E 4850

Tink

£ 2 < Figure 5-3:
“As Shot” WB settings in RS

As mentioned earlier, If possible a mini ColorChecker may be photo-
graphed. In this case, however, we will use other means to correct
the WB. Because white balance for these kinds of photos is highly
subjective, no serious problems are encountered .

We have chosen to click on the ice with the white balance tool:

Figure 5-4: White balance after correction (note the eye dropper cursor)

Color Temperature
] (BZ50

Tink

- z <« Figure 5-5: Click WB settings

This has improved white balance. After tonality is improved, the
image may still need some tweaking.



Sample #2

Figure 5-6: Cool white balance

Colar Temperature
E 5050

Tint b 11, ¢ Figure5-7: WBsettings for

“As Shot”

Again, we have no ColorChecker, but also no real defined gray occurs
in the image. For that reason, we change the color temperature by
adjusting the “Color Temperature”slider.

5.1 Quick RawShooter real life workflow B “-m"
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Figure 5-8: With WB at Color Temperature 6000K

Color Temperature
E £000

E 1,

Chapter 5: Pixmantec RawShooter (RS) B ;\"

Tink
< Figure 5-9: WB setto 6000 K

The result is slightly too warm for our taste (this is highly subjective).
Finally we settled on a WB temperature of 6,000 K. Again changes to
the tonality may suggest revisiting the WB settings.

Apply settings from one image to other images
(especially WB)

Since all other photos of crabs were shot in the same light, we wish
to apply the same WB setting to the other crab photos. Keep the
current (master picture) selected and add the other crab photos to
the selection.



Figure 5-10: Select master and target images

Click on the copy settings button "=

Copy image correckions El

— Carrections bo copy

White Balance (Calor Temperature | Tink)
D Appearance

D Exposure compensation

[ Fill Light, Shadow/Highlight contrast

O saturation and Hue

O sharpriess and Detail extraction

O muoise/Color noise suppression

[T Copy allimage corrections

(a4 I Cancel | < Figure 5-11:

Copy “White Balance” only

Now, all crab photos have the same WB settings leaving the other
original image settings untouched

Tune tonality

Sample #1

Normally we ignore tools that proclaim the attribute Auto. But for
tonality correction, the RS “Auto Exposure” often provides us a head
start (keyboard shortcut (a1t)-(E]).

Let’s begin using Auto Exposure. It changes settings for
Exposure, Fill Light, Shadow Contrast and Highlight Contrast.

i
J
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Figure 5-12: Image using Auto Exposure of RawShooter

fppearance | Flat look

Exposure compensation
3

E 0,27
Fill Light
o (13 .
Shadow conkrast
Tk I
Highlight contras
EP -17

< Figure 5-13: Auto Exposure

This adjustment brought much more life to the photo. It requires
tweaking to make it a bit brighter. Overall brightness is achieved
using the exposure slider, brightness in the shadows with Fill Light
(No equivalent for this in other RAW converters).



Figure 5-14:

Appearance

Flat look:

Exposure compensation
T

#

] 074
Fill Light
Tk 15
Shadow contrask
Tk 26
Highlight conkras
BT 17

Comparing the original image to the final result is quite impressive;

Image of figure 5-12 after some tonality tuning

< Figure 5-15:
Tonality tuned

how a few slider changes can make such a huge difference.

5.1 Quick RawShooter real life workflow m :-g
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Sample #2
Again we start with Auto-Adjustments ([A1t)-[E])

Figure 5-15: Image in RS using Auto-Adjustments

fdppearance | Flat look L

Exposure compensation

0.27
Fill Light
3 13 .
Shadow contrask
17 ¥
Highlight contrast
-1t

< Figure 5-16: Auto Exposure
There remain minor tweaks:
» Brighten the image overall

» Open the shadow up (more Fill Light)
» Keep some aggressive highlights in check



Figure 5-17: Image after tweaking Exposure, Fill Light, Shadow contrast and Highlight
contrast

fdppearance | Flat look

Exposure compensation
t

E 0.3,
Fill Light
' E I
Shadow conkrast
Tk 17+ dFigure 5-18: Tweaked tonality
Highlight ':':""jgras,t = settings for image of figure 5-15. The

result is shown in figure 5-17.

It takes less than 30 seconds to achieve a first usable result.

Rank/Prioritize keepers

Prioritize images

wni
-

5.1 Quick RawShooter real life workflow B
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Browsing your images, you may want to prioritize them. RS allows
flagging them, ranking from 1 to 3. By doing this, you can display
only the first-ranked pictures if you choose to do that:

Figure 5-20: RS now only shows those images with priority 1
(there are 3 of them).
Convert images in the background

At any time, convert single or sets of images in the background by
clicking the Process button & or just hitting the Insert key.

Mark bad pictures for deletion

4 Figure 5-21:
: Mark image for
1ds2 S001 0034.CR2 deletion

No matter how unpleasant it may be to view your poor shots, which
happens to even the best photographers, you can mark those poor
images for deletion. When an image is marked for deletion, it is not
actually removed immediately. Rather, it is moved from the all
images tab to the wastebasket tab. If you then view images at the
wastebasket you may undelete them by clicking the delete button



on the thumbnail view again. For final deletion, next press the /=
button. RS pops-up a warning dialog. If you confirm it, your images
will be removed completely (you will no longer find them in the sys-
tem waste basket):

RawShooter essentials 2005 i x|

i)r/ Are you sure vou wank to permanently delete the 1 image Files(s) marked for removal?
-

If wou are not entirely sure, seleck Mo and review the content
of the tab containing the images marked For removal.

Mate: Irmages Far remowval marked as read-only will be deleted without Further warning.
Yes | Mo I

Figure 5-22: You receive a warning before images are deleted

All changes are always permanent

RS stores all settings permanently in some settings file:

B B3 x_inbox u | |2 1ds2_5001_0034.CR2.rws
() 20041124 _1ds2_Monkerey = 1ds2_5001_0038.CR2 rws
- - 1ds2_5001_0039.CRZ.rws

=) 1dsz_5001_0040.CR2 rws
=) 1ds2_5001_0041.CR2.rws
=] 1ds2_5001_0042.CR2 rws
=] 1ds2_5001_0043.CR2 rws
= 1dsz_5001_0044.CR2.rws
= 1dsz_5001_0045.CR2.rws
= 1dsz_5001_0075.CR2.rws

| 20050207 _1dsZ_Pebble_Reach
[ ¥_premiere
|20 = _thumbs_plus
b DYDPCD-RMY Drive (B
“#* Removable Disk (G:)
[# “=* Removable Disk (H:)
“* Removable Disk (I:)

Figure 5-23: Setting files used by RS

The setting files correlate to each folder stored in a subfolder
“.RWSettings".

Perfect your winning images one at a time, or batch
process them all

Whether you convert images individually or use batch processing
depends both on your style of post-processing and on the number
and kind of changes required.

wn
-
w
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5.2 Getting started (setup RawShooter)

Note: Even though a lot of details are covered here, this book does
not replace the manual. Further details and principles are covered in
our e-book DOP2000 ([47]).

After installation, you must register and RS is ready to go. There is
not much to setup, but we suggest the following:

» Select the "Batch convert" tab.
Comect  Batch caonvert |

Less options...

Zamera profile

[nternal [default] ]
RGE warking space

Adobe RGE [1338) “
File Format Bit depth

TIFF W 18 bik b
Ciualicy Meta data

Maximum s ExIF o

[ apply sharpening

| Automatically open with:  Choose,,,
Title | 1Ds_ 0000 S853

bl e i 4 Figure 5-24: Batch convert tab

RGB Working space: We use either 8-bit Adobe RGB or 16-bit
ProPhoto RGB All as shown on the above screen shot.

This is the first RAW converter used with its sharpening set to
“on”, Later we may add minor sharpening with EasyS in Photoshop.

You can also open converted files directly into Photoshop. We
don’t do this most of the time because we have a different browser
displaying the folder with converted files

You may also use custom camera profiles, but, in our estima-
tion, the internal profiles are quite good. We will not feature expla-
nations on how to use custom profiles, but RS fully supports these
profiles and their creation process (see Preferences).


http://www.outbackphoto.com/booklets/dop2000/DOP2000.html

Open the "Naming and output location dialog™:

Maming and location... x|

oukpuk naming

Digits in dublicate names I g | Digit delimiter I -

[ always include digits

Prepend I Append I rse

Sample output name:  Titlerse, HF
Titlerse-01 . kif

—ukput location

" Save converted files in subfolder along side the RawW Fileis)

Subfolder name I Converted

' Different location  Choose folder. .. | Y Figure 5.25-

LY kp_woarkfilesix raw_shooker Set up the

naming and
location for

ok I Cancel I converted RAW

files.

We created a special folder for all converted files
(D:\_tmp_workfiles\x_raw_shooter).

5.3 Inspect and browse your files with RawShooter

Note: As the name implies, this is a browser for RAW files only.

The RAW file browser supports various features. First, you can select
from 5 different layouts to which you can switch ‘on the fly. We use
option #5 — filmstrip-mode:

oEo. 2 R

Imange only alk+1
Thumbnails only — Alk+2
Thumbnails left Alk+3
Thumbnails above  Alt+4
v Thurnbnails below  alk+5

< Figure 5-26: Different layout options

Our main layout looks like that of figure 5-27:

wn
-
wn
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@- M-0 @ @&

2 s®3

Color Temperature
£

Tink

FillLight
£

Shadaw contrast

Highlight contrast

a

| saturation

Hue

Sharpness

Detail extraclion

Maise suppression

r——

(] 7%, 8-

AI\(BB)' A | #em| 1w] 2 | 3 | | o | image S8/ 66(531.1 MB) Selection: 1 (3.4 1B}

Current image: 350d_0000_0251,CR2 ki 26,00 % e -8

Canon EQS DIGITAL REBEL XT 50 mm, F 9.0, 1j200 s=c., 150 100 e

Figure 5-27: Viewing option #5 with filmstrip-mode

At figure 5-28 you find (-] 20040320_1ds_Hwy1_Davenport

Correet | Batch convert|

3
fppearance | Flat look

Exposure :DWDEHSEUUH

Color noise suppression

xr 851,140+ 107 107 107 |

the folder browser and (] 20041022 1d2_SaltorGea
favorites list:

At any time you
can add a folder to M:\digi_inbox_2004%all_DWD_2004_005,200403201
the list of favorites = all_ovo_zo04 004 -]
(either right context =~ = | 20040210_e1_death_walley

----- () 20040211 el Deathvalley

menuorviadrag/ || 20040228 _e1_ Capitola

drop). Favorites are = all_ovD_2004_005

crucial togetquickly . N 0040

toyour last projects. = (| 20040323 12 JimRose _plviso_Te
Once you have E.J 200443324_1d5_I?Utiests_lns_gatu:-s

----- | 20040325 _tds_Filali_1z0

selected a folder, RS = = = = - | 20040325_d70_keeble_test

will start to create | 20040326_300d_LosGatas

previews and thumb- = (| zo040326_d70_LosGatos

nails. RS is notably Figure 5-28: Folder navigation of RS

very fast but using



folders with many large RAW files will
take some time. Two indicators in RS
preview that building is in progress:

e

Figure 9-29 » Al
Progress wheels. % Current i
& Zanon EC

Figure 5-29: Window top border shows how many previews are still to be created

Once previews have been created, the workflow is quite fast. The
filmstrip area allows organizing your images into different priorities:

Current |magelﬁ5_\€lﬂ€la 5243, TIF
Canon EOS-10s 200 mm, f 1.1

Figure 5-31: Filmstrip

There are eight tabs on top:
» Allimages in the folder
» All flagged images in the folder
» Allimages with no priority and not marked for deletion
» Images of priority 1, 2 or 3 (easily tag all files)
» Recently processed images

» Images marked for deletion (if you then finally delete them they
are gone for good)

(¥, }

-
~N

5.3 Inspect and browse your files with RawShooter B
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» The filmstrip toolbar allows =
P O [e%, ¥-u

control of appearance:

- Size of the thumbnails

- Sorting order (name or date)

- Finally, delete images marked
for deletion.

For any single image, perform the following
operations on thumbnails:

Flag image

Set priorityto1,20r3

Mark for deletion

Rotate by 9o degrees, left or right

v v v Vv

Once you have selected a folder and want
to work on a single image, use the full
image view ([Tab) it toggles between both
views):

-y
' v Sork by name
Sort by date

Reverse order

1Ds_0000 5843, TIF

B

| comea | ui.

% wms- mm

Figure 5-32: Work view



You can scale the image up to 800%. 100-400% are @[
pre-defined settings: —=

400%
RS allows conveniently toggling between “fit View” 300%;
and the last selected zoom level by using [¢)-[TaD). S

100%:

If you work with zoom levels, the
navigator panel helps to find the
right locations.

Figure 5-33 »
RSE navigator panel

Here are controls for the main view:

Zoom level 3
Fit to screen

Zoom presets

Hand tool (better to use the space bar)

Show under/overexposure warning colors (can also be activated
on-demand using the key).

v v v Vv Vv

Preview size

RS provides full-sized previews for all cameras. Working with 100%
views or larger is much more convenient than in Capture One (check
out the slide show - see below).

Deletion workflow

Deleting files is an important and critical process. In RS you mark
files for deletion on a folder-by-folder basis. Once you have marked
all files that you want to delete in a certain folder, you can revisit all
those files in the “marked for deletion” tab (e.g. presented in a slide
show - see below). To undelete a file, just uncheck the deletion
mark on the thumbnail pane. When you are sure you want to delete
marked files, click on the wastebasket icon and remove the images
completely (they will not show up in your system waste basket).

wni
-
o]

5.3 Inspect and browse your files with RawShooter B



Some useful keyboard shortcuts

As with other tools, RS provides a number of keyboard shortcuts to
speed up work and which you should keep in mind for efficient work-

ing.

(Tab): toggle browser to image view

(Ctrl: show over-exposure indicator colors
Ctrlj-{Tab): toggle between zoom and fit size view
Alt)-(E]: Auto exposure (good starting point)

520 5.4 Image corrections
|

All correction tools are on one
Correct tab: »

)
5
o
3 Lo . Colder YW armer
5 All essential image corrections . 0
&% fall into the following categories: = Tirt
£ 0
l'cj » White Balance (WB)
g » Exposure and Tonality fppearance | Dutdoor normal ¥
= » Color tuning ! 4
n » Sharpness and detail SR cumpeg]sa L TR
oy » Noise handling Fill Light _
E ki 1]
U The “Correct” toolbar: Shadow contrask < =
] 3 Highlight contrast
L] “ @ & - Y Ry £ SEUEE
Saturation
From left to right: i 0
» Apply settings to other o , =
selected images
Sharpress
» Activate WB gray balance tool | S H
(we use [¢)+Click instead) Distail extraction
] 0

» Set WB to "as shot” in camera"

» Auto WB and auto exposure. - E
Glal foiEe SLUppressorn

Auto exposure frequently
provides a workable starting

point ((Alt)-(E]) Figure 5-35: RS Image correction tab



e =
B% 35 4w HE

Auko White balance Al
Auto Exposure AlE+E

< Figure 5-36: With RS, you may use “Auto

Ak All . ” . .
e White balance” as a good starting point.

» Back to initial settings

» Forward to last active settings

Since we have reached undo/redo features, it is appropriate to show
a very powerful RS tool: Snapshots.

You can create as many snap-

shots as you like, and all those —
snapshot settings are stored for 1 2 8 L&
later use.

Note: RS stores all image settings
in a subfolder with the name
".RWSettings” and all settings files
appended with the suffix “*.rws".

Setting white balance (WB)

Colder "Warmmer Color bemperature

B 0 E 4950
Tirtk Tint :

k 0 E 7
Figure 5-37: WB by Colder/Warmer WB by color temperature

White balance works as usual. The key correction methods are via
color temperature or clicking on a light neutral gray object (do not
use over-exposed white areas). The color temperature’s default set-
ting makes colors colder/warmer. You can change this in Preferences
to sliders using absolute color temperature. We choose the default
colder/warmer method because we believe that WB is, in most
cases, a highly subjective decision.

We find that "as shot” WB is often satisfactory. We do like to
photograph a gray card or Color Checker and use the gray balanc-
ing eyedropper. We are just overlooking some predefined and user
WB presets.

N
—

5.4 Image corrections B



Note: The navigator pane will show how the image would look if the
WB eyedropper is clicked at the current position.

Exposure and tonality

Aside from WB, necessary for

good colors exposure, tonality e s 2
controls are essential in getting Exposure compensation
a pleasing photographic look to Fil Light : it
your images. RS has unique & 0

5.22 controls, and we had to learn Shadow EﬂﬂtrESEi —

how to use them. Most RAW
converters support controls
that, in principle, are a variant
of levels and curves. RS works
differently. It actually operates adaptively (pixels evaluated in their
scene context, more like the Photoshop Shadow/Highlight tool). It
may seem more complicated to describe than to actually experience
yourself. To get the best from an image, you must find the optimum
setting for all four sliders:

Highlight contrask
: ;

Figure 5-38: Adaptive controls in RS

Exposure compensation
Fill Light

Shadow contrast
Highlight contrast

Chapter 5: Pixmantec RawShooter (RS) B

v v Vv Vv

Keep in mind that it is best to make use of all four sliders and avoid
extremes. Do a visual correction with RS displaying supporting his-
tograms (3 types, click to change the display type):

Figure 5-39: Watch your histogram while fiddling with the various sliders.

We like to use version #1. At the top you also find three indicators for
highlights and shadows. They signal whether a certain channel is



being clipped. In the figure above, the blue channel is clipped in its
highlights.

The best way to learn to use the controls is to play using your
own images. We often see stunning improvements. The most accu-
rate word to describe the results is: "/more 3D like.”

Here are some primary guidelines:

Note: All values are entered numerically. If you click the cursor in
one of the fields, use the mouse scroll wheel for fine adjustments.

Exposure compensation (EV): If your image is too bright, tone
down the EV. If too dark, first try Fill Light to brighten the image

Fill Light: For most images it is advisable to stay below a value of 50.

Consider perhaps lowering the EV and then turn Fill Light up. Fill
light also helps opening up shadows.

Shadow contrast: Usually best to tune up giving more depth and
contrast (punch).

Highlight contrast: Used to tone down aggressive highlights.

Again these four sliders work hand-in-hand. Work with all of them.

5.4 Image corrections B

w
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Sample 1

Figure 5-40: Dull overcast shot (Canon 1D Mk. Il)

The Fill Light feature is a key
tool for working with your
images.

Figure 5-41:»
RS settings for tonality

-

Figure 5-42: Resulting image

Exposure compensation
Fill Light _
Shadow contrast

Highlight -:_%j!!:ras_t

0,30
27

30




Sample 2

Figure 5-43: Typical shot with deep shadows (Canon 1Ds Mk. Ii)

Before USing RS, we Spent Expgsure cgmpen:satign

much time achieving the 5 E 0.26
correct tonality for this 2l L";'hth .
image (both in the RAW Shadow contrast
converter and later by oo 34

. . Highlight contrask
masking in Photoshop). 5 25

Using RS, it took us about

30 seconds (actually!). Figure 5-44: Corrections

Figure 5-45: Corrected

N
[
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Sample 3

Figure 46: Over-exposed Canon 1D Mk Il shot

We hope our corrected
photo explains why we
wanted to take the picture

sppearante. | Flatlook. v

Exposure compensation
T

-0.56 ,
in the first place. Fill Light
! |5 29,
Shadow conkrast /
e e
Figure 5-47: » Highlight contrast
' LT

Corrections

Figure 5-48: Corrected



Saturation and Hue

Here you can do minor satura- e
tion and hue tweaking. Usually o
we set both sliders to zero. it -

Figure 5-49: Saturation + Hue

Note: These tools, sharpening and noise removal, are best used at a
magnification of 100% or greater. This is why the sliders are grayed
out at lower values (though they are still fully effective).

Sharpness and Detail

It is hard to know how RS

reaches its level of very natural = 5
sharpness. Both top-of-the-class el i
debayering (demosaicing) and i

normal sharpening are involved.

]

Figure 5-50: Sharpness + Detail

Sharpening: slider normally left at 0. Zero does not mean that RS
does not sharpen at all, but this level is considered to deliver a very
natural sharpness with few sharpening artifacts. We set RS at level o
and do necessary final minor sharpening in Photoshop using either
USM (Unsharp masking) or EasysS.

Detail extraction: This allows the user to set the RS bias for fine
detail or noise. The finer detail you select, the more fine noise will be
undetected and vice-versa.

Here is a sample comparison to our previous favorite of detail ren-
dering, Capture One:

N
N
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il

:
:

Figure 5-52: 100 % magnification with C1 + strong EasyS sharpening



Figure 5-53: 100 % magnification with RS + very light EasyS sharpening

It is amazing how images appear coming directly from RS with shar-
pening level set to o (we again remind you that this does not mean
there was no sharpening). Images do seem to have a more 3D and
natural look.

Noise reduction

Actually removing noise is easy. We hear you yelling :-). However,
removing noise AND keeping detail is the real challenge. Even more
difficult, is doing noise removal in near real time.

Honestly, we have not played enough with RS for a final judg-
ment. Also, we do not use many high ISO shots. Still, RS may be the
first RAW converter that is good enough for most of our photos
without third party noise removal tools.

The developers of RS have invested a lot of work into noise
removal since their tonality feature allows brightening shadows
quite a lot. This operation is also pulling out noise, which is found
primarily in the shadows. Opening up shadows usually needs effec-
tive noise removal. The two sliders provided deal with the two
most common types of noise:

N
©

5.4 Image corrections |
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» Luminance noise

Motse supnresson

» Shadow noise 5

il

We use the noise removal tool
in our sample session below.

]

Color noizes supprazsion

]

Figure 5-54: RS noise reduction

Batch processing

When all parameters are set, Add S e s
add the image .to the batch 1Ds_ 0000 5850.TIF =
queue. Processing is done in 1Ds_0000_58350

the background while you work
on the next image. =

- 10 0000_5852.TIF

1DS 0000_&a52

At any time you can view the
batch queue and add, stop or
remove batch jobs.

1D 0000 5853 TIF
1Ds_0000_5853

| 1D:_0000_5854.TIF
'IDS_EIEIEIEI_5854

10s_0000_5855

E | 10 00005855 TIF
Figure 5-55: »

RS image batch queue

Slide show

|4

Another nice feature in RS is: A slide show. The slide show is useful

for two purposes:

» To simply view your pictures

» To set priorities and for tagging files for deletion




Figure 5-57: Controls

The slide show may be the best way for
an initial preview of your images.

Note: It is preferable to wait until all pre-
views for a folder are created before gen-
erating the slide show as this process can
be very slow if you try to do both simul-
taneously.

Figure 5-58: »
Timing and transitions

v [Manual
1 Second
2 Seconds
3 Seconds
4 Seconds
5 Seconds
6 Seconds
7 Seconds
& Seconds
9 Seconds
10 Seconds

Loop

Transition

v [one
Blend
Fade
Wit

W
—
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5.5 Advanced image corrections

Although RawShooter is still quite young, and until now focuses on
basic conversion functionality, there already exist quite a variety of
advanced image corrections. Expect to see even more in upcoming
versions of RS.

Noise (luminance and color noise) » Noise suppression in RS
works quite well. You may not need specialized noise removal tools.

Sharpening » For optimal sharpening, we use some sharpening in
RS and still more later with other tools in Photoshop (Smart Sharpen
or EasyS Sharpening Toolkit).

Removal of chromatic aberrations (CA) » No correction of chro-
matic aberrations are offered with RS 1.1.

Vignetting » No correction of vignetting is supported with RS 1.1.

Cropping »RS (as of version 1.1) does not offer cropping, so any
cropping can be accomplished in Photoshop.

Correcting tilt » No tilt correction is offered with RS 1.1.

Perspective corrections » No perspective correction is offered with
RS 1.1.

Dust removal » There is no provision for dust removal in RS 1.1. Dust
removal, thus, is best performed with the Photoshop Healing Brush.

Upsampling » No up or down sampling is supported with RS 1.1.

5.6 Extra workflow support

Batch conversion » you may convert any selection of images at any
time in the background.

Background processing » RawShooter processes all conversions in
the background. This is very convenient when working on a large
number of images. It, however, slows down your foreground pro-
cessing a bit.

Apply settings from one file to other files » This may be easily
done (see our Batch Processing chapter 8 for more information).



Snapshots for different conversion settings » A very powerful feature
of RS is Snapshots. You can save the current settings by creating a
new snapshot. Snapshots are permanently stored with your settings.

Save/restore settings » You may save your current settings, load
them again and reset to RS defaults.

Camera default settings »

RS allows defining default cor-
rection settings on a per cam-
era model basis.

Undo / redo » Snapshots
allow you to go to and fro
— from current settings to
previous settings.

Keyboard shortcuts » For
crucial and often-performed
operations, keyboard short-
cuts can save a lot of time. All
shortcuts we introduce here
are important. Check your
manual for others.

Support for scroll wheel »
Click in any numeric field and
use the scroll wheel on your
mouse for fine-tuning.

Processing Bias Paramete x|

These bias parameters will be applied in
addition ko the corrections made in the
Correct panel and are used with all Fasw
images originating From the camera model
specified below,

Camera:  Canon EOS‘R?S Mark, IT
Exposure bias

0.00
Shadow contrast bias

]
Sharpening bias

]
Detail extraction vs. noise suppression

]
Sakuration bias

]
Hue bias

]

Figure 5-59: Processing Bias

RGB value samplers » RS has one color sampler that can be set to
show the RGB value of the pixel below the mouse cursor during the

editing of a single image.

W
W
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Chapter 6
More RAW Converters

Camera: Canon 1DS Mk. I

By previously digging deeper into the details of Adobe Camera Raw
and RawShooter, we will shorten our description of those additional
RAW converters. In so doing, we are not judging them less valuable.
In his chapter, we describe the main features and some specialities

of these converters.

[«))
4

More RAW converts |
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6.1 Phase One’s Capture One DSLR (Capture One)

Capture One Pro by Phase One ([20]) has been available for some
time and has a generally good reputation. The company is well
known for its P-series of digital camera backs for medium format
cameras, such as the Mamiya RZo or Hasselblad 6 x 6.

We use Capture One DSLR Pro when working with our Canon
1Ds, 10D and Nikon D1x, D1oo and use Capture One Rebel with the
Canon 300D. Capture One DSLR is available for Windows and Mac
0s.

There are two main features making Capture One a state-of-
the-art RAW converter:

» Excellentimage quality
» Great RAW converter workflow
» broad range of supported digital cameras

[ Coturs (rm LS Lawsad dubdion, 13 daps iriaf - L], B8] el F ' | Comwors GES- i G

Figure 6-1: Capture One DSLR



There are various versions of Capture One (i.e. Capture One Pro and
Capture One SE) each supporting unique function levels and differ-
ent sets of cameras. Previously available LE version of Capture One
has been discontinued.

Note: Some dialogs may differ, but is of little concern as we cover
only those features used in our workflow.

Capture One is fully color management aware, an essential quality
in doing any serious color work. The best way to appreciate Capture
One is by learning how it works.

Capture One DSLR is what is called a “Full Service RAW Converter.”
This means you can accomplish nearly all operations on your final
image inside this tool (one exception is retouching, such as cloning
and lens & perspective corrections).

Note: Capture One DSLR RAW conversion is not based on the Canon
or Nikon SDK. It uses its own algorithms utilized on their high-end
digital backs for many years.

In fact, Capture One DSLR implements a highly-productive workflow
for RAW files it supports.

We must remind you that this section is not intended to replace
the manual, as we cover only the primary steps and settings.
Capture One DSLR deserves a book of its own.

Capture One Setup

First, some help in setting up the preferences. We strongly recom-
mend you take care to follow these essential settings:

» DSLR noise Suppression: our preference is to set this at low or
medium/low for lower ISO images.

» Disable sharpening on output. Doing so simulates sharpening of
the preview but does not apply sharpening to the output. We
inspired this feature as we do sharpening later in Photoshop, but
still wanted a preview that appears sharp.

» We disable opening of the developed image in Photoshop.
Rather, these files are visible in the Photoshop file browser.

» Activate the separate RGB channels for a histogram.

6.1 Phase One’s Capture One DSLR B 3
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e £

Preview Cache | Miscellaneous Settings I Develop settings I Exposure Evaluation |
Develop settings | E=posure Evaluation Preview Cache Miscellaneous Settings
— Maming i~ Default sharpening
Default name: | Untitled Method:
TIFF extension: | tif JPEG extension: |.jpg AmoUn ) 176 %
Mame delimiter: |- Thieshold: - - - - ’T

IV Use capture name a3 default name

— Drefault color saturation

™ Include 3 digits for duplicated filenames |
Sample name:
My Image. tif T Automatically open developed images
My Image-1.tif & With the . TIF associated application
I Include capture infarmation in TIFF Caption " Selected application  Choose... |
IV Include EXIF infarmation |
Autist: |Unspecified

Copyright: [Unspecified

— Processing setting:
[ Do NOT ratate the image (according to orientation]

[V Disable Sharpening on output

¥ | Perform processing on single processar [V Hide focus orientation frame automatically

Banding suppression: DSLR noize suppression: ™ Render background in zolid gray ;—Ji
] s 0 ! g [] T d [~ Enable JPEG Browsing

Lo High  Low High

’TI Cancel | ’TI Cancel |
Figure 6-2: Setup of Preferences in Capture One DSLR

Color Management Settings™ A

Camera Product:
Canon EOS-10D R

Carnera profile:
|I:an|:un EOS-100 Gereric |

[T Only show Phase One camera profiles

CQutput destination [Working Space):

\adobe RGE (1998) =]
Weh destination
\sRGB IECE1966-2.1 =]

Proof destination
\Adobe RGE (1398) -]

i oritor profile:
|ﬂnrtisan_D BE 2216123285 ﬂ

[~ Urlock Manitor profile zelection menu

Wwindaws bMaonitor prafile:

}-’-‘-.rtisan_D BS 2216123285 4« Figure 6-3: Capture One
color management setup




» Camera Profile: Capture One offers generic profiles for supported
cameras

» Working Space: We use Adobe RGB (1998).

» Monitor: At this time, enter your correct monitor profile (Capture
One actually checks for a mismatch to the system monitor pro-
file)

Capture One RAW file browser

tu¥ Lirm (8 Lo dubbior, 13 sheps iryaf [0 B0 _ bl LR | Cars BOS- i o

SO-H- "R . v H=

" p—r

i
E
:
i
g
B

i
i
1

6.1 Phase One’s Capture One DSLR & a

Figure 6-4: Image Browser in Landscape Mode

At first glance, the browser view appears as a nice but normal image
browser. There are some major differences, however:

» By pressing function key F8, the browser toggles from portrait to
landscape mode (allowing maximum space for preview image).

» Browser and Capture One do not use original RAW files for pre-
views. Instead, Capture One creates its images in the back-
ground, and once these previews are created, you can switch
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from one file to another in nearly real-time. The downside of this
approach is the large disk space needed for the preview cache (It
can be cleaned via the preferences dialog).

» Capture One allows users to define permanent project folders.
Doing so simplifies accessing all current project folders quickly.
The preview images in these permanent folders remain even
after cleaning the cache.

Image Processing

Image processing in Capture One is a five-step workflow:

Inspect

Gray Balance your image
Correct exposure and contrast
Sharpen (called focus)
Develop

v v Vv Vv Vv

Inspect

The first thing to do is to review
photo and capture information, at:

- Expozure evaluation

» Histogram (best used with three-
channel histograms)

» Data recorded by the camera, for 4 ] % 1 i

example: - Capture Information [Canon EDS 100] —
Capture |D: 220105445-3000060

- 1ISO Capture time: 2002:04:15 16:03:04
150 Speed: 100

— Exposure time and aperture Exposure time [T+]: 1/400 zec.

p p Aperture [Ayv] FE.0

- Lensused Flash: Off
Focal Length: 90 mm

- Flash Exposure Program: [M) Manual

Metering Mode: Evaluative
Auto Focus Mode: Manual
Whitepaint: Auto

| Develop | Focus | Exposure | Gray Balance| capture [

Figure 6-5: Capture tab of CO



Gray/White Balance (WB)

The main tool used for gray balancing is the eyedropper. Select a
gray area within the image and click the eyedropper. Capture One
helps by giving you hints as to whether this is the best spot for gray
correction.

If no gray exists in the image, things can get a bit more compli-
cated. In such case, it is suggested you use the color temperature
controls (Color Temperature and Tone Balance).

Best to have taken the shot with a gray card or Color Checker
(we have one with us at all times) using the same light. Makes gray

balancing much easier. Capture One also allows additional cast cor-
rections.

.

- % I mh
Custam... Rl =

@O KRB

[f Selected [Good] White balanced

E
i
jun}
=
1]
e
ak}
‘ M54 74
= 154 152
far}
2 Msg 145
1=
=
2
@  Color temperature:
=
L% ] 4375 K
= Tone balance:
L
— Calaor cast carechion; Hue  Sat.
g L i =l
)
&
(]
® K oA

| S
e < Figure 6-6:

Capture One’s Gray Balance tool

Since you can save/restore WB settings, you can also save some
sample settings for the same light conditions.

Capture One provides automatic correction. As in all automatic
corrections, results may not be optimal. Try and decide for yourself.

6.1 Phase One's Capture One DSLR B |
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Exposure

After white balance, expo-
sure is the next most impor-

[E*‘ | 150 100 | Film standard -

tant correction tool. Here, by e |
you can correct £2.5 EV. The s _.] e -|T

histogram and preview
image (use this option in the
toolbar) let you inspect all
areas of over-/under-»
exposure. Especially impor-
tant are the RGB channel his-
tograms as there are often
over-exposures in only one
of the channels.

Besides EV, you may
correct contrast and tweak
saturation (try to maintain
moderation).

RGE | b NN =

Levels I Curve |

.4

0 1.00 251

J ‘f Freserve color balance v
Figure 6-7:» Raw RGE Destination

Capture One Exposure r_ r_
£ =
Tone Curves = =

In addition, Capture One e T
includes a variety of tone
curves:

IS0 200 | Film standard -

| Develop | Fncus| Exposure Gray Balance | Capture

] e et R LA

0o Flm gxtra shadow p Figure 6-8:
cp | Linear response Capture One offers some
= predefined tone curves

For most situations, the standard tone curve Film Standard will do.
When requiring greater shadow detail, try Film extra Shadow.The
curve Linear Response is used mainly for profiling purposes.

More and more often we find Curves in Capture One to be use-
ful, especially in recovering some shadow detail. Otherwise we
leave shadow recovery to Photoshop.



Focus and Sharpening

The Capture One sharpening tool
is a classic Unsharp Mask (USM).
Refrain from over- sharpening your
images.

As mentioned earlier, we
leave our own sharpening until
later in the workflow process.

Figure 6-9: »
Capture One Focus tab
o P R 100%
Sharpening Freview Setings: W

Develop tab

Method: | Standard ook~ =)

Clicking the Develop button .2 Tk 140
(or the Insert key while you are Thaheld o ——— 5
viewing any tab) a real RAW con-

version is performed. Once again, | s B
Capture One demonstrates its [10d_0000._0060
focus on workflow. Here’s how? S
RAW processing is done in the Widh | 3076 —
background, and Capture One is Height | 2052 Fieel [
free for the fur.ther interactive Resoluton: | e e
image corrections.

File format; |T|FF ~|

Note: Capture One LE can have
only a limited number of files for
development at any time. We work
around this limitation by working
on developed files in Photoshop.

Bit Depth:  |16Bt v/
Filesize: | 381MB | 5.3GB

Calar Management wark o
| Corwet to Destination |

6.1 Phase One’s Capture One DSLR B 3

Then we add more to the queue. If e

this is a problem for you, you are a
real pro. Buying the Pro version
might save time and money.

2+ XES -

10d_0000__0060 [ 104_0000__00&0.CRY

<I | *

Figure 6-10: » B | 147
Capture One Develop tab Automatic open images after develop [

| Develop Focus | Exposure | Gray Balance | Capture
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What's More?

There much more to Capture One. In our personal workflow, we are
quite pleased with the basic functionality as outlined. Studying the
Capture One help file is well worth the time.

» You are able to create custom camera profiles and use them in
Capture One.

» Export preview images

Note: There are available third party profiles for Capture One. They
can make a significant difference in your work.

Because we use so many different cameras and RAW converters we
try to keep to the basics, which are:

» Get the white balance right
» Optimize Exposure



6.2 Bibble version 4 (B4)

We have used Bibble for more than 4 years. Unfortunately the previ-
ous version, Bibble 3, had not been updated for some time. Eric
Hyman, Bibble’s author (Bibble is his cat’s name) took his time and
created a completely new version 4. We suggest it was worth the
wait. Bibble 4 supports most digital SLRs available as well as some
digicams, and runs on Windows and Mac OS. Bibble’s goal is to pro-
vide satisfactory image quality along with excellent workflow.
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Figure 4-11: Main window of Bibble 4 (Windows version)

The Bibble user interface is highly customizable. We show here the
interface we use (thumbnails in filmstrip-mode).

[o)}
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Bibble Setup

Preferences

—General
Output
Browser WLCR panel zize I Large vl
Cache ~

Setfings Copy/Paste Cuick preview steps |4 =

Fenarne Formats Click-tool sample size I tedium 'l

(bt [Ty
D EQUENCE MUMDETS

Photoshop Plug-in
Tethered Shoating [~ Dizable tool palette docking

I~ Hide toolbars

[~ Do not delete temporary work queues on window closing
I~ Fully process images in backaround windows (slower)
v Fartially process foreground images (faster)

[~ Alwaps open images "Fit to Screen” [map be slawer)

I~ Da not auto-save lapout changes

¥ lgnore legacy bib files

[~ Faworite hot-keys move files instead of copying

Image background calar . |
Browser background color . |

I onitar, profile I <none selecteds

Select.. |

Figure 6-12: Setup of Preferences in Bibble 4.x

Cancel | (1] I

We recommend unchecking the Fit to screen option, speeding up

workflow significantly.

0
General
Dutput e
Browser ¥ Remove items older than 7 days
SeHiR Loy Pase ¥ Keep cache size under 1024 1B
R Fe I~ Limit cache to avalable free space 50 percent
Select a new cache folder Browse.
Tethered Shooting
Current cache size: 1075 MB Purge Cache | Fieduce Cache

cavs

< Figure 6-13: Setup



There are a couple of things requiring setup. We recommend using a

cache folder to store lots of data (at least 1 GB). For other setting,

refer to the help.

Color management

Bibble is fully color managed. You x|

may add your own custom profiles

Color Management

5

and’ moreover, Change settlngs onan Calor Management:l b aritor Proofed vl

image-by-image basis.

Cuztom Profile

Working Space:| Adobe RGE [1998) |

Figure 6-14: »

[ Apply Custarn ICC camera prafile.

[~ Profile includes tone adjustments.

Bibble Color Management Setup "

Main features of Bibble 4.x

As with Adobe Bridge, Bibble is highly customizable. When browsing

a folder we suggest use of the following view setup:

Fib EdL v Bowser Toos wandow elp

[fez08amadaT|uesd X€K< »[=- -

11/20040525_1d2_Filok/1d2_D000_0091.CR2

Zoam: 3% x4 0567, 0235 — > (RGE) 43797, 15042, 16300 (BB 199, 069, 066

v Appy Cures
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|
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Figure 6-15: Bibble 4.x multi-image view
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Bibble 4 supports all tools needed for an efficient RAW conversion (it
works on JPEGs, too).

Picture Options (holds crucial parameters)
White Balance (WB)

Curves/Histogram

Sharpen/Noise

Color and color management

v v Vv Vv Vv

White balance (WB)

Apart from correct exposure, the second most important task in
Bibble 4 is correcting white balance (WB). Two ways exist to accom-
plish this:

» by setting color temperature — using either the slider
Temperature or by selecting one of the presets via the pull-down
menu.

» by selecting a point that should be neutral gray using the #".

ite Balance

| =

| Click white =]

N ES

— | Incandescent
= Flourescent
Sunny
Cloudy E
‘wihite Balance g,i shady bt
[~ Mew'wB I [ncandescent ;Iﬁl ISh T
- Click White
Temperature 1] I‘WDD [ Custom Kelvin
Tint B [ As Shot

Figure 6-16: WB: Setting Color Temperature Color Temperature Presets

Normally, we are more interested in a pleasing subjective color tem-
perature than absolutely accurate color values. Our photos seldom
have well-defined gray areas enabling use of the eyedropper for a
reference point for a white balance (see description at page 6-15).



Setting the Gray Point

Correcting WB by clicking on a
gray area in the photo (e.g. a
gray card or ColorChecker)
with the eyedropper # is the
method of choice when you
need the best objective WB
correction and such gray area
exists within your photo.

Picture Options

This is a crucial dialog — only
the main controls are men-
tioned here:

» Exposure (EV)
» Tone Curves
» Auto levels

Make a habit, during EV cor-
rection, of very carefully
watching the image and its
histogram to avoid data clip-
ping in the highlights and (or)
shadows.

Bibble 4 tone curves are useful to adjust contrast:
The differences are subtle, but they can make a

huge difference in tonality.

Auto levels can be acceptable or too strong. We
leave highlight clipping always at zero (you can
define default settings for new images). Sometimes,
Auto Levels delivers the snap that you desire.

‘wihite Balance

|

[~ Mew'wh Incandescent ll fl
Temperature _I 4700
Tint B [

Figure 6-18: White balance

Ficture Options

s
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Figure 6-19: EV compensation
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Figure 6-20:
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Tone curve adjustment
(RGB tab)

Bibble 4 provides a powerful
curves tool with a full RGB I
histogram.

Figure 6-19: »
Curve adjustment

Color adjustment
(RGB tab)

Be cautious when using the
hue slider. Using the satura-

[v Apply Curves. | RGB L.l

Curves / Histogram

IKIS| SN x|

tion slider may make more
sense. Most often we lower
saturation rather than mak-
ing it stronger. As explained
in chapter 3, you should con-
sider a more selective satura-
tion enhancement and do it
in Photoshop.

Sharpening/Noise

As stated previously, we prefer to
do sharpening in Photoshop us-
ing one of many sharpening tools
available. Most frequently we use
sharpening at level “low” or turn it
off entirely.

Fringe Reduction is designed to
lower fringes (mostly green or ma-
genta) at high contrast edges. This
helps keep artifacts down from
chromatic aberration (CA). If your
image displays fringes, you must

i o e sl
11717 e

Figure 6-20: Color Rendering

=,

Sharpen / Moize

N
3

Zoom; ,:
¥ Sharpening:

Fringe Reduction I Strong vl
[~ Maize Reduction: '—J—

Figure 6-21: Sharpening/Noise




use high magnification to recognize them - do your fringe reduc-
tion here.

Normally we keep noise reduction “off” or set to a very low level. If
your image clearly requires further noise removal, use a dedicated
tool, such as Noise Ninja in Photoshop. Photoshop CS2 ships with a
new noise reduction filter (see chapter 7.3 at page 7-9).

Workflow with Bibble 4

Bibble provides for a good workflow. Here are some elements that
help with that:

Fast thumbnail conversion

Fast image preview

Easy real-time image corrections
Apply settings to other selected files
Render images in the background.

v v Vv Vv Vv

Bibble 4 does an better than average job in all these areas.

Another handy feature of Bibble 4 is its so-called Batch Queue:

Figure 6-22 on page 6-18 shows our standard settings for run-
ning a conversion in the background and then launching the con-
verted files into Photoshop. You may attach a keyboard letter to
this batch queue (we used “P”). When you press ‘P’, the image gets
converted in the background, the result launched into Photoshop.
We have another queue attached to ‘T, doing the same, but does
not open the file in Photoshop.

This is been intended as a full description of all Bibble 4 features.
Some of its other interesting features are:

» Work Queues: You can group files from different original folders
into virtual groups then work with them as though they belong
to the same folder. When working on a project, you can create
different work queues and collect 'keeper’images in these queues
by subject. You might, for example, have a queue each for:

- Landscape
- Wildflowers
- Wildlife/Birds

)
-—
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w Batch Settings

EEWNREGER B-bit TIFF copy

—Source

i+ Azk " Fixed

[~ Recurse Sub-directaries

[¥ Recreate directon struchure

File Types ta Process: | Al files

—Destination

" Ask (* Fized

|D:/_tmp_workfiless_bibble

" Relative

Browse... |

—Image Settings
{* Current

= Defaults

" Fram cantrals

£ From file

[¥ Preserve ratation
¥ Preserve crop

[~ lgmore crop

Browse... |

¥ Only prompt once

File |

v Enable this output target

—Renaming farmat

I default

- |

I[Dname][e:-:t]

Save in zubfolder
Output Format:
v Embed profile

| TIFF (8 bit

Jpeg quality: IE!D 3:

Del |
Add |
H

—lImage Size
o Full

" Proof
= Settings
£ Custom

width |E4D
feight |4BEI

Scale mode——
’7(' reduce % crop

[~ Open with extemnal viewer

Select. . | IF'thUSth.e:-:e

Save I

Cancel

Figure 6-22: Batch Queue Settings

» Print Queues: We have not even used this, as yet, since we often
print from either Photoshop, Qimage or Image Print.



6.3 Canon Digital Photo Professional (DPP)

i 4y Network Plcss.
© Padaxs
& Frems

Canon Digital Photo Professional (DPP for short) is a free tool that
ships with the Canon high-end DSLRs: 1Ds, 1D and 1D Mark Il (it is
also designed to support future Canon digital SLRs). DPP is Canon’s
answer to third party tools that are much stronger in terms of work-
flow than its past Canon tool.

Conversion quality is good, and also its workflow is adequate. It
runs under Windows and Mac OS. DPP is not quite as elegant to use
as ACR, Capture One or Bibble 4.

x_2004)all_DVD_2004_011120040525_1d2_Filoli]

[

[Recipe data: [Number ofimages: 61 [Number of selected images: 0

Figure 6-23: Canon Digital Photo Professional

Setup

Preferences

With DPP, we consider Operating Mode as one of the most impor-
tant settings. Standard is the best compromise of working speed to
output quality (same quality on output as “Quality Priority”).

[=))
-
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Preferences

x|

Generalseftings | Viewsetings | Toolpalete | Colormanagement |

— Startup folder
& Last displayed folder
" Specified folder

Browse.,, CADocuments and Settingsiuweihy Documentsiby Pictures

—Save recipe
& Display message when adding file

" Add to file automatically

—Operating mode (enabled after next startup)
¢ Quality priority Normally, this setting is recommended.

i When saving images, the image quality is
¢ Standard the same as with [Quality Priority.

(" Speed priority

~Default value of output resolution

240 dpi

~AtEOS Capture startup
[~ Editimage window enabled at EOS Capture startup

OK I Cancel

Figure 6-24: “General settings” tab in DPP Preferences

Color management setup

DPP does not detect a system monitor profile automatically, but

allows selecting it manually. This is essential in achieving an accu-

rate color preview on your monitor.

As working space

General seftings | View seftings | Tool palette

We USe ”AdObe ~Faordisplay

Color management I

RGB," as with all £ sRGB

+ Monitor profile

tOOIS- Browse... | Artisan_uwe16123285.0cm

- Default settings of Work colar space
i sRGB

@ Adobe RGH

1 Wiide Gamut RGE

~Rendeting intents when using Easy-PhotoPrint
" Percepiual

& Colorimetric

Figure 6-25: »

x|

Color Management

Lok 1

Cancel




DPP - main features

There are four types of windows used when working with DPP:
» Main Window: for browsing thumbnails (see figure 6-26)
» Image Editing Window: Editing selected RAW files

» Single-image editing window (see figure 6-27)

» A panel with settings for the RAW conversion (see figure 6-29)

AV image scjustment | RGR rmase soiusimert

Brightness sdjusiment Resel

i——— 000

inite balance sajustment Resal
click | i [ N [

[=hot sstings | Tune.

Dynamic range acjust Ressi

6

255
one curve prapertye

=hot satling: il

Color adjustment Resal
=hot sotlings hd

li 338, B09): 213, 92, 82 |seandard |adobs ReE 2

Figure 6-26: Edit Image Window

N
—
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Digital Photo Professional - [K:' ox_2004%all_D¥D_2004_011',20040525_1d2. 2_0000_0091.CR2 *] B [=] 53| 1d2_0000_0091.CR2* K|
RAW image adjustment ] RGB image adjustment

| Fr——— T Reset 1
Siightness adjustment | Reset ]
f ——— oo
White balance adjustment Reset
Clickj [0j - 31 [ Register
[shot setings =] _ Tune.
I, Reset Il
|Dynamicrange agjust._Reset =
255

shot settings s
[color adjustment Reset
shot settings ¥

Figure 6-27: Singe Image Editing Window
The tools necessary to correct and optimize a RAW image are divid-
ed into two tool tabs:

» RAW image adjustment
» RGB image adjustment

E5| B 1 42_0000_0091.CR2 * E

RAWN image adjustment | RiGB image adjustment RAW image adiustment  RGB image adiustment
‘ Brightness adjustment Reset H | Tone curve adjustment Reset H
—F———  Jomwo : I === 1EElE click |
255
‘White halance adjustment Reset H

click_| Jo [ e e |
Ishmaenings j Tune... | J\

‘Dynamic range adjust Reset H

\\ " <Fi 6-28:
IU_ 255 El?ightness: = Igure b ’

o

Tore curve propemy: ——F— [o Bibble uses
Ishot settings j Contrast: o different

‘Color adjustrment e H | Caolor adjustment Reset [| thS fOf RAW
Ishm settings j Hue:

—— conversion
Saturation: W and RGB
handling.




RAW image adjustment Panel

This panel contains key con-
trols to adjust your RAW files:

1d2_0000_0091.CR2Z * Ef

RAW image adjustment | RGH image adjustment

» White Balance (WB) |Elrightness adjustmentﬂ Reset ||
» Brightness (EV) = 200
» Color Adjustment wihite balance adjustment Reset ||
» Dynamic range adjust- click_| Jo A e M
ment (Tone curve) Ishmseﬂings j Tune... |
White Balance (WB) |Dynamic range adjust Reset ||
Other than EV, the second
basic task in DPP is getting
white balance (WB) correct.
There are two ways to correct
WB. '
[0 255
A) Setting the color Bl el
temperature shot settings 2l
|Color adjustment Reset ||
|White balance adjustment Reset | Ishmseﬂings j

Click |

Llilil Register...l
Tune... |

ISEEIEI

a figure 6-29: RAW Adjustment Panel

a figure 4-30: WB: Setting Color Temperature

When shooting
nature photographs,
we are often more
interested in the
subjective color tem-

|White halance adjustment

Feset ||

Click |

Llilil Fegister... |

Calar termip.

j Tune... |

shot settings
Auto

Find a1
perature than abso- = ;;:'&f”
lute accurate color Claoudy

values. Our photos
seldom have well-
defined gray areas to
use for method B
(Figure 6-32).

Tungsten light
Fluaorescent light
Flash

Click white balance

| 5600

Figure 6-31: Color Temperature Presets

¢
N
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B) Setting the Gray Point

|White balance adjustrment Reset |
[ Click 1] 2] 2| FReaister. |
ICIickwhite halance j Tune... |

< Figure 6-32:
Setting WB Gray Point

Correcting WB by clicking on a gray object within the photo (e.g. a
gray card or ColorChecker) is the method of choice to obtain the
best objective WB correction when you have such a gray area inside
your photo.

Setting Exposure

|Elrightness adjustment Reset |

| 017 «Figure 6-33:
EV compensation

During EV correction, keep your eye on the image and histogram
closely to avoid data clipping (both highlights and shadows). Sadly,
the better-suited histogram is from the RGB adjustment tab as the
histogram here appears to display linear data. Therefore, it is proba-
bly better to correct exposure by only viewing the image.

Color Rendering

|Cn|nradju5tment Reset ||

Ishut settings j < Figure 6-34:
Color Rendering

We leave this menu at “shot settings”.

Tone Curve Adjustment (RGB Tab)

This is an extremely powerful curves tool. We have used all its con-
trols to demonstrate its flexibility:

» Brightness
» Contrast
» All normal curves functions



| Tone curve adjustment Reset ||

| o0 PN Click

f2za | 7
E g
E ]
IF Sl m = Il!'
[a— 230
Brightness:
& IE < Figure 6-35:
Contrast:

: Tone curve
= ID adjustment
We always leave our image slightly ‘soft, making final adjustments in
PS using our layer-based workflow.

Color Adjustment (RGB Tab)

Be careful in using the hue slider. The saturation slider may make
more sense. Often, we'd rather make saturation lower rather than
stronger. As explained earlier in the workflow chapter, you should
possibly consider a more selective saturation enhancement and
then do it in Photoshop.

Calar adjustment Feset ||
Hue:
[ o
Saturatian: « Figure 6-35;

=

IE g Color Adjustment

[o)}

N
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Saving converted files
DPP offers two ways to save converted files:

1. Single image save (don't forget to select “Embed ICC profile”).

savens 2|

Save in: | () 20040525 142 Fiol =S ¥ M-
6-26
||
Fil : I
‘2 ile name: 1d2_0000_0091.TIF Save
q>” LRI TIFF 16hit* TIF “ TIFF] Caneel |
C
o )
(V] Image qualty, ———————————1 1@ Output 240 dpi
= resolution
< Sharphess f——— i
o P ¥ Embed ICC profile
o 4
O .
= Figure 6-37a: Save converted file
S
9]
g 2. Batch save
2
S x
1d2_0000_0091 .CR2 —Save falder
|D:x_tmp_workﬂlesb(_dpp_temp Browse. . |
r~ File farmat
LIEE =R (= 0 ]
f
M Embed ICC profile Shiaifprizs L
f;
~ Output resolution
240 dpi
—File name
& Currentfile name
= Mewr file name
it o Conanco Armhior
(=AIRINIE] =i PR = RS R =
Bl oot
Ex: DRFF_0001.TF, BFP_000Z.TIE...

Execute I Cancel

Figure 6-37b: Batch Save



We choose the second option because you are able to:

» Convert multiple files at one time

» Select a standard target folder

» Continue working on another file while conversion of the pre-
vious file is performed in the background.

When the images are processed, this dialog displays:

=" Digital Photo Professional -[1 /1] 3 — =]

Procossing fla

output ile:

Marmaly processed : 1

Error o < Figure 6-38:
Processing dialog of
Details DPP

Unfortunately, no option makes this window close by itself.
Bug (feature) in our current version (6/2/2004):

When an image already exists in the target folder, that image will

not be processed. EVU would, in this case, use a different name (e.qg.

XXXX(2).tif)

N
)
N
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6.4 Nikon Capture

Nikon Capture (NC for short) is Nikon'’s full-featured RAW conver-
sion utility — available for Windows and Mac OS. It is used not only
for RAW conversion, but for scanning with Nikon scanners and edit-
ing JPEG files, as well. Though it offers diverse image operations, it
does not modify the original image, rather, stores all operations as a
command sequence. Thus, you may undo or modify at any time
these operations without a loss of quality (much the same as other
RAW converters). Nikon Capture, however, does not substitute as an
image editor, such as Photoshop.

6-28
u & Nikon Capture Editor
%)
= Ele Edt View Image Settings Tools ‘Window Hep Toal Palette 1
g w_0005_0717.NEF @ 25% = idcurves
g were the zeftings at the tme thiz image was taken: e
Y Focal Length: 200mm ‘wihate: Balance: Auty s
= Exposure Mode: Manual AF Mode: 4F 5 5 E
é Meterng Mode: Center’eighted  Tome Compe Less Contras | 1
1 s - 174 Flazh Sy Mode: Mot A1
v
s ||l EEET—
o E 4 b 000 Ew
g g i e
Q Shapening: || Inchanged - ~
© I J IJ_ »
=
U Tane Camp: Il Inchanged j r D
I: | an 255
Color Mode: |Linchanged [~
[~ Hue Adjestment [argnaly 07 Inpa: Dutpit
4 I— » IU . | B4 Color Balance
T Saturation Compensation s ﬂlﬁlﬂu‘l‘p Mask
¥ i Moise Reduction
€y ¥
- ®  Size/Resolution
& Keep my ciop

" Keep my output size
| 4 white Balance

Yfidth |1|:| 03
ISeL[nh’ Temrperalure Height: [6.53 nos

Camara'WE: Auta at ISEIEI Ippi vI
MewWB: [Recorded Value =l Scae: T000%  Bebit RGB: 16.9MB
I _j CMYE: 225ME  16-bit RGB: 33 TME

5 ¥ Bird's Eye
F
hﬁ.:l:ﬂlt 1 I— g K. T Infarmation
Cooles ]

W

Figure 6-39: Nikon Capture




Although it must be purchased separately, if you are serious about
conversion of Nikon RAW files, you need to buy this tool. If you use
any of Nikon’s excellent films scanners, you should seriously con-
sider purchasing Nikon Capture. The kit includes both a Windows
and a Mac OS version.

Stated again, this discussion is not intended to replace the
manual. We describe only features used in our workflow.

In our judgement, the quantity of windows and panelsin a
Nikon Capture screen can be a bit confusing.

When installing Nikon Capture after a Photoshop install, NC
places an import filter into the Photoshop plug-in folder which pre-
vents the Photoshop file browser from recognizing RAW files during
Nikon RAW file import and redirects data to Nikon Capture instead.
If you prefer to open NEF-files (Nikon RAW files) using primarily
Camera Raw, you may remove this plug-in (called “Nikon NEF
Plugin”) from your Photoshop Plug-in folder (Import).

Setup

Preferences

You may launch converted files directly into Photoshop. That is why
we suggest selecting the Photoshop application here. In fact, we do
not use this feature in our own workflow.

x

General | Temparary FiIesI Advanced Colorl Grid Linesl Colar Managementl

"Uzer Default” image adjustments:
|E:\F'r0glam FilesyMikoniM Capture304Meutral. set Browse... I

Open saved images in:

|C:\F'roglam Files“AdobetPhatoshop 7.0%hotoshop. exe Browse... |

< Figure 6-40:
Selecting the Photoshop
0K I Cancel Help I directory

¢
N
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Color management

This dialog box allows
you to select your pre-
ferred working space
and monitor profile.

We use Adobe
RGB (1998) as our
working space and
select the system
monitor profile
(shown is the monitor
profile for our Sony
NV170 notebook).

You must restart
Capture to make the
monitor profile active.

Main features

x

Generall Temporary Filesl Advanced Eolorl Grid Lines ~ Color Management |

Mote: Making changes to items on this page will also affect Mikon Capture
Camera Control and Mikon View,

Monitar profile;

|E:\...‘\spool‘\drivers'\color\son_l,l_NW 70_B-26-2002_1.icc Browse... I

Default RGE color space:
|adobe RGE [1938) x|

W Use this instead of an embedded profile when opening files

Printer profile:
™ Use profile for printing

| Browsse... |
Intent: I Perceptual 0 l

CHYE. zeparation profile:
|E:\F'r0glam FilezYCommaon FilegiMikoniProfilesh\MECMY K icm Browse.. |

MK I Careel I Helrn I
Figure 6-40: Color Management Settings

Let us assume you have opened a NEF photo in Capture 3 or 4.

Advanced RAW

Making correct settings in the
“Advanced RAW” dialog box
right is essential to your suc-
cess.

» We will cover EV compen-
sation later.

» Sharpening can be set to
“low” or “normal”. Normal
sometimes introduces
unwanted halos.

» Tone compensation is set
to“normal” or, on a photo
with stronger contrast, to
“Less Contrast”.

h ﬂndvanced RAW

Exp Comp: ‘, - Jl— }. [f EY
Sharpening: I“Low j
Tone Comp: INu:urmaI j
Color Mode: | "Mode Il [4dabe RGE) =l

[ Hue Adjustment [originally 0°)

(— —»[ -

[~ Saturation Compenzation [ariginally 4]

 f—— [

Figure 6-41: Advanced RAW Dialog



» For color mode, we use our working space “Mode Il (Adobe RGB)".

» We rarely ever use the “Hue Adjustment” or “Saturation Compen-
sation”. If we need to correct these, we use Photoshop later.

Curves

The Capture 3 Curves tool is
quite powerful and we prefer
its interface to that of Curves

in Photoshop. Capture lets us Iﬁ ‘

view the histogram. On the
other hand, we attempt to
minimize our work in the
Capture converter and leave
the rest to Photoshop. k

Return to the EV com-
pensation slider in the “Ad- ID—
vanced RAW” dialog box.
Starting with the histogram IIZI |1.nn |255
above, an EV of +1.0 would
result in the histogram of fig-
ure 6-43.

As said before, you should limit ‘

KINENNIEIE]

Irnmnt Mutrnat:

Figure 6-42: Capture Curves

modifications in Capture 4 and do the
rest in Photoshop. In case of a light
over-exposure, you must use a nega-
tive EV value for compensation. Play

with the slider until you see no more
spikes at the far right of the histogram.

If necessary, set the Tone settings to T
“Less Contrast” to recover lost high- ‘.-

lights. .
Figure 6-43: EV +1.0s

Size and Resolution

Most users will not need this dialog box. If we choose to print the
photo larger than 17" wide, we upsize photos at an early stage (we
upsize to a 12 Megapixel equivalent). This helps minimize the effects
of degradation occurring later in the workflow when later upsizing
of the photo is often done.

[e)}

w
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This setting permits
printing up to 21" wide
at 180 ppi without fur-
ther resizing or increas-
ing to 30" with no seri-

Size/Resolution

{* Keep my crop
" Keep my output size

ous problems by width: [4.256
utilizing Fred Miranda’s E— Ipiﬁels vl
Sl actions. We were Height: |£.823

inspired to use this
method by Paul

300 [ ]

Scale: 141.5%  Bhit RGE: 34.4MB
CMYK: 42.9ME  16-Dit RGE: B5.9MB

|

Figure 6-44: Upsizing In Capture

Tip: Experiment with this method as it may not be the right choice
for you (and avoid it if you print smaller than 17" wide).

White Balance (WB)

Beyond EV, the other main task in Capture 4 is getting the white bal-
ance (WB) correct. There are two ways to correct WB.

Setting the color temperature

The settings in the image of figure 6-44 shows the way we use usu-
ally use this dialog box. Select the light source, such as “Daylight’,
then “Sunny’, “Cloudy” or “Shade” and finally tune the color with the
“Fine Adjustment” slider.

= [¥] vhite Balance

I Set Color Temperature j

Camera 'wEB: Auto

New 'wB: | Daylight =l
IEIDudy j
Fine I 6283 K
Adjustrment: 4 | 4 < Figure 6-45:
Cooler W armer WB: Setting Color

Temperature



In most photographs, we are more interested in the subjective color
temperature than absolutely accurate color values. Most of our pho-
tos contain few well-defined gray areas to use with method 2.

Setting the Gray Point

Eﬂwhite Balance
R: Sample Gray Point
G: * Usze a single point
B:

= Average several points

Start |

Fed: { -—J— } I'I--IE
< Figure 6-45:
Blue: 4 '_J_ 4 ID'E? Setting WB Gray Point

Correcting the WB by clicking on a gray object in a photo (e.g. a gray
card or ColorChecker) remains the method of choice if you need the
best objective WB correction and you have a gray area inside your
photo to use for a reference.

Save and load settings

Once you have established settings, save them.

» To save them: From the main menu bar, click Setting then select
Image Adjustments and click Save.

» To recall them later: From the main menu bar click “Setting” then
select Image Adjustments and click Load.

Tip: Save the settings you use most often and recall them for each
photo you process.

o
w
w
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Chapter 7

Perfecting Images

Camera: Sigma SD1o

Do you really need to bother with this?

For many casual images you may never have the desire to look into
all the minor shortcomings of digital images. But the camera and
lenses (even the more expensive ones) are far from being perfect.
There are several different defects, you should watch for and then
decide if you can life with it or that you should work on.

~
-

Perfecting images ®
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Here are some of the more important defects that we will cover in
this chapter:

»

»

»

Image blur (lack of sharpness) which can have many sources

- Lens blur

— Blurintroduced by the camera’s AA filter

— Motion blurs. There are tools that deal with this to some
extent. But you better use fast shutter speeds or a tripod.

— Out of focus blur. This is hard to deal with. You better use a
higher f-stop to gain more depth of field.

Noise. There are three types of noise:
- Color aliasing

- Luminance noise

- Moiré

Chromatic aberrations

Lens distortions

Vignetting

Rotation (more related to wrong camera setup)
Perspective corrections

Removing dust spots

You should not get that worried about all these problems and tackle
them only if you feel they distract from your images.

Why did nobody bother that much about this with film? First, in

the high-end people did bother but had a very hard time to correct
it. Second, with digital we have now many good methods to mini-
mize all these flaws.

Actually Photoshop CS2 adds three new tools to help reducing

all of the above defects:

4
4
4

Smarter Sharpen

Reduce Noise

Lens Correction

(corrects many different types of defects created by lenses)



7.2 The art of sharpening

All digital photos require some sharpening. Especially since the AA
filters (Anti-Aliasing-filters) in most digital SLRs blur the image a bit
to decrease color aliasing (see description at page 1-9).

Sharpening is one of the most difficult and subjective topics in
digital photography but good tools are available and continue to
improve.

The sharpening process has a built-in contradiction: While giv-
ing the impression of sharpness improvement, the viewer should
be aware that some smaller details might get lost during this pro-
cess. That is why the targeted viewing distance is very important.

Sharpening may be done in (at least) three stages of your workflow:

» Inthe camera
(not if you shoot RAW files, and we even do not recommend it, if
you shoot JPEG or TIFF and do some optimizations in Photoshop
later).

» Inthe RAW converter.
We rarely use this and but most of the time just use a sharpening
of the preview image without actually sharpen the image.
However you might slightly sharpen the image in the RAW con-
verter and do some more sharpening in Photoshop afterwards.
RawShooter seems to do a better job with sharpening than
other RAW converters do. So with RawSHooter you may use a bit
more of sharpening.

» In Photoshop.
This is our preferred method as you have a very high level of
control and may even restrict sharpening to certain areas of the
image. There are quite a number of good sharpening tools as
plug-ins for Photoshop.

Even in Photoshop a three step sharpening may be the best way:

- Aslight overall sharpening to improve the image

- Aselective sharpening restricted to those areas of your
image, that improve with further sharpening and that should
be in the focus of the viewer. Bruce Fraser calls this a creative
sharpening.

N
w
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- Afinal sharpening as one of the very last steps before output-
ting. This sharpening should be done when the picture is
scaled for output and it should be adapted to the output
method. Digital slide show need almost not sharpening,
while printing using an inkjet printer or an offset printer need
much more sharpening, due to its printing process using
dithering. Output on a lightjet printer or a dye sublimation
printer requires less sharpening. Part of this final sharpening
may even be done by the RIP (Raster Image Processor) if you
use one and the RIP is supporting this (e.g. Qimage, see [33])
supports it).

USM (Unsharp Mask)

The classic tool for sharpening in Photoshop is USM (Unsharp Mask).
It is also important to be aware that it is difficult to judge sharp-

ening on the screen. A photo that looks hopelessly over-sharpened

on the screen might be exactly right for some inkjet printers.
Sharpening artefacts should be limited to a minimum:

» Halos (white or black borders at edges)
» Noise will get sharpened as well, making it more pronounced.

There are a lot of sharpening tools out there and it is up to you to
figure out your favorite methods.

How Photoshop “Unsharp Mask” works

The most used tool for sharpening is probably straight USM
(Unsharp Mask) in Photoshop and nearly all techniques are a varia-
tion of it. To get an understanding of the sharpening issues you
need to better understand how Photoshop USM works and its inher-
ent limits.


http://www.ddisoftwrae.com

< Figure 7-1:
Sample Picture
(not sharpened)

We open the Filter»Sharpen»Unsharp Mask Dialog:

Unsharp Mask
Cancel |

v Preview

j 100% ﬂ
Aot I 130 %

RadiLis: I 0.7 pixels

N
v
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o
Threshald: |3 levels
e < Figure 7-2:
Unsharp Mask Dialog

In (almost) all cases you should check the Preview button. Three fac-
tors control USM:
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» Amount
» Radius
» Threshold

Amount » defines the strength of the new improved contrast at
edges. The optimal amount depends very much on your image.
Start with a value of 50-100 % and carefully watch the effect with
your image that should be set to an enlargement level of 100 % (or
even a bit more).

Radius » determines how many pixels are involved to build the new
edges with higher contrast. Often 0,5-1,0 are good values, though
the best value is very dependent on the resolution of your

image. The higher the resolution, the higher Threshold may be. An
inadequate high value will result in a high contrast and artefacts.

Threshold » defines “how different the sharpened pixels must be
from the surrounding area before they are considered edge pixels
and sharpened by the filter” (see Photoshop Help) and is needed to
avoid sharpening noise too much.

Good values are very much dependent on the resolution of the
image (ppi — Point per Inch). The higher the resolution, the higher
values of Amount and Radius may be selected.

< Figure 7-3:
Sharpened
Image

What is the dilemma? You can either sharpen too little or too strong
so that the image gets severely damaged by showing light or dark
halos
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Figure 7-4: Image shows strong halos

We would caution you to stay on the side of low sharpening. If you
images only impress by being sharp then try to work on the con-
tent.

Here is short story. We looked at some Cibachrome prints in
one of Carmel’s top photo galleries. None of the prints in that
show was critically sharp. But they all were beautiful.
Remember sharpness is only a tool to improve the content.

Since the sharpening effect is also a function of the resolution and
the printing technology, finding optimal settings can be a lengthy
process and needs a lot of experience. There is also a principle limi-
tation to USM: all settings are global for any given image. But you
might want to sharpen the skin (smoother) different from the hair
(much more crisp) for a portrait. Also avoiding amplifying the noise
using plain USM can be tricky.

That is why there are a huge number of different sharpening
techniques published (most often based on some edge masking)
and many Photoshop plug-ins that try to make sharpening easier.

|II

Note: There is no simple "one size fits all” solution to sharpening.

7.2 The art of sharpening B J
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The two step approach
The two-step approach is a simple way to get started in sharpening

» Low sharpening in the RAW converter
» Final sharpening in Photoshop

We don't really do any sharpening in the RAW converter and use
later only EasyS Sharpening Toolkit in Photoshop. That does not
mean that the RAW converter sharpening is that bad but we find
that good sharpening tools in PS offer more control.

Once you have a grip on sharpening, have a look into the many
sharpening tools we show at Digital Outback Photo ([8]) and pick
the technique that fits your workflow and image best.

Photoshop CS2: Smarter Sharpen

In Photoshop CS2 we finally get an improved sharpening over plain

USM.
T x
Cancel |
¥ Presiew

" Basic & Advanced

T Settings: I Diefault j —By -
Sharpen  Shadow "L Highlight ™

Armount: IF %o
Radius: F pixels
~
Rernove: I Gaussian Blur vI
Arigles I o B .

v Mare Accurate

Figure 7-5: Photoshop CS2 Smarter Sharpen


http://www.outbackphoto.com/workflow/wf_31/essay.html

In advanced mode you can also tune the sharpening for the shad-
ows and highlights. In general you don’t want to sharpen the
extreme shadows (Noise) and the also not the bright highlights.

Other Sharpening Tools

In our daily work we use several advanced sharpening tools.
There are a lot of sharpening tools out there and it is up to you
to figure out your favorite. Here are a few of our favorites.

» Our own EasyS Sharpening Toolkit (4, &; see [46])
» Focus Magic (4, see [31])
» Focus Fixer (4, &; see [32])

7.3 Noise reduction

Small sensors and larger sensors at higher ISO settings can show dif-
ferent kinds of noise. This is mainly visible in the shadow parts as
here the signal to noise ratio gets very low. For more information on
noise in digital images read our paper at [8]. The whole industry is
working on sensors and software that allows lower and lower noise
levels.

Actually removing noise is easy. But removing noise and keeping
finest details and without muting color is the real challenge.

There are several types of noise:

» Fine and coarse (hard to remove)
» Luminance noise (detail noise)
» Color noise (means false color pixels in homogeneous colors)

N
©
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http://http://www.outbackphoto.com/workflow/wf_38/essay.html
http://www.focusmagic.com
http:/www.fixerlabs.com
http://www.outbackphoto.com/dp_essentials/dp_essentials_05/essay.html
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Figure 7-6: Shows Luminance and color noise

Fortunately we have now quite a few good programs (and all the
good also work as Photoshop plug-ins) that can do a great job
reducing noise.

But first check whether your noise is really a problem in your
prints. Only reduce the noise so far that you keep detail and avoid
some sort of plastic look in your images.

After the use of some noise removal filter, we get the image of
figure 7-7:



Figure 7-7: After noise removal

N
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Photoshop CS2: Reduce Noise

Finally Photoshop CS2 also got a very usable noise filter Reduce

Noise:
5|
Cancel

V' Preview

" Basic  Advanced

r Settings:IDefauIt | B

Overall *Ber Channel %

Strenath; I 7

Preserve Details: |81 %

Reduce Colar Moise: I 55 %

Sharpen Details: | 25 %

[~ Remove JPEG Artifact

;I 200% ﬂ

Figure 7-8: PS CS2 Reduce Noise

As noise may be stronger in some channels — usually the blue chan-
nel shows more noise — it may be well worth to use the Per Channel
tab and start noise removal with the blue channel. This may pre-
serve more details in your red and green channel.

Noise is in the shadows

Because noise is primarily present in the shadows it can be very use-
ful to perform the noise removal in a new layer and then use a Layer
Mask so that the noise removal is only active in the shadows. We use
the masks from our own Tonality Tuning Toolkit (see [7]).

Other Useful noise removal filters
We find the following noise filters very useful:

» NoiseNinja (4, &; see [12])


http://www.outbackphoto.com/workflow/wf_61/essay.html
http://www.outbackphoto.com/dp_essentials/dp_essentials_04/essay.html

» Neatlmage (#, &; see [27]). There is a Standard and a Pro edition.
This is an excellent tool.

» Noiseware (47,&; see [28]). There is a Standard and a Pro edition)

» Helicon Filter Pro (4¥; see [29]) This is superb freeware tool)

If you work with 16-bit images, which we recommend to do, you
usually have to buy the Pro versions of the tools.

7.4 Reduce chromatic aberration (CA) and purple fringing

Chromatic aberration (CA for short) is actually a fault that nearly all 7-
lenses show. Whether it is also shows in the final image is up to the
quality of the lenses used. Most of the time chromatic aberrations
show as purple/green fringing and it gets stronger the more you get
into the corners. The reason is that the lenses have a different focal
plane for the different colors. Especially consumer class digital cam-
eras show more CA than high end digital cameras with top lenses.
There is also purple fringing that may look the same but is the
result of leaks in the imaging sensor (e.g. The Sony F828 shows
both strong chromatic aberrations and purple fringing).

Heal chromatic aberration (CA)

Lower quality lenses but also some prime lenses used with full
frame sensors show mostly in the corners so called chromatic aber-
ration (CA). It shows as magenta and green borders at opposite
sides of high contrast edges.

7.4 Reduce chromatic abberation and purple fringing B
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http://neatimage.com
http://www.imagenomic.com
http://www.shareup.com/Helicon_Filter_pro-download-21227.html

< Figure 7-9:
Sample Chromatic
Aberration (left)
and the fixed result
in Camera Raw 2/3
(right)

If you don't use Adobe Camera Raw and did not upgrade to Photo-
shop CS2 yet, then you may use the Photoshop plug-in Debarrelizer
(see [30]) It corrects lens distortions and chromatic aberrations):

N
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~ Cancel |
i Load... |
: Save.. |
~ ¥ Preview
] R
‘ — Spheric Aberration
‘ Correctioln Angle
~ —l |25.2 [1.0-180.0)
~ — Chromatic Aberration
. Scale Red Channel :
i ] |2.385 [+ 10.000)
Scale Blue Channel
& 1 [0.000 [+/-10.000)
~ —Sampling
‘ Scale Ta Fit: IDFF 'l Sampling Type: ISpIine 'l < Figure 7_70
‘ [~ Edge Replication CA remova/ in.

Iheimagingfactory|  Deparrelizer



http://www.theimageingfactory.com/data/pages/prodcuts/products1.htm

Photoshop CS2: Lens Correction

New in Photoshop CS2 you can also fix chromatic aberration outside
of Camera Raw using the Lens Correction filter:

Lens Correction {200%)

Place mouse over contral For help |

4 =
Cancel |
)
<M — Settings: ICustom j -
\l Remove Distortion ID.DD
@ 4 =
— Chromatic Aberration
Fix Red/Cyan Fringe [7]
- -5
Fix Bluejellow Fringe o
o
— Wignette
Arnount o]
-
darken lighten
Midpaink +50
-
Set Lens Default |
— Transfarm
Vertical Perspective 1]
= - =\
Horizonkal Perspective u]
L o i
Angle: @ ID.DD 2
B Edge: |Transparency 2
S35 EETT 1 J_'I_I ! =
Scale 100 %
IV Preview [ Show Grid Size: (16 [+ | Color: [ -

Figure 7-11: “Lens Correction” filter of Photoshop CS2

Heal purple fringing

Here is a real example we got from a Sony F828. We show how to
make useful images from such files.

First get a free version of Panorama-Tools. You have to search
the web where to find it, as we have no right to distribute this free
software. A good start will be [40]. There you find a user friendly
front end to Panorama-Tools as well.

The following is working on the original file (that was not
sharpened)
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4 Fig. 7-12:
Original with

7-16 strong CA

1 Because we are using layers we create a new layer with the result
of all current flattened layers in it.

2 Using Panorama tools to remove some CA

Chapter 7: Perfecting Images ®

i
Piefz I
 Fadial shift _UMI Set Polynomial Coefficients for Radial Correction 1]
Mo '_BMI g = axirdest™d ¢ bxr dest™d + cwi_dest "2+ d"r_dest
[ Herizontal shit Optiorss |
o red [0 o I | (EEEE
™ Shea _Options |
green | fo [i /1
I~ Scse _Gptios |
bl 0 1] 0 1
P I Rdial Luminance Optiors_| oo | ! |
b - Conechon Mode: % Radial ~ Homsontal
.r [~ CutFrama Optionz | =
™ Fourier Fiter Dptions |
s Cancel | ok |
:' losd | Save | cCacel | ok |

Figure 7-13: Correct radial shift in Panorama Tools

These parameters may vary with the focal length.



< Fig. 7-14:
After
Panorama
Tools

This step removes some purple and even more the green CA fring-

ing.
3 Reduce purple

Use Photoshop Hue/Saturation tool to reduce the purple:

Hue/Saturation E

T Edit: [RERENES —
Hue:
_ E _cance |
. ) '
Saturation: I? Load... |
('} Save... I
Lightress: | 214
i
™ Colarize
S S I?/? Z % prevew

X

X

< Fig. 7-15:
Selectively
reducea
narrow color
range of purple

It will leave desaturated areas in the picture but not as bad as purple

(see figure 7-16).

7-17
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4 Fig. 7-16:
Result after
applying
Hue/
Saturation

7-18

4 (Optional): You may additionally (or alternatively) reduce
magenta using Selective Color Options:

selective Color Dptions ' x|

— Colors:

Magentas
agenta %

|
A I 0 o Cancel |
Magenta: I Tl oy Load... |
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— : ! s
rello: | ] o _
§ . ) Iv¥ Preview
Elack: I a %o < Figure 7-17:
Purple finging may
also be reduced using
Method:  Relative  Ahsolute the “Seletcive Color

Options”



7.5 Distortion

You will be surprised how much distortion even good lenses may
show. But the good news is that you hardly will see it with images
that have no straight horizontal or vertical lines. However once you
photograph architecture it can be quite an annoyance.

There are two kinds of correction tools:
» Visual corrections based on barrel or pincushion distortions

» Profile based correction based on measured profiles for
camera/lens combinations

Whenever possible use a tool that is profile based as the correction
will be more correct and automatic. But also the other tools will help
you getting a pleasing result.

Profile based corrections

Clearly our favorite tool is the free PTLens plug-in (see [25]).
Unfortunately it is only available for the PC right now. For Mac OS
however you may buy LensFix ([26]) at a very reasonable price. It is
based on the same technology.

Here is an example:

PN AR

TR

|

|1 B

Figure 7-18: Strong barrel distortion
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PTLens can correct this automatically knowing the right camera/
lens combination (even tries to get as much info from the image
EXIF as possible).

x|
i~ Profile
Make
Model
— |
Lens
| EF 70-200mm /2. BL 1S USM + EF 1.4x estender =l

98.000  focal length (35.000 - 280.000)

Canon
Canon EQS-1DS
Facal length: S8mm

Parameters
htoy: 208
& 0.000000
b: 0.012273
o 0.000000
d 1.012273

~ Yignetting ~ Carrect

A oK
il v Preview

i . . . . i
N Optiahs
¥ Distottion
Midpoint Reset
' . . . . i

[~ Wignetting

Cancel

Figure 7-19: PTLens User Interface

The resulting image looks much better now:

—_—

Figure 7-20: Corrected Image



In some case PTLens can even be used for correcting distortions cre-
ated by fisheye lenses:

Figure 7-21: Canon 15 mm fisheye lens

Figure 7-22: Corrected distortion using PTLens
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Photoshop CS2: Lens Correction

| Place mouse aver cantrol for help |
S = —I
Cancel
0
& - Settings: |Custom MECES
a4 — Remove Distortion
- @ 5 "
— Chromatic Aberration —————————————
Fix RedfCyan Fringe 0
-
Fix Blue,Yellow Fringe 0
j— — -
_— e — Wignette
—_— — —_— Amount 0
=== ———— — - - 3
darken lighten
\ Midpoint +50
— e | A
Set Lenz Default
= —— [ Transform
e Vertical Perspective 0
1=} 3 =
= — e
Horizantal Perspective 0
Ly 3 u
— s
- e e Angle: (D 0.00
== — Edge: ITransparency -
Scale 100 | %
-

[V Preview [ ShowGrid Size: calor: [

A
Figure 7-23: Corrected image using the Photoshop CS2 "Lens Correction" filter
The correction in the Photoshop CS2 Lens Correction filter may be

not as perfect as in PTLens but in most cases it will perfectly do the
job. Remember, in the old days you did not do any correction at all.



7.6 Vignetting

We encounter this problem rarely. But wide-angle lenses at open
aperture or some flash photos may suffer from Vignetting like the
picture of page 7-23 (this is only a demo, the real image had only
minor Vignetting that would not show that well in the book):

Severe
Vignetting

Vignetting can be fixed in ACR or in the CS2 Lens Correction tool:

Lens Correction (49.9%)

| Place mouse over control for hely

A
o
v
=N

[V Previen [ show Grid  Size: color: [

Cancel
[~ Settings: | Custom - ,®7

Remowe Distortion

[ Chromatic berration ————————|

0.00
o
N

Fix BlugYelow Frings i

Fix Red/Cyan Fringe

— Vignatte

Amaunt
e
darken lighten

Midpoinkt +50

Set Lens Default
— Transform ——————————————
Vertical Perspective [l
— 3

Horizontal Perspective o
Ty

m -
Angle: @ 0.00

Edge: | Transparency -

7

< Fig. 7-24:

Scale o %

=

Figure 7-25: Quick fix in Lens Correction
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Midpoint does not define the midpoint of vignetting, but defines
how far from the middle of your image vignetting-correction should
start. In some cases this may not be enough, as some lenses show
an unsymmetrical vignetting behavior.

As always we advise not to over correct the images. These are
still photos and should show that they come from the real world.

Some enforced vignetting however may also be used as a creative
touch to your image. Slightly darkening the outer border of your
photo may lead your viewer to focus to the middle of the frame
where you usually want the focus to be. For this, use a negative
value for Amount. However as this effect will create a circular dark-
ening, in most cases we would prefer to use a darker frame pro-
duced in Photoshop.

7.7 Correcting tilt and perspective corrections

Rotation (correcting tilt)

Some RAW converters help to correct tilt directly (e.g. ACR 3.x and
Capture One). For all the others you can easily use Photoshop and
especially the CS2 Lens correction filter. If you choose to work with
an 8-bit image in Photoshop, doing a correction in the RAW con-
verter has some advantages, due to the 16-bit mode used there. If
you prefer to correct it in Photoshop, we would recommend staying
in 16-bit mode until the tilt is correct and other corrections are done
as well and only convert to 8-bit mode afterwards (Image » Mode » 8
Bits/Channel).

If you have to do some image alignment, you should do the
cropping after aligning the image.

Perspective corrections

Figure 7-26 shows a classic image that shows a perspective distor-
tion:



What Causes Tides?

20
ot eynt e O Missan i et s Caso,

Perspective
distortion

< Figure 7-26:

Besides a strong perspective distortion it also shows minor lens bar-

rel distortions. Both can be corrected in one step with the new PS

CS2 Lens Correction filter (Filter » Distort » Lens Correction).

Lens Correction {49.9%}

| Madify the midpoint to affect the spread of the vignette correction.,
&
LV
Al
@
Q

Cancel

—settings: [custom 7| -

>

Remove Distortion +4.00
= 12 I
i Chromatic Aberration
Fix RediCyan Fringe 0
Fix Blue/*ellow Fringe 0
-
o vignette
Amounk 0
-
darken lightzn
Midpoint +50
T
o
Set Lens Default
— Transform
Wertical Perspective =
=] = &
Horizontal Perspective 0
L = w
Angle: @ 000 °
Edge: |Transparency =
Srale 100 %

¥ Preview [ Showarid Size:[16 [+ ] coor: [

Figure 7-27: Lens Correction filter

For this correction you need the grid enabled in the filter. Here
(Figure 7-28) is the final image after a crop:
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What effect does the sun have upon tkfﬁdé?
When the sun and the moon are nearly in line with cach
other and with the earth, as they are at the new moon and
full moon, the sui n’ls'nillhnlllmwhldddlolhud

lmﬂdu—m!mﬂtdwtlg!ﬂﬂ,mimhmnfﬂt
year, but from an Anglo-Saxon word which means a “Teap!”

_)

At s phioss o e o e frves o i
d moon are at %0-degree angles o each ather, and

another Anglo-Sason word which means “scanty”

Santa Barbara's highest tides of the year occur during full

and new moons in January, when the sun s closest to
the carth.

Figure 7-28: Final corrected picture

7.8 Removing dust spots

Sometimes the CCD or CMOS sensors collect dust. These spots are
easy to see in brighter parts of the image (e.g. sky). Here you can
use the Photoshop clone tool @ to copy over the spot with a simi-
lar area of the image.

Photoshop 7.0 introduced a very sophisticated clone tool: the
“Healing Brush” &”,. The healing brush melds the source and target
areas together and often produces a more pleasing result than the
clone tool. Here is a sample dust spot:

e H ,r.:-q.; I-‘!—,
< Figure 7-29:
s Sensor Dust Spot




Select the Healing Brush tool &%, in the PS tools palette. Then press
the key and the source cursor shows up (can be hard to spot if
the color of the cursor is close to the background color). You then
click in an area where you want to sample patterns to replace the
target (here the dust spot).

< Figure 7-30:
Selecting the source for the
Healing Brush

Then you create a brush that is slightly bigger than the dust spot,
position it over the spot, and click with the mouse button.

O

Figure 7-31: Apply Healing Brush The corrected image

This is actually not an easy example as the dust spot sits on top of a
cloud pattern and could be improved to better reflect the original

pattern.
We rarely use the clone tool anymore to remove unwanted

parts from a photo.

Comment by Phil Lindsay: “Yes, it's true that the healing tool is great
but there are still instances in which the rubber stamp may work
better; especially if the two regions have grossly different colors.”

N
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Patch tool

The Patch Tool uses the same algorithms as the Healing brush, and
can be used to remove, or move, areas in your picture.

We use it here to remove the same dust spot. This time we use
the Patch Tool #£3%. The first step in using the Patch Tool is to select
the area you want to remove (works like a lasso):

< Figure 7-32:
Patch Tool Selection

Then you drag the selected area to a place with a pattern that
should replace the source:

< Figure 7-33:
Move selection to a
replacement source
The result is close to our first attempt:
< Figure 7-34:

Result after Patch Tool use



Sometimes you need to use the Healing Brush for a final touchup of
the patched area.

Using Selection with the Healing Brush

Here is a spot on the CCD (actually residue from canned air, ouch):

< Figure 7-35:
Major spot

Here the use of the healing brush is tough.
» Work at about 400 % magnification

» Select the area with a rectangular marquee that you want to pro-
tect from the healing brush and invert the selection

< Figure 7-36:
Protect
window

» Now the healing brush is restricted to the selection and would
not interfere with the areas that are not selected (in this example
the window).

N
N
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After some more work we get a final result that looks like figure :

< Figure 7-37:
"Healed” image

This is not really perfect work but would not be seen in smaller to
midsize prints. This is a good example how the healing brush can
save your day.



Chapter 8
Batch Processing techniques
for RAW files

S S
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Camera: Canon 1DS

When shooting digitally, the number of pictures taken and pro-
cessed will quite likely surpass numbers done with your analog
camera by as much a factor as 2 to 5. For this reason alone, process-
ing photographs individually is inefficient and usually not viable. In
most cases, you will want to batch process most images.

All RAW converters described in this book allow you to do just that
- some in easier and more efficient ways than with others.

oo
-

Batch Processing Techniques for RAW Files ®
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8.1 Basic batch processing pattern

The basic mode used for batch processing is quite similar with all
converters described:

» Inspect and sort your files into those you wish to keep and those
you want to delete. This usually reduces the number of files by a
factor of 1.5 to 2.

» Sortyour files, grouping together all files having similar lighting
conditions or possibly those with contrast and color problems
grouped together. To do this, tag them, using the browser of
your choice. You may also choose to group them for different
conversion or output settings.

» Next, process the either the first (or most typical) picture of a
group with your RAW converter, taking all necessary care to
achieve optimal results.

If you do not have time or patience for that, you may use the
RAW converter’s default settings. In most cases, the resulting
photo will be better than in-camera processing. The reason for
this is that your computer has much greater processing power
than the processor in your camera. While the camera internal
processing program (its firmware) is infrequently updated, your
RAW converter may be updated far more often, gaining an
advantage using new know-how and better algorithms. In addi-
tion, you may have corrected some default settings of your RAW
converter thus compensating or correcting some imperfections
of your specific camera in specific shooting conditions.

» Save the RAW conversion settings so you may apply them later
to all other files with the same or similar characteristics. Some
converters, e.g. ACR, Capture One and RawShoooter, allow
applying subsets of these settings, as well.

» At this time, select all files in a group and apply the same set-
tings to them. You may now safely start batch processing your
files. This is usually done in the background while you deal with
editing for the next set.

Concerning the settings for RAW conversion, you have several

choices to choose from with most converters:

- Use the camera profile default settings (these may or may not
be modified from the original defaults)



- Use the original camera profile settings (those, shipped with
the converter)

- Use settings previously applied to the individual files

— Use the settings of the previous conversion

- Use the settings of a (temporary) reference image

- Use some other saved settings

» When doing batch processing, you usually have a choice of
where to write output files — either to the same directory as the
source files or to a different destination directory. We prefer the
latter, since it separates our working file set from the valuable
originals (RAW files).

Most RAW converters offer an effective method to naming (or
renaming) output files although in practice, we rename our files
before they are even seen by any RAW converter.

Some RAW converters discussed offer additional options for batch
processing. For example some may produce several output files
from each source file, for instance, a high resolution 16-bit TIFF to be
used for fine-tuning and printing, as well as, a low-resolution JPEG
file for use in a web presentation.

With most RAW converters you may choose if the batch pro-
cessing will be done in the background (while you continue editing
files) or at a later time. As processing many large files takes a toll
concerning CPU and memory resources, it may be advantageous
add files to a batch queue with the intention of processing at a later
time. Don't be surprised if the performance of your computer slows
noticeably while background processing is done (dual processor
machines help considerably at this time).

It is recommended you convert RAW files into a new location
(different folder). In this way, these files won’t be inter-mixed with
your current folder browser display. Also, there is no danger of acci-
dentally overwriting source files (most converters prevent this with
RAW files). Later, you may move or copy them back to the source
folder manually using a script or via the batch renaming of the con-
verter. Don't overlook defining a logical name scheme for the desti-
nation (converted) files. The RAW converter usually does that as
part of the conversion process. Applying IPTC metadata to your
RAW files (e.g. from ACR/Bridge) will save the labor of assigning this
data to your converted files, as well.

8.1 Basic Batch Processing Pattern ® 3
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Most RAW converters may be configured to open a converted
image in Photoshop automatically, in batch processing this usually
is not practical. We suggest you disable this option.

As mentioned earlier, batch processing is becoming more
important. In Photoshop CS1you had to write your own Photoshop
action to open a file, make the various settings in Photoshop and
save them, Photoshop CS2 comes preconfigured to do that. We see
similar enhancements in batch processing in newer versions of
other RAW converters, as well.

Apart from file conversion, simple file renaming is a frequently
required batch operation. This can be done with one of the many
renaming utilities (e.g. “Rname-it” or “Downloader Pro”, both men-
tioned in chapter 3). Currently, however, renaming has become a
basic function of most RAW converters. In Bridge, this function is
found under Tools»Batch Rename. The scheme for renaming is
quite flexible and allows for the inclusion of text, date, various
sequence numbers and some EXIF metadata in the file name (e.g.
an Image-Unique ID). A file may also be copied or moved to a dif-
ferent folder.

x|
[ Destination Folder Renarme |
 Rename in same folder z |
& Maove to other folder LI

" Copy to ather folder

Efjuergen/photcsiall_2005/3ll_dvd_05_08

[ Mew Filenames

[Date =l [Today =] Mmooy = =
| Text | [=soo_ (=] [+
| Text | JLosGatos =] [+
[sequence tumber <] [1 Four Digits = B

[ Options
¥ Preserve current filename in XMP Metadata

Compatibility: [ Windows [~ Mac OS5 [~ Unix

[ Preview
First selected filename First new flenarme
04112005_350D_|LosGatos0001.0RF 04112005_350D_LosGatos0001.0RF

3 files will be renamed

Figure 8-1: Batch-renaming dialog of Photoshop CS2



8.2 Batch Processing with Adobe Camera Raw

To convert a number of RAW files efficiently with Photoshop CS1you
must create your own Photoshop action. This action should open a
file in ACR, apply all settings for the ACR workflow (selecting output
Resolution, Depth, color Space, Size, ...) start the conversion, make
the setting for the target format, and finally save the file using the
appropriate (preferred) image mode. Important in file saving is
selecting an output file format and various settings for that specific
file format. (The following is brief description how to create such an

action. For more details, please refer to the Photoshop Help system).

How to create an action in Photoshop

Photoshop actions are very useful tools to do repetitive tasks.
Creating a new action may be as easy as just recording the dif-
ferent Photoshop steps in your task. Thus, an action is a
sequence of steps (such as opening a file or setting a new
image mode) in Photoshop.

To create your new action,  |EEEEEG—_— -
activate the action panel | History § Actions C

(Window »Actions). d b 3
Before starting, have a

look at the basic recording

tools in the action button

barl@ @ P 1 ] F

Their functions are (from the |

left to right): . . 2 al 9@

Stop recording

@  Record button: shows “red” if Photoshop is recording an
action and “green” when the recording is stopped.
= Replayaction
1 Create a new action set
al Create a new action
#  Delete action or action step

8.2 Batch Processing with Adobe Camera Raw B 3
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To create an action for batch processing RAW files, first create a
new action SET by clicking —I. Enter a descriptive name for this
action set:

New Set x|
Marme: | My _Batch_conwersion Ok |
Cancel

Select the new action set in the action panel and click 2l to cre-
ate a new action. This starts recording the following Photoshop
steps. But, first a dialog appears, asking for a name for the new
action. Lets us call it “16-bit RAW conversion”.

NewaAction x|
Record |
Set: | My_Batch_conwersion j Cancel

Function Key: [More | [ i .

Color: | [ Mone L]

INE=HN15-bit raw conversion

The next steps to be recorded, done in Photoshop, are:

» Open a RAW file (File » Open). It doesn’t matter which file you
open because its name will later on be replaced by the
source selection).

» When Adobe Camera Raw appears, set all Work-flow Options
you want to use for your batch conversion. From the ACR
Settings menu, select the appropriate conversion settings
set you plan to use in your batch.

» Click Open to start the conversion. The converted image will
be opened in Photoshop.

» In Photoshop set the image mode you desire and add proto-
type adjustment layers (this, only useful, if you prepare your
images for individual image corrections after the batch con-
version is complete).

» Call up“Save as” (File »Save as), select the appropriate file
format (e.g. TIFF) and explicitly set all options and modes
for your intended file format. The file name you give here



will be overwritten when the actual batch processing is per-
formed.

» Close the Save dialog by clicking OK.

» Close the image window in Photoshop.

Click ! to stop recording and thus finishing your action. Take a
glimpse of the steps in your action by clicking at b of your par-
ticular action in the action panel. You will see all steps and val-
ues chosen. Photoshop allows adding more steps, deleting or
replacing steps. All this is well documented when you call up
Photoshop Help.

You should now save your action set (select action panel,
right-click on ¥ 1 and select Save Actions).

To start batch processing with Photoshop, select File » Automate »
Batch.

Batch x|
There are four sections Play
in this dialog: R =it et - ol
Action: | Automation workspaces j
» Play for selectin
h y . gd Source: | Folder o
t e. action-set an e
aCtlon. [~ Owerride Action “Open” Commands
I Include All Subfolders
3 SOU rce to Select the I~ Suppress File Open Options Dislogs

™ Suppress Color Profile Warnings

Destination: ,None—L|
» Destination to spec-

ify where the pro- =
cessed (converted)
files should go. !

source files.

» Errors-Handling |

Figure 8-2: » Errars; | Stop For Errars -
Batch dialog in Photoshop

Section“Play” » First, select the action set. An action set is a collec-
tion of different actions grouped into a set. To be listed in this pull-
down menu, it should reside in the Photoshop default script folder.

8.2 Batch Processing with Adobe Camera Raw B 2
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You may, however, load additional scripts in Photoshop: Activate the
action panel (Window »Action). In that panel choose Load Actions
from the =) drop-down menu. From the Set menu of the Batch dia-
log select the specific action you plan to use to process your source
files.

Section “Source” » In the source sec- :
. . . . Source; | Bridge -
tion is specified which files to process =

and how the processing should be done.
Various source selections are available:

For this RAW conversion, only Folder
or Bridge (or File browser with C$1) is of interest. Selecting Bridge
processes those files selected in Bridge (or the Photoshop browser).
Or, if you select Folder, all files in that folder (and optionally all files
in its subfolders) are processed. In this case, you must select the
source file folder by clicking the Choose button. In either case, we
strongly recommend the following settings:

| Source: I Bridge vl
Chmmse. .. |

¥ Cwetride Action *Open” Commands
[ Include &1l Subfolders

V¥ Suppress File Open Options Dialogs
¥ Suppress Color Profile wWarnings

‘Bridge

4 Figure 8-3: Suppress
Open and Warning dialogs

Override Action “Open” Commands will suppress the open dialog
box as each source file is processed - it, nevertheless, will open each
individual file. If you do not check this button, only that file will be
opened which was in use when the batch script was recorded.

“Include All Subfolders”is optional and will do a recursive process-
ing of all source subfolders, as well. We rarely use this option.

Suppress File Open Options Dialog suppresses the file Open dia-
log when opening individual source files.

Suppress Color Profile Warning suppresses a pop-up of the warn-
ing dialog if there is a mismatch of color profile of the converted file
and current working space of Photoshop.

Section “Destination” » Similarly to the source section, you specify
your file destinations. They may either be written to the same folder



as the source files or to a different destination folder (which you are
asked to select by clicking Choose).

Section “Errors” » If an error occurs while processing the files, the
processing may either stop (useful when debugging your scripts) or
the error may be logged to a dedicated log file while processing con-
tinues with the next source file. The second option is preferable in
the final, well-tested script.

Batch conversion using Bridge

Using CS2 and Bridge for a standard batch RAW conversion, it is
unnecessary to build a Photoshop action. There is a simpler way:

» Select the files you want to convert within Bridge.

» Call up Tools»Photoshop »Imageporcessor. This brings up this
dialog box:

CTee—— x4
G Select the images to process
7, Process files From Bridge only {3)
(& W Cancel |
\J [~ ©pen First image bo apply setkings
Select location d i
e elect location to save processed images — |
7 Savein Same Location
(&7 Save... |
\J o Select Folder, .. | E:\Converted_Raws
e File Type
=E [~ | Resize ko Fit
Quality: |5 Wi I px
™| Conwert Profile ko sRGE H: I px
[~ Save as PSD [ Resize ba Fit
¥ Mawirnize Cornpatitility Wi I px
(b I px
[+ Save as TIFF [~ Resize ta Fit
W LZW Compression Wi I px
ik I px
() Preferences
[~ Run Action: Default Actions j IAutomation workspaces j
Copyright Infao:

W Inchude I0C Profile

Figure 8—4: Batch conversion via “Image Processor” in Photoshop CS2

8.2 Batch Processing with Adobe Camera Raw B 3
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You probably already know the scheme:

@® Open the first (additional) image in ACR and do the conversion
settings to be applied to all selected files (1).
If you don't use this option, current settings of the individual
selected files are used instead.

@ Select the destination for converted RAW files.

® Select a file format for converted files. You may generate JPEGs,
as well as, PSDs or TIFFs — all simultaneously.
You may even resize the (converted) images.

@ You may select an additional Photoshop action to be applied to
the converted file. The default action offers several different
workspaces.

You should always include the ICC profile of your destination
color workspace.

You may Save the current settings of this dialog box or may Load
settings previously saved.

Clicking Run starts the conversion. If you selected the Open first
image to apply settings (see area 1 of figure 8-4), ACR pops-up the
Open dialog where you may select a RAW file. This RAW file will be
open in ACR, and you may set up various ACR settings for image
optimization. Clicking Open in ACR starts the conversion using the
selected ACR settings for the selected file of the Open dialog as
well as the previous files selected in Bridge.

The pictures will eventually display in Photoshop, yet no actions are
required, and images are saved automatically.

Some Predefined scripts with Photoshop CS2 and Bridge

Photoshop CS2 ships with an assortment of preconfigured scripts to
do batch conversion. If the scripts are to your liking (test them!), all
you need to do is select the files to be converted in Bridge and call
up the chosen conversion-function.

To select batch-conversion in Bridge, select Tools» Photoshop »
Convert to. You may select one of the preconfigured destination
file formats like JPEG, PDF, TIFF, ...
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A dialog will pop up, that allows you to do file format-specific set-
tings (e.g. Quality for JPEG or embedding of an ICC profile). You may

select further conversion parameters (e.g.

options by clicking the Output button) in
omere o

L PrefErenes —————| oK
[~ &lpha chanrels

x|

[~ &nnotations Cancel

¥ Embed Calar Profie

Byte Order: IWinduws 'I
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Total Number of Files to be Converted: 3

destination folder, rename
the dialog.

4 Figure 8-6:

Option when converting to
TIFF using the “convert to”
script.

If the functions/scripts offered do not meet your requirements, or if
you need additional scripts, you may design your own Photoshop

actions and include them into the Bridge
script folder.

(or Photoshop) default
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4
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These predefined conversion scripts are available only in CS2
suite. Using only Photoshop or an additional component of the
suite, may modify your tool menu (figure 8-5).

Simple Photoshop CS2 Batch Conversion Using Bridge

When using Bridge, you may proceed very similarly:

1.

Select the files you want to convert within Bridge.

2. Shift-douple-click the previous file selected. This brings up ACR
in the film-strip-mode.

3. Select the file you want to use as the reference for your settings.
Do all corrections you wish to apply to this and the other images.

4. Now, select all files of the film strip (using the shift key) or click

5.
6.

7.

the Select All button (upper left corner).
The ACR Save button will change to “Save n images”.
Clicking Synchronize will apply settings to all selected files.

Click Save n images. The dialog box of figure 8-7 pops up.

Save Options B

8.

r— Destination: ISave in New Location j —_—
Select Falder... | DY _tmp_workfiles\x_acr_tmp), Cancel |

r— File Maming
Example: 10d_0001_0385.Lf

|Document Mame =+ =]
| =] | =
Begin Kumbering: I—

FieExtensions [&F =]

— Farmat: |TIFF =l

Compression: INone X, l

4 Figure 8-7

Clicking Save starts the actual batch conversion of selected files.
ACR registers the status of the processing at the lower right cor-
ner of the ACR window, just above the Save button.



8.3 Smooth Batch Processing

There are several additional points you should learn to achieve pain-
less batch processing. These points are valid not only for ACR but for
other RAW converters, as well:

» Be sure the source files you want to process are correctly
selected before activating a batch - either that you selected
them with the file browser or Bridge (if that is, indeed, the
source) or you selected the correct source folder.

» Make certain there is enough disc space for your converted files.

» Select a file naming scheme for your destinations files that
avoids overwriting files with identical names.

» Disable various Open and Save (or Save As) dialogs and the
warnings, as shown in figure 8-3 at page 8-8.

» If you have created your own batch scripts (recording Photoshop
steps), you must explicitly set all parameters and settings in
those Photoshop steps which are relevant for the conversion
even when they are correctly set as you process your sample
image (e.g. resolution, depth, space and output size or scaling
and your output file format). When you call up the script next
time, different settings may be in use, and result will be unpre-
dictable output.

» If you use a script for your batch, test it thoroughly. Test it under
different conditions, for instance, in cases where the output file
already exists.

8.4 Batch Processing with Capture One Pro

Capture One Pro was one of the first RAW converters providing
advanced batch processing, thus improving workflow with RAW
files. We prefer to use Capture One in film-strip-mode while batch
processing.

Principal settings for batch processing with Capture One are
made in File »Preferences»Process Settings (see figure 8-8 at page
8-14).

o
-
w

8.4 Batch Pressing with Capture One Pro B
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It allows including a
copyright note into the
output files without
calling up of the ITPC
metadata dialog.

The main section
for actual processing
are found under the
tab Process within the
Capture One main win-
dow. Here, it is the sec-
tion Batch Editor which
controls batch process-
ing.

This section (figure 8-9)
shows icons to control
the batch queue, and
shows the current ele-
ments and state of the
queue:

+ Adds the current
image (or all
images selected)
to the batch
queue. This does
not start process-
ing them.

%  Addsthe current
image (or all
images selected)
to the batch
queue, initiating
the processing of
the file.

x Removes a
selected item
from the batch
queue.

x
Expozure Evaluation I Preview Cache

Pawer and Partahility I Mizcellaneous Settings I Save Optionz I
Process settings | Capture Options I 1394 and Camera settings

— Maring

Default name: |L|ntit|ed
TIFF extension: |t JPEG extension: IF

Mame delimiter: |-

¥ Use capture name as default name

¥ Include last 5 digits of capture number in filenarne
¥ Include 3 digits for duplicated filenarmes

Sample name:

b Imnage-01 234, 4
b Irnage-01 2234007 L

¥ Include capture information in TIFF Caption
¥ Include EXIF information W Embed thumbnail [TIFF]

Aurtist: |Juergen Gulbins

Copyright: |Juergen Gulbing

— Procezsing zettings
[~ DoMOT rotate the image [according bo arientation)

¥ Disable Sharpening on output

[™ | Perfarm processing an single pracessor

B anding suppresszion; D5LR roige suppression;
. . T F
Loy High Low High

0K | Abbrechen |

Figure 8-8: Batch-setup in Capture One Pro
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B | e

Automatically open processed images W

Figure 8-9: Batch Editor in Capture One Pro




£  Starts processing of the queue. The progression bar at the bot-
tom of the sections will show the progress.

&  Stops processing of the batch queue. All items not yet pro-
cessed remain in the queue.

# - Opens files recently processed via a drop-down list.
@ Allows selecting a different destination folder.
By Opens the current processing folder for inspection.

When an item (image) is added to the batch queue, the settings
from the process tab (e.g. Resolution, Depth, Size/Scaling, File for-
mat,) as well as all the conversion settings of the Capture, White
Balance, Exposure and Focus tabs) are copied with the image-name
as part of the conversion job ticket.

As in Photoshop, Capture One provides a rename function. To
set it up, click &. To start renaming, select files in the browser and
click &

Though Capture One DSLR was one of the leading utilities con-
cerning batch processing, it has fallen somewhat behind new
releases of other converters. However, it is still fast compared to
some converters and delivers very satisfactory image quality.

o]
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8.4 Batch Processing with RawShooter

Batch processing setup in RawShooter remains relatively simple. We
prefer RawShooter in its film-strip-mode. The settings for processing
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are grouped under the Batch convert tab.

After applying the proper conver-
sion settings (Correct tab), select
the file or files you want to pro-
cess, check your workflow param-
eter using the tab Batch convert
and click Add.

This create job tickets for the
batch conversion and adds them
to the batch queue. The process-
ing will only start when you click
Go!. Once you begin the batch
queue, all items of the queue are
processed as quickly as possible
until you stop batch processing
by clicking Stop (which has
appeared during an active batch
queue instead of Go!).

A status bar shows progress
of the individual conversions. All
items processed will be removed
from the batch queue. As with all
other RAW converters, original
RAW files will not be modified or
touched. There is a button to
call up the dialog for

Conect  Batch conwvert ]
Less apkions, ..

Camera prafile
Internal [default]

RGE working space
Adobe RGE [1333)

File Formak Bit depth
TIFF 16 bit
Cualicy Meta daka
R EXIF

Apply sharpening

Automatically open with:  Choose, .,
Title  PS272509

Marning and output location, .

Add Gol Femove  Locate

! P5262473.0RF =
®4 P5262473

| PE272504.0RF

ﬁ | Pr272504

| Po272508.0RF
-} FE272506

Figure 8-10: Batch-convert tab of RS

Naming and output location. Locate opens the destination folder
containing converted files using the file browser of the operating

system.




Chapter 9

DNG - Digital Negative Format

Camera: Olympus E-20P

9.1 DNG - its potentials

As of mid-2004, each manufacturer of digital SLRs had its own pro-
prietary RAW format — moreover, most had several (somewhat)
unique RAW formats for different camera models. For photogra-
phers using more than one camera, this was a real nuisance.
Software companies, which intend to process RAW format files, must
provide a broad, ever-increasing range of conversion routines as
part of their software. Each time a new camera hits the market, they

©
-
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have to evaluate its specific RAW format and often must adapt and
enhance their converters. To print-shops, studios and others hand-
ling digital data, the large variety of RAW formats remains a serious
problem, and processing becomes costly.

Having implemented Adobe Camera Raw, one of the best RAW
converters of the market, supporting a broad range of RAW formats
(as of this writing, about 60 formats), Adobe has a rich experience
with RAW conversion. To support the multitude of formats with
Camera Raw, Adobe takes a two-step approach. The first is to con-
vert the proprietary RAW data into a universal internal RAW format.
The actual conversion from RAW to JPEG or TIFF is done from an
intermediate format. The multitude of formats supported by Adobe
camera RAW, provides Adobe with a very good insight of the gen-
eral requirements of a universal RAW format. Having this record of
quite useful and universal format experience (PostScript, PDF, XMP,
...), Adobe began to specify a generalized format for RAW photo
data. The result was the introduction of Digital Negative Format
(DNGQG) at the Photokina exhibition, 2004. Its purpose is to provide a
universal container for RAW photo data and is partly derived from
TIFF EP, a format used by other RAW formats, as well. DNG likely
bears a resemblance to the internal intermediate format of ACR, but
it is an external file format. Apart from the actual RAW data - the
data read from the camera sensor — and the well known metadata,
such as EXIF and ITPC (see chapter 10), it allows embedding proprie-
tary data of the camera maker (Adobe calls it private data), as well.

Though introduced and controlled by Adobe, DNG is an open for-
mat — well, as of now, half open. It is open in the sense that it is well
specified, documented, and its specification is published, something
that is not true for most of the various proprietary RAW formats.

DNG holds three promises:

» It may be used as an exchange format for RAW photo data, used
whenever necessary to provide RAW files to a service or person,
who cannot (or does not wish to) process the proprietary format
of your camera.

» It may be used as an archival format for RAW photo data.
If the specific proprietary RAW format of the camera used in the
shooting is no longer supported, or the conversion to a standard
format is no longer optimized (while the general optimization of



the RAW data using the Bayern pattern continues), RAW files
archived as DNG will probably still be accessible and their access
should improve over time.

» DNG may replace some proprietary RAW formats or preclude
introduction of additional new formats, thus reducing the
jumble of different formats you may handle.

While not all of these predictions will come true immediately, DNG is
a promising newcomer. Already, some advantages are obvious.

DNG as an exchange format »To use DNG as an exchange format
today is quite simple. Adobe offers a free Raw to DNG converter
(DNGC for short) on its web home page ([45]). It is available for
Windows and Mac OS and can handle the conversion of complete
folders (see section 9.2). All cameras supported by Adobe Camera
Raw are also supported by DNG converter. Rather than handing-off
photos to others in a proprietary RAW file format, it is probably advis-
able to supply your data using DNG (unless JPEG or TIFF is the appro-
priate format). As the range of formats supported by Adobe Camera
Raw is extended, support will also extend for DNGC.

DNG as an exchange or archival format is not only supported
by Adobe, but most other providers of RAW converters have picked
up support for DNG, including Phase One (with Capture One) and
Raw Shooter. Most software companies supporting RAW format for
asset management systems, now support DNG or will do so soon.
So, if your favorite tool does not yet support your specific RAW for-
mat, you may convert it to DNG using DNGC. Doing this, you will be
able to include those images into your picture database or use them
with a special filter or other tool designed for working on RAW files.

There is yet another advantage in using DNG. As there is (inter-
nally) a clear separation of photo data and metadata (see chapter
10), if you change settings in the preview of a RAW converter (e.g.
Adobe Camera Raw or RawShooter), these new settings need not
be stored on a separate sidecar file, but may be included into the
dng-RAW-file without actually modifying the original photographic
information (sensor readouts).

DNG as an archival RAW format » As PDFs, are an answer to many
archiving problems troubling companies storing their office docu-
ments, DNG may be the answer for archival of RAW photo data. As
with PDF however, this may not solve all problems nor be the best
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solution in every case but definitely should be seriously considered
as a long-term archival format for RAW photo data. Adobe will most
likely not go out of business for some time. If that should happen
(unlikely as that may be), numerous other RAW converters are sup-
porting the conversion from DNG to JPEG, TIFF or other standard for-
mats to come.

The Digital Negative specification provides for not only all pixel
information stored in current RAW formats, but also for all addi-
tional, proprietary metadata that many manufacturers include.
Note, however, that the current release of the Adobe DNG
Converter may, in some cases, ignore a portion of proprietary
metadata, and include only basic information required for creating
a high-quality image file. For this reason, using this release of the
Adobe DNG Converter for archival purposes, it is recommended
you save your Digital Negative files in addition to the original RAW
files created by the camera.

DNG as native camera RAW format » When DNG was introduced
by Adobe in 2004, many photographers wondered whether camera
manufacturers might pick up DNG as their native camera RAW for-
mat. It seems obvious that smaller companies and new market
entries would be the likely early adopters, while the main stream
industry, such as Canon, Nikon and Minolta have invested too many
resources into their formats and tools to switch any time soon. As it
turned out, it didn't take long before some companies committed to
DNG. Early 2005, Hasselblad and Leica announced their commitment
and will support DNG as native camera RAW format.

DNG definitely will not be the only solution to the dilemma of a wide
variety of RAW formats. In the future, a real RAW format standard will
probably be defined by a standards organization, such as ISO or
ANSI. Then, Adobe will probably propose DNG as a standard. Today
however, DNG is an important step toward reduction of the format
variety in RAW photo data. As with PDF, DNG will undergo enhance-
ments over the years and will be extended to pick up new features of
futures camera techniques.

It is too soon to judge the success of DNG or its part in the for-
mat gamble. However, it exists, is easy to use and well supported. It
may be a reasonable solution when you want to pass RAW data to
outside parties. DNG may offer a good solution, if you want to use
some special software on RAW data not supporting your specific



RAW format, or when you wish to save an additional copy of your
RAW data, using DNG, for archival purposes.

As of today, however, we would not recommend conversion of
all RAW data to DNG then delete original files (though DNG files
may include your original RAW data), but would recommend its use
for exchanging RAW files with other parties.

9.2 Usage of the Adobe DNG Converter

The Adobe DNG converter (DNGC for short) may be downloaded
free of charge from Adobe’s Internet Home Page ([45]). It has multi-
ple functions, outlined above.

= E
@ Adobe Digital Negative Converter :,‘}!

| Select the images to convert

=
[ ") Select Folder.. | D4 tmptmultiple_raw'

I Include images contained within subfalders

-1 Select location to zave converted images

fa -"\' ISave in Mew Location 'l
Select Falder.. | Db tmpmultiple_raw_dngh

I | Breserve subfolders

 Select name for converted images

Mame example: MyDocument.dng

IDocumentName ;I +| ;I o
I == =
Begin numbering:
File extension: |.dng -
< Figure 9-1:
Preferences .
Compressed (lossless) Change Preferences. .. DNG dlalog
Freserve Faw Image
Don't embed ariginal tO Convel’t a
About DMG Converter... | Extract... | Convert I Exxit | Complete fo,der
of RAW files

The interface is uncomplicated, and you will be wise to keep in
mind, that its task is to convert an entire folder of RAW files, not just
a single one.

In section @, you specify the folder in which RAW input files
requiring conversion reside. Section @ indicates where the gener-
ated dng files will go. Parameters of section ® define the naming
conventions of the newly-generated dng files. Parameters of sec-

9.2 Usage of the Adobe DNG converter B ﬁ
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tion @ specify, how the conversion will be done. Clicking on
Change Preferences brings up the following dialog box:

Preferences )

— Compression

¥ Compressed [lossless)

— Image Conversion tethod
+ Preserve Faw Image

" Conwvert to Linear Image

i/. The image data iz stored in the onginal “mozaic” format, iF pozsible,
B which maximizes the amount of data prezerved. Mozaic image data

cah be converted to linear data, but the reverse iz not pozsible.

— Original Faw File
[~ Embed Original Raw File
Embeds the entire non-DME raw file inside the DMG file, This creates

alarger DM file, but it does allow the original raw file to be extracted
later if needed.

i

< Figure 9-2:
0k, I Cancel | DNG
Preferences

Compressed » should always be used since it is a lossless compres-
sion, reducing about 10-65 9% from files sizes.

Image Conversion method » There are two ways to do the conver-
sion: retaining the original RAW data — usually the data of the Bayern
pattern sensor data — and a conversion to a linear picture. In most
cases, the first method is preferred. As improvements in the Bayer
pattern interpretation (also called demosaicing) come along, you still
retain original data and may apply any improved algorithm to that
data. As significant improvements were implemented in the past
couple of years, more may be expected. Converting to a linear form
actually performs an interpolation of the Bayer pattern (exception:
RAW files from a camera with a Foveon-based sensor). In doing this
method, some potential of your RAW negative is lost if you want to
go return to the original RAW data. Additionally, file size increases by
about 60 to 300% (the linear version holds RGB data, while native
RAW format stores but one pixel value per sensor element).



Original Raw File » You may embed the complete and original RAW
fileinto a dng file, essentially making dng into a wrapper for your
RAW data. You may extract the original file from the dng file (to
extract such a file, activate he button Extract at the bottom of the
conversion dialog box).

Clicking Convert initiates batch conversion. DNGC is quite fast, but
converting many large files still takes time. Progress is indicated in a
separate window. Stop the conversion by clicking Stop Conversion.

Conversion Status i

Images remaining to convert: 28 of 28

Original File: Converted File: Status:
10d_0000__00&1.CRWw 10d_0000__0081_1.dng Processing -
10d_0001_0384.CRWwW 10d_0001_0384_1.dng ‘Waiting
10d_0007_0385.CRW 10d_0001_0335_1.dng “Waiting
10d_0007_0386.CRW 10d_0001_0326_1.dng Waiting
10d_0001_0387.CRw 10d_0001_0387_1.dng ‘Waiting
1D2_9000_0022.CR2 1D2_9000_0022_1.dng ‘Wwaiting
1Ds_0000_0T12TIF 1Ds_0000_0112_1.dng “aiting
1D_7DE4A0360.TIF 1D_7D8A0360_1.dng Waiting
300d_0000_1354. CRWw 300d_0000_1954_1.dng ‘Waiting LI
Thank you for using the Adobe DNG Converter. Adobe offers a full line of digital
imaging products ta help wou get the maost out of wour phatographs. 1L l‘l u ]
DN(
Learn Mare at Adobe.com | e e
< Figure 9-3:
Stop Converzion | ] 4 I Exit | DNG ConveI’Sion
#  Status

As with original RAW files, DNG files may be used as input to RAW
converters. If you attempt to open a dng file using Photoshop, it will
launch Adobe Camera Raw to do the conversion from DNG to stan-
dard image format, as described in chapter 4. The dng file includes
all metadata, such as EXIF and ITPC data, embedded in the original
RAW file. It may not, however, contain some undocumented proprie-
tary parts whose meaning is known only to the manufacturer of the
camera. To keep that data, as well, you must embed the original
data in dng, hoping that its meaning will be known to Adobe (or
possibly another provider of a RAW converter) to be released at a
future date.

If you use Photoshop CS2 (Photoshop 9) or later, there would nor-
mally be no need to use DNGC, because Adobe Camera Raw 3.x pro-
duces DNG files, as well. In this instance, it is simpler to call up ACR
via Bridge and use ACR for the conversion.

9.2 Usage of the Adobe DNG converter B ‘f,
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9.3 Advantages and disadvantages of converting to DNG

Adobe’s DNG converter runs smoothly and fast. However if you
already have dng files in your source folder, DNGC converts them as
well, which usually makes little sense. When we tested the converter,
dng files could be opened by Photoshop CS1 (aka PS 8) and Photo-
shop CS2 (aka PS9). As of this writing, C1 and Raw Shooter, Nikon
Capture 4.1, Canon Digital Photo Professional and Bibble did not
support DNG. Many Viewers and DAMS (Digital Asset Management
Systems) supporting RAW files did support DNG (e.g. ThumbsPlus,
Extensis PORTFOLIO, iView Media Pro), but an updated version of
their RAW converter plug-ins may need to be downloaded.

Using lossless compression, dng files are usually smaller than
original RAW files, depending upon the RAW format used. While
with Nikon .NEF files tend to gain about 10%, with my Olympus
.ORF files (from a Olympus E-20P DSLR) dng file size was about 1/3
the original Olympus file size! This factor may be an additional
advantage when storing files on a CD/DVD or when transferring
RAW files via the Internet. If compression is not activated, however,
the dng file is usually larger than the original file — up to 2 times. For
that reason alone, we do not recommend using this option.

Adobe supports new cameras very soon after they are on the
market. So, in some cases, converting those RAW files to dng may
allow them to be correctly handled by other applications working
with RAW files - such as, asset management systems (ThumbsPlus,
Portfolio, iView MediaPro, ...) or special stand- alone filters such as
DxO - which do not yet (or never will) support your specific RAW
file format.

Exchanging RAW files as dng with outside parties, such as print
shops, may be another usage, though, to date, most print shops
and similar services prefer TIFFs or JPEGs.

Converting from a proprietary RAW format to DNG is clearly an addi-
tional step in your workflow. DNGC does not yet support hot folders
(watched folders). So, each time new RAW files are imported, you
must call up DNGC. This may become automated using a script, but
you still have to deal with them. Until now, all RAW formats sup-
ported by DNGC are also supported by Adobe Camera Raw. So, there
is currently no real advantage to using DNG locally. Exchange of RAW
data, clearly demonstrates its advantages.



Chapter 10
Metadata

Camera: Nikon 100D

10.1 Metadata for Photographs

Metadata provides descriptions with data. Using digital photogra-
phy, metadata describes an actual photo taken. Metadata may be
embedded in the actual data file or may be stored separately -
either in a discreet file or in a database. With RAW files, TIFFs and
JPEGs, we actually find several types of metadata:

» File attributes
» EXIF information
» ITPC information

Metadata m @

-



» Further metadata such as

RAW conversion settings (e.g. embedded in XMP),

JPEG comments,

Preview icons and preview images,

Keywords,

Classification data etc. (partly stored in an image database).

File attributes » The file Metadata “Keywaords
system stores metadata, = File Properties
such as filename and file Filenarne | PEO42765.0RF
type (given by its exten- Document Kind v Camera Raw
sion), (file) creation and Application P 29-1104
1(:2 modification date, access Date C.rE.'atE!d v 04,03,2004, 14:21,.,
. rights, file Iength, etc. Date Ffle Cree.ut.ed v 11.03.2005, 12:03...
- . . Dake File Modified ' 05.08.2004, 00:21...
3 This metadata is deter- —= :
8 ined by th File Size P 9,47 MB
2 mined by the camera, Dimensions : 2572 x 1920
S and, later on, by your Resalution ' 240 dpi
= operating system, the Bit Depth ' 16
()
=4 RAW converter or other Supports XMP ! Yes
© o . o
S applications. Aside from Figure 10-1: File Properties in Bridge

the file name and type,

and to a lesser extent, the creation date, this data is of no great con-
cern or information value to the photographer. Some cameras
include information as part of the file name, e.g. the creation date.

EXIF information » The Metadata “Keywords 5

EXIF data (EXchange 7 Camera Data (Exif) N

Image Format for Digital Exposure P 1)3205 at 4

Still Cameras) is created Expestice Rroura) + Mormal

by the camera and 150 Speed Ratings a0

. R Focal Length V17 mm

includes settings used M Aprbire ke  F2.0

when the picture was Sofbware D Pa-1104

taken. You find informa- Dake Time ' 04.08,2004, 14:21..,

tion on the camera maker Date Time Original »04.05.2004, 14:21...

and model, apertureand "= - pilmoctie -
Metering Mode ' Pattern

shutter speed, ISO set- Gt TR

tings, type of lens, focal Make ! OLYMPUS OPTICAL...

length used and if a flash Model + E-20,E-20N, E-20P

was active. [tincludes the Figure 10-2: EXIF data in Bridge

date and time of the
shooting, as well as the metering mode used, white balance and



color space settings, the camera program used and the resolution of
the photograph. It may even contain the location of the shot via GPS
data (e.g. for the Nikon D2X there is an optional GPS module available
to record current GPS coordinates. This is included into the EXIF data
of the camera). There are many more data, EXIF can store. The EXIF
specification also allows for addition proprietary fields. All these val-
ues are recorded when the picture is taken and embedded into the
data file, be it JPEG, TIFF or RAW.

This EXIF data is not only valuable to the photographer, but is
also used by the RAW converter, by optimizing applications, such as
the lens correction software PTLens or DxO ([34]) or by the firm-
ware of inktjet printers when (automatically) optimizing pictures for
output. (This optimization may be suppressed by explicitly sup-
pressing automatic optimization with your print job or by an EXIF
flag, indicating that the picture was optimized by some other appli-
cations previously, for instance Photoshop).

Normally there is little need for a user to change this informa-
tion. Consequently, neither ACR, C1 nor DPP provide this change
function. If, however, the date and time for shooting is not set cor-
rectly, you may wish to eventually make such a correction. If you
do, you may use a special application, such as Exifer ([35]) or
ACDSee ([36]).

IPTC (International Press Telecommunication Council) » This
type of data has been in use for some time with photographers
shooting press-related material. It was defined by the International
Press Telecommunication Council, and permits inclusion of copy-
right notices, author, title, a short subject description and keywords
for retrieval. This metadata is very DRM (Digital Rights Management)
oriented; it however does not embed a watermark into the file.

Though these ITPC fields are present in pictures coming out of
the camera or RAW converter, they are usually empty. They must be
filled in by the user. Photoshop provides a function to do that.

Additional metadata » While there is a well-accepted standard for
EXIF and ITPC, you may find a multitude of additional metadata.

Adobe defined XMP (Extensible Metadata Platform) for the
metadata exchange between applications. XMP is widely used in
Adobe applications, such as Acrobat, Photoshop, Illustrator,
InDesign and others. XMP is XML based and open (its specifications
are published, and it is supported by the IETF). XMP data may be

e
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embedded into your data file or may be stored in a separate file.
XMP is quite flexible and may contain predefined fields, as well as
user-defined fields. With Adobe Camera Raw, the settings for RAW
conversion are embedded in an XMP file. Photoshop (and Version
Cue) may even include a version history in the XMP file of a picture.
Other makers of RAW converters store such information using a dif-
ferent format. RawShooter Essentials, stores these settings in files
using the file extension .rws (inside a subfolder .RWSSettings in the
folder containing the RAW files). These files are in a binary format.
RawShooter supports having several setting files for one RAW file
and you may choose which settings to use for the conversion.

Further metadata on your photos may be stored in a separate
database, often the case when you manage pictures using a digital
asset management system (DAMS) such as Extensis Portfolio, iView
Media Pro, ThumbsPlus or one of the other numerous asset man-
agement utilities, professional document or content management
systems. While using an asset management system, you may usu-
ally add keywords, categories and further classifications. These
metadata are normally stored only in the database of the DAMS. If
you use a DAMS to administrate your images, make certain your
DAMS is importing those EXIF- and IPTC-fields, since you will likely
use them for searching into their database. Searching a database is
much faster than opening individual files to read data.

There are some overlapping fields within different metadata sets.
For example, ITPC, as well as EXIF, provide a field for the title (or
name) for your picture. You may also include it as a JPEG comment
(not so on RAW files). For that reason, you should decide where you
want to include this data. Redundancy often leads to conflicts and
errors.

Another type of metadata not mentioned above, are ICC profiles.
Profiles defines how the color (pixel) values of the image are to be
interpreted (see chapter 11). At present, ICC profiles are not part of
RAW files, but must be attached (embedded) to photographs when
they emerge from the RAW converter and should stay with the file
ever after. Files containing embedded ICC profiles are called ICC
tagged files.

All of the RAW converters discussed handle EXIF and IPTC metadata
and tag-converted files with the appropriate ICC profile. Again, at



present, XMP usage is mainly restricted to Adobe applications. All
these metadata can be quite useful and important to you. Their use-
fulness increases over time as more and more applications come
along, taking advantage of such metadata information. Bridge, for
example, lets you search and sort files by much of the metadata
mentioned (not only with photo files, but other Adobe application
files, as well).

An example: If you browse your picture files using the
Photoshop CS1 file browser or Bridge (part of Photoshop CS2) and
change the white balance of a RAW data file (even without actually
converting the RAW file), those changes are saved and stored as
XMP data either embedded into the RAW file or as separate “sidecar
files”. Since RAW files are considered sacrosanct (never to be modi-
fied), any additions or modifications of metadata are stored in sepa-
rate files by ACR, Bridge or RawShooter. When using DNG (see chap-
ter 8), metadata, such as conversion settings, may be embedded, as
DNG provides a clear, well-defined structure for accomplishing this.

Concerning display, editing and usage of metadata, Bridge, ACR
and Photoshop Elements are the most advanced of the set of appli-
cations we deal with in this book. Using a digital asset manage-
ment system, you will find more advanced features for metadata
handling.

10.2 Metadata usage in Adobe Camera Raw and Bridge

Adobe applications are making increasing use of metadata. Both
Photoshop file browser or Bridge display some metadata as part of
the image icon list and even more as part of the metadata preview
window. The (almost) complete range of metadata is displayed,
when you call up the File Info window.

Using Bridge or the file browser of Photoshop CS1, you may
customize which metadata is displayed with the preview icons of
the browser and what kind of metadata is visible at the metadata
panel of the browser (see figure 10-1 at page 10.6). This configura-
tion (customizing) is done via Edit»Preferences. (Mac:

Bridge» Preferences). To customize information display with the
preview icon, select General.

o
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Preferences

General [0

Metadata

Labels

File Type Associations
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a Figure 10.3: Customizing of metadata in icon view
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To determine, which metadata is displayed in the Metadata Area of
the file browser, go to Edit»Preferences » Metadata. Again, the
metadata fields are grouped by file properties, IPTC Data and EXIF
Data. Additionally, you may activate a display of edit history. Labels
and ratings associated with a picture file are part of the file’s

metadata, as well.
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4 Figure 10.4: Customizing of metadata
in icon view mode

el

Powered By

) Hide Empty Fields

( Cancel

) .

1d2_0000_0091.CR2
25.05.04, 10:51:29 Uhr
3304 x 2336 @ 240 dpi

1Ds_0000_4592_lin.dng
19.05.04, 11:48:35 Uhr
4064 x 2704 @ 240 dpi



As said previously,
all ITPC data must
be entered manu-
ally. You may do this
at the metadata
area of the file
browser. Click on
one of the ITPC
fields marked by a
# and enter the
value for that field.
Pressing (1] will
write the data into
the file.
Alternatively,
you may call up the
metadata window
by right-clicking the
mouse button and
selecting File Info.
Though keywords
are part of the ITPC

Metadata “‘Keywords S

[O]

W IPTC {lIM, legacy)

Document Title | Red Poppy
Description .

Author - [Uwe Steinmueller
W IPTC Core

Creator

Creator: Address
Creatar: City
Creator: State/Province
Creator: Postal Code
Creator: Country
Creator. Fhone(s)
Creator: Email(s}
Headline
Descripticn

IPTC Subject Code
Date Created

IPTC Scene

Locatian

Title

Provider

Source

Copyright Notice
Rights Usage Terms

- [Uwe Steinmueller

Figure 10-5: ITPC data may be edited
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set, with Photoshop file browser or Bridge, you must use the Keywords
panel to edit and enter them.

Keywords may be grouped in sets. If you apply a set to a file,
all keywords of that set are included in the metadata. You
may, however, select only one or more keywords of the set
and apply them. If you delete a keyword or a set from the key-
word panel, or if you change the keyword name, it will not
change the keyword data of all those files that have those

keywords previously assigned.
To rename, delete or create a new keyword

New Keyword
or set, go via the = menu of the keyword New Keyword Set
panel or call up the menu via the right mouse Rename
button while the mouse cursor is over a key- Delete

word field.
If you select several files (preview icons) and edit the ITPC or
keyword metadata, new values are applied (added) to all selected

e
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files. The panel in this case will usually display murtiple vaives), to indi-
cate, that the data values of the selected files differ.

If you want to apply the same ITPC data to several files, e.g.
name, copyright, URL and your address - this is an uphill task.
Bridge, however, allows applying a metadata template to the files
selected in the browser windows. To do this, first apply the
metadata to a single file and save this data to a separate metadata
file (.../File Info» Advanced»Save). Next, select the files you want to
provide with the same metadata inside the file browser and apply
the saved metadata to the files via .../File
Infor»Advanceds»Append, selecting the name of the metadata pre-
viously saved in the upcoming dialog box. Using Replace instead of
Append will replace all of your file metadata with the fields set in
the template.

XMP files are Unicode text files. So, you may view their content by
simply opening the XMP file using an ordinary text (Unicode-
enabled) editor, where you may edit its content. This allows creating
your own metadata templates, e.g. for an easy assignment of copy-
right information to photographs or even creating your own cus-
tomized File Info panel (a description for this can be found at [43]).
However, the basic structure of the file should not be altered.
Conserve the correct XML/XMP syntax.

With Photoshop, Bridge and ACR, there are two ways to store
metadata not embedded in an image file:

» atthe ACR database or
» inside a separate XMP file, called a“sidecar file” by Adobe.

Both methods have their benefits and their pitfalls. Storing external
metadata in the ACR database file will result in a very compact, cen-
tral solution. There are two disadvantages of this central database,
however:

» If you move your directory with picture files or rename your pic-
ture file, the connection between the picture file and its external
metadata is broken, and it is difficult to recreate that connection.
Any renaming using the Photoshop file browser or Bridge, the
association is maintained. But, there is no function to move a file
or complete directory of files within Bridge or Photoshop C51 file
browser (except drag and drop).



» Storing metadata in an XMP sidecar file adds an additional XMP
file (name.xmp) for each picture file. It resides in the same direc-
tory as the RAW file, and contains metadata, as well as the RAW
conversion settings of the image file. As long as you rename your
image file or move it using the Photoshop file browser or Bridge,
the sidecar file will be renamed, copied or moved consistently. If
you do these operations using different tools, you must make al-
lowances for the sidecar file.

We prefer the second method because it allows moving whole fold-
ers, including the metadata information, as well as archiving a folder
while easily including metadata with the folder (e.g. on a CD or
DVD).

The scheme is very similar with the other RAW converters and file
browsers, though they use different file and folder names.

10.3 Retrieving files by searching for metadata

An important benefit of metadata is its use for sorting and retrieval.
With PS file browser or Bridge, you call up the find dialog box via
Edit»Find or via [Ctr]+[F] (Mac: (E]+[F ). Here, you may include sev-
eral metadata characteristics into your search criteria:

i Find 7
Source
Look in: | DNG-test-suite I+] ( Browse... ) ( Cancel )
E Include All Subfolders | Search Past Versions of Version Cue Files
"] Find All Files
Criteria
Keywords }-3-1 contains Irﬁ D70 = @
Eilerae 4——All Metadata Fi-i contains PH Kéln =) @
File Size =
Date Created Match:  If any criteria are met H-v]
Date Modified ™ Show find results in a new browser window
Document Kind
Label
Rating 4 Figure 10-6: Bridge Find dialog. It allows to specify several loopup
Keparonds criteria
| Description
Comments

¥ All Metadata

o
©
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The files fitting the search criteria are grouped in a temporary set.

The search function for metadata is not available (as of now) with
RawShooter, Capture One, Bibble, Nikon Capture or DPP. However
you may find these with asset management systems like ThumbsPlus,
Extensis or iView - provided they included that specific metadata
into their database when importing the image files. While Photo-
shop searches for data in its cache or by reading the metadata section
of the files, asset management systems look it up in their database,
usually much faster if a large number of files are handled. You should,
however, be sure that the metadata you will likely use for searching
is included in the DAMS database when importing your images into
these systems. This may have to be configured when customizing your
DAMS (digital asset management system).



Chapter 11
Profiling and calibrating for your
RAW Converter

Camera: Olympus E1

11.1 The problem with camera profiles

In chapter one and two, we emphasized the importance of ICC pro-
files. What was said is true for monitors, scanners and printers. But,
profiling is useful for digital cameras as well. Cameras, however,
present a problem:

When you profile a device, the first step is to define the relevant
parameters, light being one of the most important. When you profile

-
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a scanner, the light source remains the same (you only differentiate
between reflective and transparencies). With printers, Dso (daylight
at 5,000 Kelvin) is the standard light source for evaluating and judg-
ing prints. Cameras however, encounter varying light conditions, e.g.
night shots, morning light, sunny or cloudy). For this reason, profiling
your cameras is practical only if you shoot in only one or just a few
different lighting conditions, such as may be the case when shooting
in a studio.

If all this holds true, the scheme for profiling can be quite simple
and similar to other device profiling:

» Shoot a camera target using the same lighting conditions you
propose to use with photographs. Use those camera settings
(e.g. resolution, white balance, exposure, ...) you will (most
likely) use later for shooting. Your target must have uniform
lighting. The hardest part is to get even lighting avoiding reflec-
tions with color targets with glossy patches.

» Import the image of the camera target into your profiling soft-
ware. Doing this avoids any color correction and much of the pro-
cessing (you need to use a RAW converter if the target shot is a
RAW file). In some cases, correcting white balance may be helpful.

» Your profiling software compares the colors appearing on the
image of the target with known color values of the target and
calculates the camera ICC profile from that.

Keep in mind however, that this ICC profile is only valid for the
camera you used for shooting and only for pictures taken with
identical (or quite similar) lighting conditions used when shoot-
ing the target originally.

If you are shooting TIFFs or JPEGs, apply this profile to your photo-
graph when opening the image in Photoshop. If you shoot RAW
files, the RAW converter should accommodate camera profiles. Only
RSE, C1 and Bibble do this.

All RAW converters we consider in the book provide their own,
generic internal profiles for the cameras they support. Usually, sev-
eral shots are taken with a specific camera while using different light-
ing conditions. From these photos, an averaged profile is calculated
(with additional tweaking). White balance control of your RAW con-
verter allows white balance of your image to shift along the axis
between the profiles for low color and high color temperature.



There are several packages to accommodate camera profiling — e.g.
the module Camera by Gretag Macbeth ([15]), inCamera by
PictoColor ([24]), or Profile Prism by Digital Domain ([33]).

11.2 Camera profiling using Eye-One Photo and
ProfileMaker

GretagMacbeth ([15]) offers
Camera, a package con-
sisting of a camera target
and a software module
called ProfileMaker 5.
Camerais sold as a stand-
alone package or as part
of different Eye-One pack-
ages - e.g. Eye-One Photo.
Gretag's Camera — sup-
porting Windows as well
as Mac OS - including a small (4 x 5 Inch) camera target MiniColor-
Checker.

For serious camera profiling, however, you should consider
ColorChecker SG, which may be ordered separately. It is larger, has
many more patches and allows better profiles. It does come with a
fierce price tag (around 300 US Dollars or Euro plus tax).

Figur 11-1: GretagMacBeth
MiniColorChecker

i Digital ColorChecker® SG

EN BN _EE
1 . e ‘.‘ i

< Figure 11-2:
Gretag MacBeth
e " e . X ColorChecker SG, an
H HE HBE . J excellent camera
A Vi s o e b target

Despite this, it is of excellent color quality, quite robust and the col-
ors should not fade for a long time, even when used in bright light.

=y
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The color patches show very little metamerism in varying lighting
conditions.

To profile a camera using Eye-One Camera, follow these steps:

1. Take a picture of the target — we recommend ColorChecker SG
— using the same lighting condition you use for a shooting ses-
sion. Continue with your shooting and do the profiling before
you process your images of that shooting session.

2. Convert your target image using standard settings with your
RAW converter, then convert to a TIFF file. If you usually work
with 16-bit TIFFs, convert the target image as a 16-bit TIFF, as well.

3. Start ProfileMaker 5 and select Camera.

I x

File Edt Language Help

ProfieMaker 5.0

PROFESSIONAL

MOHITOR CAMERA SCANNER | FRINTER | MULTICOLOR

DEWICE LINK.
| i

Reference Data Photo Task
IDigitaI ColarChecker SG.tat ;l |General Purpoze ;l

Photo Tazk Options... |

Photographed Testchart Light Source
| MyTarger_CC-SGaif | |Ds0 -]

Calculate Profile

Start.. I

Batch |

Figure 11-3 »: Starting dialog of ProfileMaker 5.0



4. From the drop-down list labelled Reference Data select the type
of target used.

5. With the drop-down list Photographed Testchart selected, press
Open. Navigate to the image of the target shot.

6. ProfileMaker will show the target image in a new window.

iz 1ds2_5001_0329-RSE.if I (=] 4

. Crop your target by dragging the white cropping marquee to the four corners of the target.

Digtal ColorChecker® 5G IE‘I
Example... | Fieszet | Ok I Cancel

Figure 11-4: Target image that has to be cropped

Carefully crop it, using the mouse with a cross hair cursor and
the [&], Better to crop a bit tight than to include white surround-
ing space. You may even crop into the target area, if the image
shows a perspective view.

j—y
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7. Compare your target image with the image of the reference
target. If their orientation and pattern of patches are the same,
proceed.

8. From the drop-down menu Photo Task select the type of picture
you took, and then from the drop-down menu Light Source
select the type of lighting condition used for shooting.

9. The Options found in the dialog box with Photo Task Options let
you tweak your profile for special lighting and color conditions.

Ly ProfileMaker =101 =]
File Edit Language Help i
Photo Task Options ) x|

The Photo Tazk Options give you the possibility to influence the style of pour
digital camera profile.

Photo Tazk !‘ ﬂ

Custom

Gray Balance | Ewposure Compenzation ] Saturation ahd Contrast | Spot Colors ]

Gray Balance

' Use camera gray balance
" Meutralize graps automatically

“our camera kestchart shot iz well gray balanced. The option 'Uze camera
gray balance' iz suggested.

¥ Meutralize tones near the gray awis

weak ztrong [%

4 I Cancel |

Figure 11-5: Several options allow to adapt your camera profile to specific needs

These should be used only if you have prior experience in profiling.



10. Clicking Start initiates the generation of the profile. You may see

1.

some messages, advising that the image is over- or underex-
posed. Ignore them.

Provide a descriptive name for the profile, naming the camera
and lighting conditions, (e.g. Nikon-Dyo_Studio_D50).

That’s it! This profile may be used as a camera ICC profile with C1
or RSE or may be assigned to a converted image using
Photoshop.

If your RAW converter does not support custom camera profiles,
you should consider converting your RAW files without doing
much color correction with the converter. Apply the generated
profile to your converted TIFF or JPEG file using Photoshop:

Open the converted image with Photoshop, avoiding any profile
conversion while opening.

Select Image»Mode»Assign Profile from the menu (PS 9):
Edit»Assign Profile). From the drop-down menu of pro-
files, select the camera custom profile you generated using
ProfileMaker for lighting conditions used for the shooting.

Assign Profile
(;ssign Profile:
Dor't Color Manage This Docurnent
O Working RGB:  Adobe RGE (1998) < Figure 11-6:
& profie: | MikonD70_studio D50 - [¥] Preview Assign your camera

profile in Photoshop

If you checked Preview in your Assign Profile dialog box, you will
see the effect of the selected camera profile even before you
click OK. Clicking OK will perform assignment of the camera pro-
file.

11-7
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11.3 Camera profiling using InCamera.

InCamera is a Photoshop plugin allowing users to create camera
profiles. We recommend InCamera mainly for studio profiles in
which you control the light consistently.

1. Convert your RAW file with a RAW converter (e.g. RSE) in the mode
required for creation of camera profiles (see the documentation)

2. Open the converted file into Photoshop (do not color manage).

x
' The docurment *1ds2_5001_0329-RSE.tif* does not have an embedded RGE
profie,
what would you like to do?
(* Leave as is (don't color manage) 4 Flgul'e 11-7:
 Assign working RGE: Adobe RGB (1998)
: Ignore Color
O Assign profile: | adohe RGB (1993) j
™| and| then convert: document ta working RGE Management for
this image (at the

—=e | fime beeing).

3. Runthe InCamera plug-in and adjust the grid to match the target.

x

Chart Type:
ColorChecker®3G 4|

D ata Reference File... |

Digital ColorChecker SG.tst

Light Source:

o m D55 D aylight (5500] =]
NN W ST
-Dl_"]. ]DDD_Ii'DD
| N 1

=
D [T Show Samples
I~ lanore Glossy

[~ Brighter
[T Use Largest Window

Check Capture...

Figure 11-8: Adjust the grid to match the target in InCamera.



4. Click on Check Capture.

InCamera lets you check for even lighting of your target.

Owverlay:
INDne LI
~MHoize
Overall Wiorz
R: OB i,
G: 0B 1.5%
B: 0OE 1.61°
Std Dew. 0.0t 1.0
Std Dew. 1.0t 2.5
* 5Std Dew. 25t 5.0
® Std Dew. more than 5.0

- Lighting Unifarmity

Owerall Error: 4.5
Diarkest: -11.4
Lightest: 742

O Darker than Chart Center
[0 Same az Chart Center
O Lighter than Chart Center

(1] I

Figure 11-9: Check for even lighting

As mentioned before. Providing good even lighting is an art. A

good profile depends on shooting good target shots.

5. Now, you just click OK and InCamera will save a ready-to-use

camera profile.

p—ry
1
O
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11.4 Shooting for a neutral gray

When shooting in abnormal lighting conditions, often the case
when shooting outdoors or outside a controlled studio with well
controlled lights, an ICC camera profile is of little use. However, there
are some ways to work around this problem. One reason for profil-
ing is to achieve a correct white balance (not always what you want,
e.g. when setting up soft or colored lights within a studio to achieve
an intentional special mood). In this situation, there is an easy and
universal solution, though possibly not achieving the same exact
colors that may be accomplished using a camera profile:

Shoot a color checker or gray card with right along your subject. Use
its neutral gray patches as the reference point for your white bal-
ance. If you shoot a series of pictures with the same lightning condi-
tions, include the color checker in only the first shot. Then apply the
white balance of this image to all the other images of your session -
so long as lighting conditions do not change.

< Figure 11-10:
Shoot a color reference
or a gray card with
your first image.

There are many gray cards and color checkers available, however
not all provide a truly neutral gray patch. In our experience, Mini
ColorChecker by GretagMacbeth is quite good - though not cheap
(about 60-75 US dollars).

To utilize the patches of a gray card or ColorChecker for white bal-
ancing, follow these steps:

1. Open the image (see cropped view) with your RAW converter,
e.g. ACR, and activate the tab for the white balance.

2. Pick up the eyedropper (A& B [B[2]2]%] and select the
gray patch on your color checker (with MiniColorChecker by



GretagMacbeth, it is the second patch from the left in the bot-
tom line - see figure 11-10).

This sets your white balance, which should be nearly neutral by
now. If you save this setting and apply it to the other pictures taken
with the same lighting conditions, you should get good white bal-
anced result for all of them.

11.5 Calibrating Adobe Camera Raw

While Adobe Camera Raw does not support custom camera profiles,
it does provide controls and settings for special color corrections.
This allows you to basically build special profiles (at least something
resembling custom profiles) for your camera. If your camera tends to
over-saturate red or cyan, for example — more than other cameras of
the same make and model - you might correct this in one image,
then make it the default color setting for the camera.

We recommend against using these settings to correct individual
shots, but to use only as a generic correction for a specific camera.
You may, however, use different settings for different light condi-
tions.

11-1

These setting are located within the ACR tab Calibrate.

11.5 Calibrating Adobe Camera Raw B

Use these sliders with care and settings: " custom #)-®
watch closely their visible | Adjust | Detail § Lens ] Curve | Calibrate
effect in the preview window.
Use a correctly-exposed pic-
ture to do the calibration. It Shadow Tint 43
should show some neutral = =
light gray areas where color- ke =
cast are easily detected. Set Red Saturation [s
several measure points with the - :
## eyedropper in these areas S N
and try to obtain equal RGB Green Saturation s
values there:

Camera Profile: = ACR 2.4 ﬂ

Blue Hue -+5

#l R 165 Blue Saturation B
G: 167 &
#* B: 165

Figure 11-11: Profiling with Calibrate
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You may use these calibration settings as new camera defaults. ACR
will use them for only a specific camera make and model - includ-

ing all cameras of this type. To use as camera defaults, save the set-
ting via Save New Camera Raw Defaults in the save setting menu:

Settings: -image Settings m @
Load Settings...
Save Settings...
Save Settings Subset...

Export Settings

v Use Auto Adjustments #U )
< Figure 11-12:

Save New Camera Raw Defaults Save your current

Reset Camera Raw Defaults .
settings as new

Preferences... £ camera defaults.

Alternatively, you may save settings as a special file to be loaded
again, in which case you should probably save the Calibrate settings
as a subset (Save Settings Subset» Calibration). Adobe stores the set-
tings as .xmp files.

The default folder for thatis " Save Settings Subset "
C\ Docun7ent.s and Settings\ o B G
user\Application Data\ - —

X ite Balance { Cancel
Adobe\Camera Raw\Settings Exposure o

Shadows

(or Mac: user/Library/
Application Support/Adobe/
/Camera Raw/Settings).

If you stay with that
folder, these settings will be
listed in the ACR Image

Brightness

Contrast

Saturation

Sharpness
Luminance Smoothing

Color Noise Reduction

Settings drop-down menu ) chromatic Aberration

and may be recalled with- =3 ¥ neing

minimum navigating. ] Tone Curve
Going a step further, ™ catibration

instead of a good gray color

balance, you may read out  Figure 11-13: ACR allows to selectively save
the color values on your your settings

target using a

spectrophotometer (e.g. Eye-One Pro), set some color checkpoints
with the ACR eyedropper ¥# at the color patches.



If you have no spectrophotometer, use the patch-values mea-
sured with our Mini-ColorChecker (see figure 11-14).

Lab: Lab: Lab:
39/13/14 66/18/18 43/-13/23
3{(€]:H RGB: RGB:
109/84/72 185/147/129 95/107/67

Lab: Lab:
38/9/-43 30/19/-20
RGB: RGB:
73/88/156 82/63/101

Lab: Lab: Lab: 1113

29/16/-50 41/53/29 81/5/80
RGB: RGB: R GB:
53/65/144 152/50/56 226/194/49

Lab: Lab:
36/0/0 21/0/0
RGB: RGB:
85/85/85 54/54/54

GretagMacbeth™ ColorChecker Color Rendition Chart

Figure 11-14: Gretag MiniColorChecker with the rounded Lab (L) and RGB (R) (Adobe RGB)
patch color values

11.4 Shooting for a neutral gray B

Try tuning the calibration settings, so that the readouts achieve tar-
get color values of the various patches. This must be done itera-
tively, since changing one color will change other colors, as well and
things can get tedious. Don't attempt matching all patches, rather
focus on the three or four patch colors important to you, (e.g. skin
colored patches or perhaps the blues). Remember that RGB values
are color space dependent! Those RGB values given in the image
shown are those or Adobe RGB (1989).

Results you achieve using this method are generally better than
merely setting a neutral white/gray balance.



14

11

B J91J9AUOD MVYH INOA 104 bunieiqied pue buijiyoid :| | 191deyd



Chapter 12
Creating B&W photos from color
images

Camera: Canon 1DS

12.1 Turn color images into Black & White

When everybody is shooting in color, Black &White Photography
may seem a dying art. We, however, are convinced, that for some
scenes and some shooting, B&W is still sensible, sometimes even
superior. With B&W, the photographer, as well as the viewer, has to

N
-

Creating B&W photos from color images ®
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concentrate on shapes and contrast. B& W permits reducing the
message to the most essential parts of the picture while drawing
attention to those parts - you have to go for a strong abstraction
with your photograph. Though some digital cameras allow shooting
in B&W, we recommend shooting in color and do the reduction to
B&W either in the RAW converter or in Photoshop (or similar image
editor). Thus, converting color images to B&W has great potential.
Still, merely converting an image from RGB mode to grayscale mode
does not (in most cases) do the trick. This method usually results in a
flat picture without high impact.

Shooting with B& W film has a long and well-established tradi-
tion, so, let us have a glance at what a workflow with B&W film
looks like then compare to steps used with digital B& W processing.

B & W with Digital Camera and

Al Photoshop
Real world in color Real world in color
Camera Filter Digital color image
(red, orange, yellow, green, ...) (TIFF or JPEG from your RAW
converter)
B&W film spectral sensitivity Photo Filters in Photoshop
Developer B &W Channel Mixer in PS

All techniques about contrast,
Negative brightness,
shadows and highlights

B&W print Dodge and burn in Photoshop
(paper grades, — -
dodge and burn) Digital B&W print

Figure 12-1: Similarities and differences between B&W film
and B&W digital images

Setting up our digital B&W workflow, we want to come as close as
possible to the simulation of these classic B&W techniques.



12.2 B &W workflow with ACR, Capture One and
RawShooter

When looking into B&W, we love the power of abstraction that
B&W provides. But we might not be alone in the observation that
working in color (have a look at our color work at [5]) and B&W
requires very different thinking and, more importantly, a different
feeling.

In fact, during the process of creating effective B&W photos we
can get distracted by any color we see (especially of the same
photo). What we want to do is think in B&W only.

Color conversion techniques

There are endless methods of conversion color to B&W, and most
are based on Photoshop:

» Channel Mixer (full Photoshop only, not in Elements)
» Hue/Saturation desaturated
» Photoshop plug-ins

» Converting to grayscale in the RAW converter (Adobe Camera
Raw, Capture One DSLR)

Probably nothing beats the power of all these techniques, but all
require switching from color to B&W and, thus, detract from our
pure B&W viewing process.

We have developed a pure B&W workflow with ACR, Capture
One and RawShooter. This includes even thumbnails and previews
in B&W.

N
w
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Canol

B & W with ACR

n EOS 10D: 10d_0000__0078.CRW (IS0 100, 1/320, £/9.0, 90 mm)

@@%’ P A DO e W S | i B @ B

|

Settings: | Custom |-
Adjust
wihite Balance: |as Shat ElS
Temperature 5800
3
Tint +4
-
Expostre I~ Auto +0.20
=

Shadaws I~ Adta 4

2

Brightness ™ Auto &l

- -

Cantrast [~ Auta +25

. o

Saturation

-
¥ Show Warkflow Options
Space: |Adobe RGE (1998) = Size: [3072 by 2048 (6.3 MP) = e | e |
Depth: |& Bits/Channel hd Resolution: |240 pixelsiinch P ’TI e |

Figure 12-2: Setting Saturation to zero will display your images in Black & White.

Creating B&W images with ACR is pretty easy. Just set saturation to

zero. You than can manipulate tonality using:

» White balance (WB)
» Calibration data

Once you have a file converted and open in Photoshop CS, change

its mode to “Grayscale” and open the Shadow/Highlight tool.




Shadow/Highlight ] x|

— Shadaows oK I

Arnount: | 23 %
Cancel |

Tonal width: [28 o Load.. |

Save.., |

Radius:

v Preview
— M

— Highlights
Arnount:
—

Tonal width:

Radius:
—

— Adjustrnents

Brightress:

Midtone Contrast:

- | Black dlip: ID % White Clip: ID %
| Save As Default] EI

" | Show More Options

Figure 12-3: You may optimize your image using Photoshop’s
Shadow/Highlight function.

Shadow/Highlight provides the ultimate control for tweaking your
B &W tonality. For grayscale images the “Color Correction” slider
turns into a “Brightness” slider. It is all there:

Open up shadows

Tone down highlights
Enhance mid-tone contrast
Optimize brightness

v v v Vv

B & W thumbnails and previews

Then, apply saturation settings to all the pictures you want to con-
vert to B&W, and even thumbnails and preview images show up in
B&W:

e
wn
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e e el R 4

7 ] o [

=

IR T

Figure 12-4: Full B& W view

Note: Use the option “Sidecar xmp files.” Otherwise, any other color

images with the same name might turn gray, too.

Camera Raw Preferences

Save image seftings in: | Sidecar " «mp” files j | 0K I

Apply gharpening to:

< Figure 12-5:
Set your
preferences
for yourimage
settings.

For this setup of ACR, use (while Extended is activated) the triangle

pull down menu Settings » Preferences.

Settings: ICamera Raw Defaulks j —(0 L) s o
Save Setkings...

Save Settings Subset,
Delete Current Settings

Expork Settings

v Lse Auto Adjustments

Sawe ew Camera Raw Defaults
Reset Camera Raw Defaulks

< Figure 12-6:

You may save your
ACR settings as new
camera defaults.



B &W with Capture One DSLR

We recall that Capture One DSLR (Capture One) allows displaying
images in grayscale, by activating the & button (top right). This is
acceptable, but not real exciting.

i ~I0fx|
e S e R I 1N o e —|
e U S GIOON

3

Capture One PRO - (17/119) 1D5_0000_1078.TIF [ C1_BWS -> Adobe RGB (1998) ]
File Workflom Collection View Help

o o
28

] X @R

Levels | Cuve |

| Process [ Focus| Exposure Wihite Balance | Capture

-4

) %

2 Pressrve color balance ¥
Flaw AIGE Desfinalion

&

s fiss
i fiss
fito fiss

OWE OB DG oo e
[ A 20050203 1ds_Orchards |  20050207_1ds_Pebble_Beach | # 20050207_1ds2_Pebble_Beach

76| Generating previews..

Figure 12-7: Capture One in grayscale display mode (click W for this)

Capture One can also convert to grayscale on output.

o

<= | Color Management warkflow:

=

= |Ennvert to Generic Grayscale |
Batch Editar

2+ XEE - < Figure 12-8:
Capture One provides a generic
grayscale profile.

12-7
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This creates a grayscale image with a gamma of 2.2. However, we
like to view a B&W image in RGB mode instead. An RGB image
allows further optimization within Photoshop.

The solution is to create a new profile converting to B&W. This
can be done with the profile editor of Capture One DSLR Pro by
desaturating colors. Unfortunately, Capture One only allows
desaturating by 30 % in a single step. We needed to repeat this pro-
cess a couple of times to come up with a first B& W profile which
we share with our readers (see [6]).

At this point, we are close to our goal of a 100 % B & W workflow:

1. Select the new B&W profile as default for your camera

Color Management Settings ]

Camera Product:

| Canon E05-1Ds

Camera profile:
\C1_Ew3 d

|_. Only showe Phaze One camera profiles

.__- "-:7’."' Cutput destination [wWorking Space]:
| |Adobe RGB 193] -
| Wweh destination

. |sRGBIECEI386-2.1 -

Proof destination

| |Adobe RGE (139) =
¢ Monitar profile:
| |Aisan_DE5_2216123285 -

& o v Unlack Moritar prafile zelection memnL

< Figure 12-9:

0 Windows Monitor profile: You may select a B&W
4| Adisan_DE5_2216123265 profile as the default

! profile for your camera
in Capture One DSLR.

This has an amazing side effect ... thumbnails display in B&W.

2. The Exposure, Contrast, Levels and Curves tools in Capture One
are very good in controlling B&W contrast and brightness.


http://www.outbackphoto.com/artofraw/raw_08/profile_BW.zip

< Figure 12-10:

Use the Capture One tools
Exposure, Contrast and Curve to
adjust your B&W image to your
aesthetic liking.

3. The techniques in Photoshop (Channel Mixer) allow you to filter
the color image to get a better B& W rendering. Here we can
(mis)use the WB control in Capture One.

< Figure 12-11:

You may use the B&W control of
Capture One to control the look
of the B&W image (which is still
a colorimage.)

»
©

12.2 B&W workflow with ACR, Capture One and RawShooter B



All three controls (Temperature, Tone Balance and especially Color
Cast) have an influence on the B&W conversion (settings may also
be saved).

In addition, Color Saturation can be used to alter B& W render-
ing. You can even try messing with the single RGB channels in
Levels (Unfortunately, Curves in Capture One doesn’t allow this yet).

5,
L e

Figure 12-12: 300D photo converted in Capture One

Working in color and Black&White

If you choose to work in B&W and color, use of Capture One allows
you to have only one type of settings and previews in your cache.

We installed Capture One a second time in a different folder to
ensure that the cache is not shared (by default). You needn’t go
through a licensing hassle by copying the *.lic file from the old
installation root to the new installation root.

Sample

We want the B& W photo to not be overly contrasty in Capture One.
Later we will open the file in Photoshop and apply some initial mild



sharpening (applied as a layer ([10]) — it allows us to improve the
sharpening later on).

Next, in Photoshop x
tyveak the black and - chamel:[ReE =] o
(if necessary) the putLevels: [@@  [119 [255 =

white pointin an

Adjustment Layer to Hep |
get the final B&W =

snap. By doing this, we
can tweak the bright-
ness and contrast later.

=

Out|:|utLeuels:ulmﬂ—IH |f F|F

| maE—
- = IV Preview 12-11

Figure 12-13: Use a Levels adjustment layer to
tweak the white point of your image.

12.2 B&W workflow with ACR, Capture One and RawShooter B

Figure 12-14: 300D converted with Capture One

Finally, the image gets saved as a PSD file. ImagePrint 5.6 (see [11])
will open PSD files and print using a custom ImagePrint gray profile.


http://www.outbackphoto.com/workflow/wf_19/essay.html
http://www.outbackphoto.com/printinginsights/pi015/pi015.html

B & W with Raw Shooter

B & W also works well using RawShooter. With it you can use both
techniques from ACR (setting saturation to zero) or Capture One
(using a B&W profile). Most often, setting saturation to zero seems
to be most convenient. You can even have different color and B&W
Snapshot settings in RawShooter.

Especially the Fill Light, Shadow contrast and Highlight
contrast sliders aid in optimizing the tonality of your B&W pictures.
Hard contrast, sometimes very disturbing in color photos, looks
fine in B&W. We frequently use stronger positive settings for

Shadow and Highlight contrast.
12-12

il
@- M-0 =R

. Conect | Batchconwet]

B S®@L- v

Color Temperature

12500
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Appearance | Flat look v
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Db Erow Eo e O
] 46
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o B81,1440. e 007 107, 107 |

|
Current image: 350d_0000_0281,CR2 3= ([ 26.00% B - M A |
Canon EOS DIGITAL REBEL KT 50mm, f 9.0, 1/200 sec., 150 100 + Ba -84 s |

Figure 12-15: B& W in RawShooter




Glossary/Abbreviations

AA filter - Anti-Aliasing Filter used in digital
cameras to spread incoming light slightly
so that small points of white light will be
recorded by more than one sensor element.

aberration - With digital photographs,
there are two types of aberrations:

(1) chromatic aberrations. These are caused
by the fact that a lens refracts light differen-
tially as a function of its wavelength (color).
Good lenses compensate largely in that by
combining several lens elements. Such a
lens is called an‘achromatic lens’ Chromatic
aberrations (CA for short) usually show up
as purple/green fringes that are more visi-
ble at the edges of an image. Good RAW
converters offer a tool to reduce chromatic
aberrations.

(2) spherical aberrations. Results in some
blurin an image.

absolute colorimetric - See rendering intent.
ACR - see Adobe Camera Raw.

Adobe RGB (1998) - A color space defined
by Adobe. It is well-suited for digital photo-
graphs and has a reasonably wide gamut,
larger than sRGB, and includes most print-
able colors.

Adobe Camera Raw (ACR) - This is the RAW
converter provided as a plug-in by Adobe
as part of Photoshop CS1and CSa.
Photoshop CS1 (aka Photoshop 8) ships
with ACR 2.x while Photoshop CS2 (aka
Photoshop 9) has ACR 3.x. Photoshop
Elements 3 provides a slightly stripped ACR
2.x interface.

artefacts (or artifacts) - An undesirable
effect visible when an image is printed or
displayed, such as moiré patterns, banding
or compression artefacts. Compression
artefacts (JPEG artefacts) may result from
too severe JPEG compression. Also over-
sharpening may produce artefacts.

banding - Noticeable tonal level jumps in
an area, where a continuous tone level
would normally be. Banding is one type of
artefact.

Bayer pattern -
An array of color
filters placed in
front of camera
sensors that
allow the camera
to capture color infor-

mation although those sensor elements
can only record brightness. The Bayern pat-
tern, in most cases, consists of a matrix of
tiny green, red and blue filter elements. The
Bayer pattern algorithm (there are several
others) interpolates from individual gray
levels RGB colors for each pixel of an image.

blooming - An effect occuring when a CCD
cell of a camera sensor receives too much
light. Its electronic charge transfers to the
next cell thus producing an undesired
‘blooming’ effect. Blooming is most visible
at the edges of high contrast and highly
saturated colors.

black point - The density (or color) of the
darkest black a device may reproduce.

>
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Black levels beyond that are clipped to the
black point.

C1. Capture One DSLR by Phase One ([36]).
As there is a trademark issue with C1, Phase
One no longer uses this abbreviation, but
instead uses “CO"

CA . Chromatic Aberration. See aberration.

calibration - Adjusting the behavior of a
device to a pre-defined state. Calibration, in
many cases, is the first step when profiling a
device.

camera RAW format - See RAW.

candela - Unit of measurement for luminos-
ity. Luminosity is specified in candela per
square meter (cd/m?).

CCD - Charged Coupled Device, an electronic
element that accumulates an electronic
charge depending upon the amount of
light (photons) perceived by the element.
The photographic sensors of most present-
day digital cameras consists of a matrix of
CCDs. An alternative technique used as
camera sensors are CMOS-based sensors.

cd - See candela.

CF - Compact Flash — a type of data storage
used in memory cards for digital cameras.

CIE - Commission Internationale de I'Eclairage.
This is the international scientific organiza-
tion which defined the CIE Lab standard.

CIE LAB - See Lab.
characterization - See profiling.

CMM . Color Matching Module - the internal
color engine of a color management sys-
tem. It does the color translation from dif-
ferent (source) color spaces to the PCS
(Profile Connection Space), and from the PCS

to the output color space. Well known
CMMs are Apple’s ColorSync for the Mac and
Microsoft’s ICM as an integral part of
Windows. Adobe provides its own CMM
module with applications, such as
Photoshop and InDesign. It’s called ACE
(Adobe Color Engine).

CMS - Color Management System.

CMYK - A color model based on the four
primary printing colors cyan, magenta, yel-
low and black (Black is also called the key
color). Used in print production, they form a
subtractive color model. Though many
inkjet printers use CMYK inks (and often
other additional colors), they, in fact, pres-
ent an RGB interface to the user.

CRT - Cathode Ray Tube - a component in
monitors utilizing glass tubes for display.

clipping - The loss of certain tonal values
usually found in the color or tonal limits of
a color space. Clipping occurs, for example,
when converting images from 16-bit-mode
to 8-bit or when converting from RGB to
CMYK. In these cases, usually some satu-
rated colors are clipped to become less sat-
urated colors.

color gamut - See gamut.

colorimeter - An instrument used to mea-
sure the color of emitted light. Often one is
used in profiling monitors.

color model - The way colors are described
by numbers. RGB, for example, uses a triple,
denoting the amount of red, green and
blue. CMYK uses a quadruple for the per-
centage of cyan, magenta, yellow and
black. There exist other colors models, such
as Lab, HSM, Grayscale (a gray value) or
Bitmap (with pixel values of o or 1 - white
or black respectively).



color space - A range of colors available for
a particular profile or color model. When an
image resides in a particular color space,
this limits the range of colors available to
that image. It also defines how the color
values of an image are to be interpreted.
There are device-dependant color spaces
(e.g. that of a scanner or printer) and
device-independent color spaces (e.g. Lab,
Adobe RGB (1998) or sRGB).

ColorSync - Apple’s implementation of ICC-
based color management (part of Mac OS 9
as well as Mac OS X).

color wheel - A circular
diagram displaying the
available color spectrum
(at a particular bright-
ness level).

color temperature - A measure on the
spectrum of the wavelength of white
(light). The unit used is Kelvin (K). Lower
color temperatures correspond to a red or
yellowish light, higher temperatures result
in a bluish tint. The term ‘temperature’
stems from a‘blackbody radiator’ emitting
(white) light when heated to a specific color
temperature Here are some examples:

candle light, fire 1000-1800 K 0

tungsten 2600-2700 K
halogen lamp 3400 K
moonlight 4100 K
Dso daylight illuminant 5000 K
sunny and blue sky 5800 K
D65 daylight illuminant 6500 K
flash 6500 K
cloudy sky 7000-8000 K
neon light 8000-9000 K

sunny mountain snow

up to 16000 K -

chroma - The technical term for saturation.

curves « A tool in Photoshop that allows
control (change) of tonal values in an
image. The curve diagram below represents
the relationship between input and output.
By modifying this curve, corresponding
tonal values of the pixels in the image are
changed.

CS1, CS2 - Adobe Creative Suite 1 & 2. The
full suite includes Photoshop, InDesign,
Illustrator, GoLive and Version Cue. The
Premium suite includes Acrobat. CS2 also
includes Bridge.

Dso - Daylight at 5000 Kelvin. This is the
standard light (illuminant) in the printing
industry (prepress) for evaluating colored
prints.

D65 - Daylight at 6 500 Kelvin. This is the
standard (illuminant) that is closer to the
light emitted by CRT or LCD monitors.

device profile - See ICC profile.

dithering - A technique used to simulate
many different colors and/or halftones yet
utilizing only a few primary colors by plac-
ing dots in a certain pattern. Viewed from
an appropriate distance, the image is per-
ceived as a continuous tone image.

dot gain - Halftone dots grow slightly in
size when printed (e.g. due to ink spread-

>
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ing). This is called dot gain. Coated paper
has a dot gain of 8-20 %, while with
uncoated paper it may grow up to 28 %.
Photoshop may take dot gain into account
when producing output for printers by
reducing a dot size appropriately to com-
pensate for its future dot gain.

dpi, DPI - dots per inch. Used as a measure-
ment of print resolution in regard to ink or
toner dots per inch on paper or printing
plates. Most printing techniques (e.g. inkjet
printers or offset presses) simulate a half-
tone value or a non-primary color of a pixel
using a pattern of tiny dots. With such
printing techniques, the dpi value of a
printing device must be considerably
higher (by a factor of 4 to 8) than the ppi
(pixel per inch) value of the image.

DSLR - Digital Single-Lens Reflex — a stan-
dard type of professional and semi-profes-
sional digital camera.

ECI - European Color Initiative. This organi-
zation focuses on defining standardized
means to exchange colors (color images)
on the basis of ICC profiles. You may find
some specific color profiles at their Internet
home page (see www.eci.org).

ECI-RGB - An RGB work space for those
images destined for prepress work in
Europe. Its gamut is somewhat wider
(slightly more green tints) than that of
Adobe RGB (1998) and also covers nearly all
colors intended to be printed.

EPS - Encapsulated PostScript. A standard
file format for graphics, usually those
including vector graphics or a mix of vector
graphics and bitmap images. Often, EPS
files contain both the actual graphic infor-
mation and additionally a preview image of
that graphic.

EV - Exposure Value.

Exif, EXIF - A standardized format for cam-
era metadata (e.g. camera model, exposure
value, focal length, ...). This data is usually
embedded in the image file and may be
used for searching, as well as, by applica-
tions to act in an intelligent way on the
data. PTLens, one example, uses the focal
length value from EXIF data to correct lens
distortions.

Firewire « (IEEE 1394) a fast, serial interface
for cardreaders, digital cameras, scanners
and other peripheral devices. Firewire
allows for transfer rates of up to 40 MByte/s
(1394a) or 80 MByte/s (1394b).

gamma - (1) Relationship between tonal
values (or input voltage with a monitor)
and perceived brightness. There are two
gamma values in broad use:

(A) 1.8, the Apple standard for the Mac and
preferred in prepress work.

(B) 2.2, the Windows standard. For photo-
graphs, we recommend using 2.2, (even on
Macintosh systems) when it comes to mon-
itor calibration and profiling.

(2) The degree to which a color space or
device is non-linear in tonal behavior.

gamut - The total range of colors (and den-
sities) a device can reproduce (e.g. a moni-
tor or printer) or capture (e.g. a scanner or
digital camera). Color gamut is the range of
colors a device can reproduce (or capture)
and dynamic range refers to the brightness
levels a device can produce or capture.

gamut mapping - The way colors are
remapped when an image is converted
from one color space to another. If the des-
tination space is smaller than the source
space, color compression or color clipping
will be take place.


http://www.eci.org

gray balanced « A color space is called gray
balanced if equal values of the primary col-

ors result in a neutral gray value. This situa-
tion is preferable for work spaces.

highlights - Areas of an image with no
color or gray level at all.

histogram « A visual representation of tonal
levels in an image. With color images, it is
advantageous not only to see luminance
levels but also tonal levels of each individ-
ual color channel:

HSB, HSL - Adaptions of the RGB color
model. Colors are described by a hue, satu-
ration of the hue and lightness (HSL) or
brightness (HSB).

hue - Hue is normally referred to as color
tint.

ICC - International Color Consortium. A con-
sortium of companies that develop indus-
try-wide standards for color management
- e.g.ICC profiles. For more information see
www.color.org.

ICC profile - A standardized data format to
describe the color behavior of a specific
device. ICC profiles are the basis of color
management systems. They allows CM sys-
tems to maintain consistent color impres-
sion across different devices, different plat-
forms and throughout a complete
color-managed workflow.

ICM - Image Color Management or
Integrated Color Management — the
Microsoft implementation of the color man-
agement module in Windows.

intent - See rendering intent.

IT-8 - A family of standard targets used by
profiling devices such as scanners or digital
cameras.

IPTC - International Press Telecommunication
Council. In photography, IPTC is a metadata
format describing the image. It provides
fields, e.g. for copyright notices, rights
usage terms, a title (caption) and keywords.

JPEG - Joint Photographic Experts Group.
This ISO group defines a file format stan-
dard for color images. The JPEG format uses
lossy compression, offering various trade-
offs between high quality (at lower com-
pression) and lower quality resulting in a
higher compression but smaller files.

Lab, LAB, L*a*b*, CIE LAB - A perceptual-
based color model defined by the CIE.
Colors in this model are defined by L
(Luminance) and two color components, a
and b.‘a’ (or‘A’) is the axis ranging from red
to green while ‘b’ (or ‘B’) ranges from blue to
yellow.

LCD - Liquid Crystal Display. A display tech-
nique used with flat panel monitors (TFT
monitors).

Ipi, LPI - Lines per Inch. The measure used to
define printing resolution (or screen fre-
quency) with typical halftone printing
methods, such as, offset printing.

luminance - Amount of light (energy) emit-
ted by a light source, e.g. by a monitor. The
unit used with monitors is candela per
square meter (cd/m?).
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metadata - Data describing other data
objects. EXIF and ITPC data are examples of
metadata as part of digital photographs.

PCS - Profile Connection Space. This is an
intermediate color space used when con-
verting colors from a source space to a des-
tination space (say, from one profile to
another). According to the ICC specification
it can be either CIE-Lab or CIEXYZ.

perceptual intent - See intent.

PNG - Portable Network Graphics. A flexible
image file format, providing indexed color
for up to 8-bits per channel and also allow-
ing transparency. This format, however, is
not as flexible as TIFF.

ppi, PPI - pixel per inch, used to specify the
resolution of a digital image. See also dpi.

primary colors - Those colors of a color
model used to construct the colors of the
pixels. For RGB the primary colors are red,
green and blue. CMYK primaries are cyan,
magenta, yellow and black.

profile - See ICC profile.

profiling - The act of creating a device pro-
file. Usually a two-step process, whereby
the first step is to linearize the device. The
second step measures the color behavior of
the device and describes it with an ICC pro-
file. The entire process is also called charac-
terization.

PS - Photoshop.
RAW (camera RAW format) - See ICC profile.
Relative colorimetric - See rendering intent.

rendering intent - A strategy to achieve
color space mapping when converting col-
ors from a source to a destination color

space. ICC has defined four different stan-
dard intents:

(1) Perceptual compresses colors of the
source space to the gamut of the destina-
tion space (where the source space is
smaller than the destination space). This is
the intent recommended for photographs.
(2) Relative colorimetric does a 1:1 mapping
when the colors in the source space are all
present in the destination space. Out-of-
gamut colors of the source are mapped
(clipped) to the nearest neighbor of the
destination space. This intent may be used
for photographs if most of the colors in the
source space are available in the destina-
tion space. In this case, most colors of the
source are mapped 1:1into the destination.
The white point of the source space also is
mapped to the white point of the destina-
tion space.

(3) Absolute colorimetric does a 1:1 mapping
when colors in the source space are present
in the destination space. Out-of-gamut col-
ors of the source are mapped (clipped) to
the nearest neighbor of the destination
space. The white point of the source is main-
tained. This intent is used (only) for soft
proofing.

(4) Saturation. This intent aims to maintain
saturation of a source color, even when the
actual color has shifted during the mapping.
This intent may be used when mapping
logos and diagrams, but is not suitable for
photographs.

resolution « This term defines the depth of
detail that an image can reproduce.
Resolution is measured in dots per inch
(dpi) or pixels per inch (ppi).

RGB - Red, Green, Blue. These are the pri-
mary colors of the standard additive color
model. Keep your photographs in RGB!



mode as long as possible and use RGB for
archiving your images.

RIP - Raster Image Processor. A module,
either part of a printer or a software appli-
cation. The RIP converts page information
into a raster image or dot pattern for print-

ing.
RS, RSE - RawShooter Essential - a free
good RAW converter by Pixmatec ([35]).

saturation - (1) defines the purity of color.
Saturation may vary from none (which is
gray) via pastel colors (some saturation) to
pure colors (full saturation) with no gray.
(2) One of the four rendering intents. See
rendering intents.

spectrophotometer - An instrument to
measure the color of emitted and reflected
light. It usually is used for profiling printers
and measuring the color (light spectrum) of
a print or other surface.

soft proof - Usage of the monitor as a proof-
ing device. For soft proofing Photoshop
simulates the colors a picture will have on a
different output method (e.g. a print) on
the monitor.

SRGB « A standard color space for monitors.
It is intended for images presented on
monitors or in the Internet.

tagged images - Images with embedded
color profile.

TIFF - Tagged Image File Format. A file for-
mat for images. TIFF acts as an envelope
format for a lot of different image formats
and allows several different compression
modes — most of them lossless (e.g. LZW,
ZIP, Runlength encoding, uncompressed). It
allows to store different color depths (from
110 32 bit per channel), embed comments,

profiles, and other metadata as well as lay-
ers and alpha channels. It is well suited as
an archival format for images.

USB - Universal Serial Bus. A computer
device interface for peripherals such as card
readers, cameras, scanner or external disks.
There are two version of the USB bus, where
USB 2 (high speed) is much faster (up to

60 MByte/s)than USB 1.x (up to 1.2 MByte/s).

USM - Unsharp Masking. A method of
sharpening an image by increasing the con-
trast of edge pixels. The term stems from a
traditional film-composing technique.

vignetting - Vignetting is an effect where
some areas of a photograph are less illumi-
nated that others. Most camera lenses
exhibit “optical vignetting” to some degree
- mostly at the outer edges but stronger
when an aperture is wide open.
“Mechanical vignetting” may occur, if a lens
hood is too small or not properly attached.

slight vignetting very strong vignetting

wide gamut RGB - A large color space that
covers almost all of RGB. There is no physi-
cal device that can reproduce all color of
wide gamut. This color space is sometimes
used for archival purposes, if output shall
be produced for photographic printers or
transparent recorders.

white balance - Adjusting the color tem-
perature and color tints in an image, so that
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there is no color cast and gray areas show
no color tint.

white point - (1) The color of ‘pure white’in
an image. On a monitor, it is the brightest
white the monitor can display. In photo
prints, it usually is defined as the color of
the blank paper.

(2) The color of a light source or lighting
conditions in terms of color temperature.
(3) The color “white”in a color space. For
example Adobe RGB (1998) and sRGB have a
white point of 6 500 K (D65) while ECI-RGB,
Color Match RGB and Wide Gamut RGB have
a white point of 5000 K (D50). Most CMYK
color spaces have a white point of D5o.

white point adaption - When a color map-
ping has to take place and the source and
the destination spaces have different white
points, with some intents (e.g. Relative colo-
rimetric) colors are adapted relative to the
new white point.

working space - A device-independent
color space (profile). It defines the color
gamut available to the image using this
working space. For photographers Adobe
RGB (1998) or ECI-RGB (in Europe) are the
working spaces recommended.



Resources

Remember that Internet addresses may
change or vanish over time. We attempt, how-
ever, to keep up to date. In the e-book version
you can click on the links (in blue) to get to a
particular page directly with your browser.

B.1 Recommended Books

11  Tim Grey: Color Confidence.
The digital photographer’s guide to
color management.
Sybex Inc, San Francisco, 2004.

(2]

(3]

Camera: Nikon D1oo

Bruce Fraser, Chris Murphy, Fred
Buntig: Color Management. Industry-
strength production techniques.
Peachpit Press, Berkeley, CA, 2003.

Ben Willmore:
uptospeed — Photoshop CS2.
Peachpit Presss, Berkeley, 2005.
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B.2 Useful resources in the Internet

(4]

(5]

[6]

[7]

(8]

(9]

[10]

[11]

Outback Photo: The home-page of
Bettina & Uwe Steinmueller with lots
of information on digital photography:
www.outbackphoto.com

Colors by Nature — some of the color
works of Bettina & Uwe Steinmueller:
www.colors-by-nature.com

Uwe Steinmueller: A Profile for B&W
conversion:
www.outbackphoto.com/artofraw/
raw_o8/profile_BW.zip

Digital Outback Photo: Our Tonality
Tuning Toolkit:
www.outbackphoto.com/workflow/
wf_61/essay.html

Digital Outback Photo: Paper on
sharpening:
http://www.outbackphoto.com/
dp_essentials/dp_essentials_os/
essay.html

Digital Outback Photo: Paper on noise
reduction:

www.outbackphoto.com/
dp_essentials/dp_essentials_o4/
essay.html

Digital Outback Photo: An essay on
Workflow techniques using actions and
filters in layers:
www.outbackphoto.com/workflow/
wf_19/essay.html

Digital Outback Photo: An essay on
printing insights:
www.outbackphoto.com/
printinginsights/pi.html

[12]

[13]

[14]

[15]

[16]

(7]

[18]

[19]

Paper on Noise Ninja — a noise removal
tool (4, &):
www.outbackphoto.com/workflow/
wf_25/essay.html

ICC - International Color Consortium:
www.color.org

ECI — European Color Initiative
WWwWWw.eci.org

GretagMacbeth: ColorChecker and
several profile packages (e.g. Eye-One
Match and Eye-One Photo):
www.gretagmacbeth.com

ColorVision: Color Management Tools
(e.g. ColorPlus, Spyer2Pro, ProfilerPlus,
PrintFIX, ...):

www.colorvision.com

Monaco Systems (now part of X.rite):
Color Management Tools (Profiling
packages, e.g. Monaco OPTIX for mon-
itor profiling):

www.Xritephoto.com

Digital Domain Inc.: Profile Prism.
ICC profiling tool for cameras and
scanners:
www.ddisoftware.com/prism/

Pixmantec: RawShooter Essentials (4).
A RAW converter for a broad range of
DSLRs:

www.pixmantec.com

Phase One: Capture One DSLR (4%, &).
A RAW converter for a broad range of
DSLRs.

www.phaseone.com


http://www.outbackphoto.com
http://www.colors-by-nature.com/
http://www.outbackphoto.com/artofraw/raw_08/profile_BW.zip
http://www.outbackphoto.com/artofraw/raw_08/profile_BW.zip
http://www.outbackphoto.com/workflow/wf_61/essay.html
http://www.outbackphoto.com/workflow/wf_61/essay.html
http://www.outbackphoto.com/dp_essentials/dp_essentials_05/essay.html
http://www.outbackphoto.com/dp_essentials/dp_essentials_05/essay.html
http://www.outbackphoto.com/dp_essentials/dp_essentials_05/essay.html
http://www.outbackphoto.com/dp_essentials/dp_essentials_04/essay.html
http://www.outbackphoto.com/dp_essentials/dp_essentials_04/essay.html
http://www.outbackphoto.com/dp_essentials/dp_essentials_04/essay.html
http://www.outbackphoto.com/workflow/wf_19/essay.html
http://www.outbackphoto.com/workflow/wf_19/essay.html
http://www.outbackphoto.com/printinginsights/pio15/pio15.html
http://www.outbackphoto.com/printinginsights/pio15/pio15.html
http://www.outbackphoto.com/workflow/wf_25/essay.html
http://www.outbackphoto.com/workflow/wf_25/essay.html
http://www.color.org
http://www.eci.org
http://www.gretagmacbeth.com
http://www.colorvision.com
http://www.xritephoto.com
http://www.ddisoftware.com/prism/
http://www.pixmantec.com
http://www.phaseone.com

[21]

[22]

[23]

[24]

[25]

[26]

[27]

[28]

[29]

Bibble Labs: Bibble. (4, &). A RAW
converter for a broad range of DSLRs.
www.bibblelabs.com

Canon: Canon Digital Photo
Professional. (7%, &).

A RAW converter for various Canon
DSLRs:
www.canon-europe.com/Support/
Patches/dpp/

Nikon: Nikon Capture. (4, &)

A RAW converter for most of Nikon’s
DSLRs:
http://nikonimaging.com/global/
products/software/capture4/

PictoColor: inCamera. ICC profile soft-

ware for digital cameras and scanners:

www.picto.com

PTLens — A correction program for
lens flaws (Photoshop Plug-in for
Windows):
http://epaperpress.com/ptlens

LensFix & PanoTools — Lens distortion
correction & image remapping plug-
ins for Mac OS:

www.kekus.com

Neatlmage. Noise removal tool (4, &):
www.neatimage.com

Noiseware. Noise removal tool (4, &):
www.imagenomic.com

Helicon Filter Pro. A freeware set of
filters to remove red eye, reduce
noise, to do sharpening and

color tuning (#¥):
www.shareup.com/Helicon_Filter_
pro_download-21227.html

[30]

[31]

[32]

[33]

[34]

[36]

[37]

[38]

Debatrrelizer. For corrections of barrel
distortions (47, &):
www.theimagingfactory.com/data/
pages/products/productsi.htm

Focus Magic. A sharpening tool (4¥):
www.focusmagic.com

Focus Fixer. A sharpening tool (4, &):
www.fixerlabs.com

Digital Domain Inc: Qimage RIP ()
and Profile Prism (/4¥) — a profiling
software for printers, digital cameras
and scanners:
www.ddisoftware.com

DxO Optics Pro. Corrects distortions
and lateral chromatic aberrations and
vignetting (4, &):

www.dxo.com

Exifer for Windows. Management of
EXIF/ITPC meatadata. (4¥):
www.friedemann-schmidt.com/
software/exifer/

ACD Systems: ACDSee.
Photo Management Software (4 ):
www.acdsystems.com

Cerious Software: ThumbsPlus Pro.
Simple to use digital asset manage-
ment system (4 ):
www.cerious.com

Rname-it (4¥). A free flexible Windows
renaming utility:
www.outbackphoto.com/handbook/
cameratocomputer.html
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http://www.outbackphoto.com/workflow/wf_60/essay.html
http://www.kekus.com
http://www.neatimage.com
http://www.imagenomic.com
http://www.shareup.com/Helicon_Filter_Pro-download-21227.html
http://www.shareup.com/Helicon_Filter_Pro-download-21227.html
http://www.theimagingfactory.com/data/pages/products/products1.htm
http://www.theimagingfactory.com/data/pages/products/products1.htm
http://www.focusmagic.com
http://www.fixerlabs.com
http://www.ddisoftware.com
http://www.dxo.com
http://www.friedemann-schmidt.com/software/exifer/
http://www.friedemann-schmidt.com/software/exifer/
http://www.acdsystems.com
http://www.cerious.com
http://www.outbackphoto.com/handbook/cameratocomputer.html
http://www.outbackphoto.com/handbook/cameratocomputer.html

®
IS

Resources m

[39]

[40]

[41]

[43]

[44]

[45]

[46]

RenamergMac (&): A free renaming
utility for Mac OS X:
http://mac.softpedia.com/get/
Utilities/RenamergMac.shtml

Helmut Dersch: Panorama-Tools. (4)
Tool for digital panoramas, used as
the basis for PTLens.

www.ptgui.com

Donwloader Pro. (). A windows utili-
ty to download and rename image
files from a memory card or from a
camera:

www.outbackphoto.com/
computers_and_more/
veit_downloader_pro/essay.html

Photorescue (4¥).

A utility for Windows and Mac to ex-
tract image files from a corrupted
memory card:
http://www.outbackphoto.com/
handbook/usingdslr.
html#photorescue

Adobe: Paper on XMP customizing:
www.adobe.com/products/xmp/
custompanel.html

New versions of Adobe Camera Raw
www.adobe.com/support/
downloads/

Free Adobe DNG converter
www.adobe.com/products/dng/

EasyS Sharpening Toolkit:
www.outbackphoto.com/workflow/
wf_66/essay.html

[47]

(48]

[49]

Bettina&Uwe Steinmueller:

Digital photography workflow hand-
book:
www.outbackphoto.com/booklets/
dop2000/DOP2000.html

Dr. Brown Russell: Tips & Techniques for
Photoshop CS2.

Dr. Brown's Services 1.0 make this
whole process much more easy
(check out the movie):
www.russellbrown.com/
tips_tech.html

Jack Flesher: Paper Upsizing in
Photoshop:
www.outbackphoto.com/workflow/
wf_60/essay.html
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Index

A
AA filter 1-9, A-1
aberration A-1
chromatic aberration 7-13
absolute colorimetric 2-15, A-1,
A-6
ACDSee 10-3,B-3
ACR (Adobe Camera Raw) A-1
adjust tab 4-22
advanced image corrections
4-38
apply settings 4-10
batch conversion 4-37 4-39
brightness 4-26
calibrate tab 4-33
contrast 4-26
curves 4-12
curves tab 4-32
exposure 4-26
filmstrip-mode 4-16
histogram 4-19
ICC working space 4-21
image correction controls
4-22
Lens tab 4-31
real life workflow 4-3
resolution 4-21
reuse settings 4-36
saturation 4-28
save settings 4-36
shadows 4-26
sharpness 4-28
toolbar 4-19
white balance 4-23
workflow support 4-39
action 8-6
additive color model 2-3
adjust tab
ACR 4-22

Adobe Bridge 4-4
Adobe Camera Raw 4-1, A-1
batch processing 8-5
calibrating 11-11
Adobe Creative Suite A-3
Adobe Gamma 2-18
Adobe RGB (1998) 2-11, 2-13, A-1,
A-8
advanced image corrections
3-24,4-38
Anti-Aliasing filter 1-9
Apple RGB 2-11
archival RAW format 9-3
artefacts A-1
camera artefacts 1-11
Auto Adjustments 4-11

B
B&W
creating photos 12-1
film 12-2
profile 12-8
thumbnails and previews 12-5
with ACR 12-4
with Capture One DSLR 12-7
with RawShooter 12-3, 12-12
backup 3-12
banding A-1
barrel distortions 7-19
batch 8-7
Adobe Camera Raw 8-5
basic pattern 8-2
conversion 4-39, 8-16
ACR 4-37,4-39
using Bridge 8-12
predefined scripts 8-10
RawShooter 8-16
renaming
Photoshop 8-4

RS 5-30
smooth processing 8-13
Bayer
pattern 1-6, A-1
demosaicing 1-7
sensor 1-8
Bibble 6-11, B-3
color management 6-13
Picture Options 6-15
setup 6-12
sharpening 6-16
WB 6-14
workflow 6-17
bitmap mode 2-2
bit depth 4-21
black point 3-17, A-1
blooming A-1
blur 7-2
Bridge 4-15
batch conversion 8-12
brightness 3-17
ACR 4-26
browsing
RAW files 3-13,4-4

C
C1 (Capture One) A-2
cache settings 4-17
calibrate tab
ACR 4-33
calibrating Camera Raw 11-11
calibration 2-15, A-2
by eye 2-18
hardware based 2-18
settings 2-18
camera
artefacts 1-11
default settings 4-40
histogram 3-3
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profile 2-16, 11-1
profiling 11-3
RAW format A-2
set to to RAW mode 3-2
target 11-2
to computer 3-9
candela A-2
Canon Digital Photo Professional
6-19
Capture One DSLR 6-2, B-2
B&W 12-7
batch processing 8-13
color management setup 6-4
develop 6-9
exposure 6-8
Preferences 6-4
RAW file browser 6-5
setup 6-3
sharpening 6-9
WB 6-7
CA (chromatic aberration) 7-13,
A-1, A2
CCD A2
CcMmYK 2-4
cd (candela) A-2
CF (Campact Flash card) A-2
Channel Mixer 12-3
characterization 2-16, A-2, A-6
Charged Coupled Device A-2
chroma A-3
chromatic aberration (CA) 7-13,
A-1, A2
CIE A2
LAB 2-3,2-16, A-2, A-5
clipping A-2
clone tool 7-26
CMM 2-8, A-2
CMS 2-8,A-2
CMYK 2-5, A-2, A-8
color model 2-4
color
adjustment
DPP 6-25
aliasing 1-11,7-2
and B&W 12-10
channel clipping 3-5

clipping 3-5
color noise 7-9
conversion techniques 12-3
corrections 3-24
depth 2-2
filters 1-7
gamut A-2
index mode 2-2
management 2-6
Bibble 6-13
DPP 6-20
module 2-8
NC 6-30
setup in Capture One 6-4
system 2-8
mode A-3
bitmap mode 2-2
model A-2
additive 2-3
CMYK 2-4
grayscale 2-5
LAB 2-3
RGB 2-3
subtractive 2-4
modes 2-2
sampler 4-20
settings 2-23
settings in Photoshop 2-23
space
CMYK A-8
mapping 2-14
visualization 2-11
spaces 2-5
temperature 3-16, A-3
wheel A-3
working space 2-10
ColorChecker B-2
ColorChecker SG 11-3, 11-4
colorimeter 2-20, A-2
colorimetric A-6
absolute colorimetric intent
2-15
relative colorimetric intent
2-14
ColorSync A-3
ColorVision B-2

command key 1-2
Commission Internationale de
I'Eclairage A-2

Compact Flash (CA) A-2
computer configuration 1-3
configuration 1-3

for color work 1-3
contrast 3-17

ACR 4-26

enhancements 1-14
corrections

color corrections 3-24
Correct toolbar 5-20
cropping 1-14
crop tool 4-20
CRT 2-19, A2
CS1 A3
CS2 A3
curves A-3

ACR 4-12,4-32

NC 6-31

D
D50 A-3
D65 2-18, A-3
Debarrelizer 7-14, B-3
deletion workflow 5-19
demosaicing 1-7
develop tab Capture One 6-9
device
gamut 2-5
profile A-3
creation 2-15
digital darkroom
setup 3-12
Digital Negative 1-1
Format 9-1
distortion 7-19
DNG 9-1
advantages 9-8
converter 9-3,9-5
disadvantages 9-8
potentials 9-2
support 9-3
DNGC 9-3,9-5
Donwloader Pro B-4



dot gain A-3
Downloader Pro 3-11
dpi (DPI) A-4
DPP 6-19
color adjustment 6-25
color management 6-20
exposure 6-24
main features 6-21
setup 6-19
WB 6-23
DSLR A-4
dust spots 7-26
DxO Optics Pro B-3

E
ECl A-4,B-2
ECI-RGB 2-11, 2-24, A-4, A-8
EOM 2-19
EPS A-4
Euroscale Coated 2-24
EV A-4
exchange format 9-3
EXIF 10-1,10-2, A-4
Exifer for Windows 10-3, B-3
expose
rule 3-4
Exposure 5-7
exposure 3-2,3-17,5-22
ACR 4-26
Capture One 6-8
DPP 6-24
Extensible Metadata Platform
10-3
Eye-One
Display 2-19
Photo 11-3

F
file attributes 10-2
file hierarchy 3-10
Fill Light 5-7
filmstrip-mode
ACR 4-16
Bibble 6-11
RS 5-15
Firewire A-4

Focus Fixer B-3
Focus Magic B-3
folder organization 3-10
format

RAW exchange format 9-3
Foveon sensor 1-9
fringing (purple fringing) 7-15

G

gamma 2-18, A-4

gamut 2-5, A-4
mapping A-4

grayscale mode 2-5

gray balanced A-5

GretagMacbeth B-2

H
hardware based calibration 2-18
healing brush 7-29
Helicon Filter Pro 7-13, B-3
highlights A-5
Highlight Contrast 5-7
histogram A-5
ACR 4-19
camera histogram 3-3
indicating overexposure 3-3
live histogram 3-7
how to create an action 8-5
HSB A-5
HSL A-5
hue A-5
inRS 5-27
RS 5-27
Hue/Saturation 12-3

|
ICC 11-1, A-5,B-2
profile 2-7, A-5
ICM A-5
IEEE 1394 A-4
image
advanced corrections
ACR 4-38
inRS 5-32
blur 7-2
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